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FreeFlow VI Design Pro Installation

This chapter contains:

(CT< i [a e I fo y {le PP PSPPI 10
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This section provides the information needed to install VI Design Pro software on the workstation. You can find
details about licensing and installation in these sections:

e System requirements

e Proof Print

e Upgrade Information

e VI Design Pro Installation
e Licensing Requirements

e Uninstalling VI Design Pro
e Adding PostScript fonts
File backup

When you upgrade or uninstall this software, ensure that you back up any customized files that can be required
later.

Virtual machine support

You can install VI Design Pro on a Virtual machine with a unique MAC address. However, no support is provided
for the VM environment.

Updates are released as full installers
You can install any FreeFlow VI Suite 18.0.0 update over any previous release of the FreeFlow VI Suite.
Installation of VI Suite components requires Administrator privileges.

f Note: In the 18.0.0 release, the VI Design Pro Installer program is changed. Before you install VI Design Pro
version 18.0.0 or later, it is necessary to uninstall any version earlier than 18.0.0 manually.

Stop active products before the installation of updates

Before the installation of any updates, stop active products, such as FreeFlow VI eCompose or VI eCompose
services.
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FreeFlow VI Design Pro Installation

Getting Started

Before you begin, first download the software from the Xerox website. Download instructions are provided here.
After you have downloaded the appropriate files you can proceed to the installation instructions that follow.

PROGRAM DOWNLOAD

To download the VI Design Pro, go to www.xerox.com/support, then select Software and Platforms. Select
FreeFlow > FreeFlow Variable Information Suite, then select then select Software and Solutions. If necessary,
to display the correct installer file, select the operating system appropriate for your target platform, then download
the VI Design Pro installer file.

Program Delivery Format

Programs are delivered in .exe format. These files can be downloaded directly to the target device. When the
device does not have internet access, copy the .exe file on the target device.

Downloads

Some Variable Information programs, Specialty Imaging fonts, and Barcode fonts are available to customers in
the United States that want to purchase those programs or fonts using a credit card.

SPECIALTY IMAGING AND BARCODE FONT DOWNLOAD

To download the Specialty Imaging and Barcode fonts, go to www.xerox.com/support, then select Software and
Platforms. Select FreeFlow > FreeFlow Variable Information Suite, then select Software and Solutions.

f Note: When downloading fonts, you will be directed to review an End User License Agreement. In order to
download the fonts you must review and accept the End User License Agreement. If you do not accept the
End User License Agreement you will exit from the font download page.

10 Xerox® FreeFlow® VI Design Pro Software User Guide
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FreeFlow VI Design Pro Installation

System Requirements

VI Design Pro (VDP) is an interactive design environment for VIPP® application programmers. It provides an
interactive user interface that provides a text-based code entry component, with smart editors with a WYSIWYG
view of the variable application as it is being designed. As code is entered or an element on the screen is moved,
updates are made, and when the screen is refreshed, the updated application is rendered on the screen. VI Design
Pro utilizes the same VI Compose interpreter that the printer uses to render the VIPP® application on the screen,
ensuring what you see on screen will match what you print at the target print device. For this reason it is highly
recommended that when upgrading a component of the VI Suite of products, you upgrade all your components to
the same version and patch or service pack level. VI Design Pro provides other features such as random access to
pages in the job (browsing) and zoom adjustments, as well as smart editor, find and replace capabilities and other
aids to assist in VIPP® application design.

VI Design Pro can be installed on a Windows 64-bit system and supports virtualization. If using virtualization, each
node must have its own unique MAC address to license the product.

The minimum software and hardware requirements are:

e  Windows® 10, Windows® 11, Windows Server® 2016, Windows Server® 2019, and Windows Server® 2022 64-bit
platform only

e 4GB RAM
e 20GB Hard drive

e Internet access (to activate the license)

f Note: The GUI display is rendered using an internal PS engine, as such it cannot render correctly PDF files
with transparency. PDF files will be converted internally to EPS for purposes of display in the GUL. Although
the GUL is not able to render transparency correctly, if printing to an FFPS APPE engine, transparency will be
honored at the device.

The following minimum screen resolution and color settings are recommended when editing any of the available
DRAW commands on the Windows PC:

o Set the desktop area to at least a screen resolution of 1024 x 768. The higher resolution is preferred.
e Set the color palette to 256 colors or better

e Set the font size to Small Fonts or Large Fonts

(D Caution: Lower resolutions can cause unexpected results.

Lines or characters of less than 1 point

When using lines or characters of less than 1 pt, you may need to use the zoom options in VI Design Pro to see
the actual lines or characters displayed on the screen.

Not all objects can be selected in the GUI windows

Some hot spots are not available and cannot be selected.

Xerox® FreeFlow® VI Design Pro Software User Guide 11
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Proof Print

VI Design Pro can use any PostScript print device available in the Windows Printer panel to proof print pages from
the application. Without a license for that printer, you will be limited to under ten pages. If a license is available for
that device then there is no limitation. To license such a device, contact your local Xerox sales representative.

The version of VIPP® resident on the printer MUST be of the same version or higher than the version of VI
Compose shipped with VI Design Pro. To determine the version of VI Compose shipped with VI Design Pro, choose
Help > About FreeFlow VI Design Pro from VI Design Pro's main window pulldown menu.

Proof Print uses the VIPP® rendering engine to create the proof pages.

The page range selection in Proof Print refers to logical pages, while the graphic display shows the current and total
physical pages of the application. This means that for multi-up applications the Proof Print page range selection
values may not correspond one to one with the actual number or position of logical pages. You should select the
range of pages to be proof printed based on the desired logical page numbers, not the physical page numbers.

j’ Note: Design Pro supports printing to PDF. For more information, refer to File Menu.
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Upgrade Information

If you have an earlier installation of VI Design Pro formerly known as VI Designer or IDE, and you have customized
the installation files, for example, the xgfdos. run and xgf . def files, and so on, print or copy these files so that
you can identify and reapply the customizations after the upgrade.

Xerox® FreeFlow® VI Design Pro Software User Guide 13



FreeFlow VI Design Pro Installation

VI Design Pro Installation

Refer to Program download for download instructions. VI Design Pro software is downloaded in a zip file. Service
packs, when available, are zip files that can be downloaded from the same location. Install these service packs over
the base software.

Installation of the software requires administrator privileges. To install the software, extract the zip file. Double-click
the XeroxFreeFlowVIDesignPro-18.n.n.exe file. Install the software on the local device. Follow the
onscreen prompts.

The software is installed to default path C: \Program Files (x86) \Xerox\VIPP\vide. As required, the
user can change default installation path. This folder contains program files, help files, Wizard libraries and sample
forms and images. A FreeFlow VI Design Pro entry is added to the Windows Start menu. Before you install FreeFlow
VI Design Pro version 18.0.0 or later, it is necessary to uninstall any version earlier than 18.0.0 manually. When you
update the install version 18.0.0 or later, the installer prompts you to uninstall the existing version before you
proceed with the installation.
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Licensing Requirements

V1 Design Pro software will install with a 60-day trial period (if it has not previously been installed on this device). To
use the product after the 60 day trial period you must convert the trial to a fully licensed version of the product. To
do this you need to purchase a production license. Without a valid license the software will not be usable.

The process to license VI Design Pro will depend on where and how VI Design Pro software was purchased. This is
due to unique licensing requirements based on a geographical region. This information will be included in the kit
you receive/download when you purchase VI Design Pro.

Do not attempt to change the system clock to circumvent the license

VDP will detect such a change and will fail to operate if this is attempted.

Manually loading a license

If you use the manual Load License option, you are provided with a license file. License files (*.dat) for all VI
products are generated via an automatic process. The process saves the file as HardwareAddress.dat , where
HardwareAddress is the address of the computer on which the product will be licensed. Therefore, it is possible
to receive more than one product license file with identical file names. It is your responsibility to ensure that you
do not overwrite existing licenses when saving a new product license. When license files used on a single
computer are due to expire at the same time, it is possible to request one file that will activate all the VI
products on that computer.

When you install an upgrade to an existing version of VDP with a valid license, the software will find and activate
the previously installed license. No further action is required until such time as the license expires.

To manually load or activate your VDP license, select Help > Install/Update Software License from the menu bar.
(You can also use this option to view how many days remain in the trial or the status of the license.)

Selecting the Install/Update Software License option will produce the FreeFlow VI Design Pro License panel. This
panel provides access to information about the installed license and two unique licensing options. Use the panel to
choose the option suited to your location.

License Information

This panel includes:

LICENSE TYPE DESCRIPTION

Days Remaining The number of days until the existing license will expire.

License Host ID VDP finds and displays this information from your computer.

If a valid license file has been loaded, the Host ID used by the license is
shown.

Product Version The installed version of the VDP software.

If you have obtained a license file...

Use this option when you have received a license file (*.dat) (usually via email). When you receive the file, store
it in a safe and accessible place on your computer.
For further instructions, refer to Using the Load License option.

If you have an activation key...

The information in this panel is designed for users who have received a software activation key as part of the
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software license kit for the VDP software.

If you do not have the license kit, and are in a location that requires this option, contact your Xerox sales
representative to purchase the software license kit for VI Design Pro software. After the order is processed, a
ship kit that contains the Software Activation Key and Serial Number, If provided, is shipped to the customer
location.

For further instruction, refer to Using the Activation Key option.

USING THE LOAD LICENSE OPTION
To activate the VI Design Pro license using a license file:
1. Select the Load License option.
2. Browse to the location of the license file, select it, then click OK.
The license is installed. The new license information appears at the top of the license panel.

3. Select OK to activate the license.

USING THE ACTIVATION KEY OPTION

f Note: Retain the Software Activation Key and Serial Number, if provided, in a safe location as they may be
required for future upgrades, support, and so on.

If you have the Software Activation key, you can use the automated license process outlined here:

1. Choose one of the available System Host IDs for the license HostID. (The default is recommended.)

j’ Note: If the automated license process fails you will need to have the System Host ID string and the
Software Activation Key available when you contact the Xerox hotline for assistance.

2. Enter the Serial Number of the device on which the software is installed.
3. Enter the Software Activation Key in the area provided and click the Activate... button.

4. The Xerox License Server may return a form requesting additional information. Fill in the form as requested and
select OK when done.

5. This information and the Software Activation Key will be submitted to the Xerox License Server.

6. At this point the Xerox License Server should have all the information required to validate the license request. If
additional information is required, a new screen requesting additional information will be displayed. Fill in the
required information and select OK.

7. The Xerox License Server will validate the information and either enable the license or return an error code if
the information supplied does not match our records. If an error code is generated, report the error code to
your local Xerox representative so they can assist you further.

If the information entered is valid, a license file will be generated and loaded to you r system. Details of the license
will be displayed in the License Information area of the License screen. To apply the license, click the OK button.
When the OK button is selected, the license will be applied.

On occasion, the automated license activation may fail. When this happens, contact the Xerox hotline for
assistance. Have the System Host ID of the workstation and the Software Activation Kit supplied in the ship kit
available. Further assistance may result in a license file being emailed to you.
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j’ Note: If you fail to connect to the license server using the method shown above, you can go to any Internet
connected device and login to the portal using this URL: https://www.xeroxlicensing.xerox.com/activation.

Enter the Activation Key and follow the on screen prompts. You will need to know the System Host ID of the
VDP system. A License file will be emailed to you. Move the license to a safe location on the VDP system and

use the Load License option to install the license.
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Uninstalling VI Design Pro

Remove VI Design Pro by running the uninstall program. The uninstall program presents a series of windows that
allow complete removal of VI Design Pro or to remove selected files and items.

j’ Note: Selecting Cancel stops the uninstall program without completing the procedure. Run the uninstall
program to fully uninstall VI Design Pro.

(D Caution: When you have an earlier version of VI Design Pro installed on the system you must use the
uninstall program provided with that version of the software to remove those files.

To run the uninstall program:
1. Login to the Windows workstation as administrator or with a user account with administrator privileges.
2. Launch VI Design Pro's uninstall program by using one of these methods:

e Select Start > All Programs > Xerox FreeFlow VI Design Pro, then right-click Uninstall.

e Use the Add or Remove Programs option on the Control Panel.

e Select Start > Run to access the Run window. If necessary, to verify the correct path to uninstall .exe file, for
example, C:\Program Files (x86) \Xerox\VIPP\vide\UninstallerDat
\UninstallXeroxFreeFlowVIDesignPro.exe, select Browse. Browse to the .exe file, then click
OK.

e Using Windows Explorer, access the vide directory on the workstation, or the alternate location. Locate and
double-click Uninstall Xerox FreeFlow VI Design Pro.exe.

3. When the Uninstall VI Design Pro window appears, select the type of uninstall to perform, then follow the on-
screen instructions to complete the uninstall process.

4. Reboot the workstation when the software has removed the selected VI Design Pro files, directories, and
software from the system and restored the selected .ini files.
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Adding PostScript Fonts

Order additional PostScript Type I and Type III fonts from the Xerox Font Library. These fonts can be used on the
printer and with VI Design Pro.

The fonts must be in a PostScript format that is supported by the target printer. In general, Type 1 and 3 PostScript
fonts are supported on all PostScript printers.

j’ Note: When VI Design Pro is not installed on the C:\Program Files (x86)\Xerox\VIPP\ folder, replace C:
\Program Files (x86)\Xerox\VIPP\ in the following description with the folder on which VI Design Pro is
installed.

To import PFA and PFB type fonts into the VI Design Pro fonts directory, select the File menu on the top menu bar
and one of these options:

e Import Roman PostScript Fonts
e Import Special PostScript Fonts

Use Import Roman PostScript Fonts for fonts using the Standard Roman (or Latin) Character Set as defined in
Adobe's PostScript Language Reference Manual. This is the option generally used for Latin Type 1 fonts delivered by
font vendors.

f Note: Use the Import Roman PostScript Fonts option to install Specialty Imaging fonts.

These fonts are suitable for re-encoding by VIPP®, using the default re-encoding table, and can be referenced in the
xgfl\encoding\fontlist file.

Use Import Special PostScript Fonts for fonts using any other character set (typically barcode fonts or fonts
converted from other legacy formats).

These fonts must not be re-encoded and must be referenced in the xgf\encoding\nullfl file.

Using either option, one or more fonts can be selected. The fonts are converted into regular PostScript fonts and
placed in the C:\Program Files (x86) \Xerox\VIPP\vide\fonts directory. Also, as part of the font
conversion process, the file C: \Program Files (x86) \Xerox\VIPP\vide\xgf\encoding\fontlist
(for roman fonts) or C: \Program Files (x86) \Xerox\VIPP\vide\xgf\encoding\nullfl (for
special fonts) is updated with the newly imported font names. By default, the VIPP® font names are of the
incremental form /RFAAxxxx (in fontlist) or /SFAAxxxx (in nullfl), where xxxx is a number ranging from 0000-
999999. The resulting fontlist or nullfl file can be edited to change these names or add font family information. For
details, refer to Customization.

Within VI Design Pro, the font key names cannot be more than 10 characters long, not counting the backslash, for
example,. /RFAA123456, due to current constraints in the GUI menu display width format. However, this limit is
sufficient for most purposes, because VIPP® font key names are meant to be short names used as shortcuts for the
long font names.

@ Important: These fonts are often subject to licensing agreements and must be used in accordance with the
terms of the agreement. You are responsible for checking the licensing agreement for any fonts and
complying with the terms before installation for use with VI Design Pro.

After you complete these tasks you are requested to restart VI Design Pro. The new fonts appear in the font pull
down menus and you can access them in the VIPP® code using the VIPP® short name.
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CUSTOMIZATION

The files C: \Program Files (x86) \Xerox\VIPP\vide\xgf\encoding\fontlist orC:\Program
Files (x86) \Xerox\VIPP\vide\xgf\encoding\nullfl can be edited to change the VIPP® font
names or to add font family information.

The syntax for each entry in these lists is:

/VIPP Shortname /PSFontname /substitute fontname SUBSTFONT

Where:
/VIPP Shortname is a unique user-defined identifier for this font (max 10 characters long).
/PSFontname is the name of the PostScript font as it appears inside the file under the

/FontName key.

/substitute fontname | (optional)is any font name that will be substituted when the font referenced by
SUBSTFONT /PSFontname is not available.

This example shows part of the C:\Program Files (x86) \Xerox\VIPP\vide\xgf\encoding
\fontlist file.

JSSTARTFF : ;
JHNGML  /Garamond-Light STimes-Roman SUBSTFONT
JNGMB  /Garamend-gold STimes-Bold SUBSTFONT

JHGMLT /Garamond-LightItalic /Times-Ttalic SUBSTFONT
ANGVBI SGaramond-BoldItalic  /Times-BoldItalic SUBSTFONT

JENDFF
% additional fonts to be purchased separately (examples)
JNPN /MEDAZ JCourier SUBSTFONT

JHPNA  SAarialMonospacedMT-obligue  fCourier SUBSTFONT

The /STARTFF and /ENDFF markers are optional and can be used to delimit a font family. Refer to the VIPP®
Language Reference Manual for more details.

KERNING

Kerning information for a PostScript font is available in an Adobe Font Metrics (AFM) file. AFM files are generally
supplied with the font kit when the font is purchased. Specifications for the AFM file can be obtained from Adobe,
Inc.

Kerning can be enabled for VIPP® SHx commands using:

e Extended syntax on the entry in the font lists

e SETKERN and INDEXKERN commands

Use this syntax in fontlist to establish the link between a given font and an AFM file:
/VIPP Shortname [ /PSFontname (AFM filename) ]

Where:

AFM filename This is the name of the AFM file containing kerning
information for the associated font.
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The AFM file must be located in one of the libraries referenced by SETMPATH or SETEPATH (or SETPPATH in project
mode).

Kerning is disabled by default.
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VI Design Pro is a Graphical User Interface (GUI) program, designed to simplify the creation of VIPP® applications.
VI Design Pro can be used to create new VIPP® applications, or to view or modify existing VIPP® applications. VI
Design Pro is the only GUI-based product that can use all the capabilities provided by FreeFlow Variable
Information Suite (VIS) applications to process data-driven graphics, data-driven conditional processing,
transactional printing, and database publishing.

V1 Design Pro can save your application in legacy or VI Project Container format for fast printing to your VIPP®-
enabled print device or to the VI eCompose system, which converts VIPP® to PDF, using the power of Dynamic
Document Construction. Additionally, you can output your application as a PDF, using the File menu option Export
Job as PDF. For large print volumes of records, this option can take longer. This option cannot use the full power of
Dynamic Document Construction available when printing the legacy or VI Project Container formats to a VIPP®-
enabled printer. Additionally, the size of the PDF file can be very large, based on the options used to create the PDF
file.

f Note: The GUI display is rendered using an internal PS engine, and therefore cannot render correctly PDF
files with transparency. PDF files are converted internally to EPS for display purposes in the GUIL. Although
the GUI cannot render transparency correctly, if you print to an FFPS APPE engine, transparency is honored
at the device.

In addition to the GUI, VI Design Pro provides the following:

e Application templates

e Smart Editor features to simplify the creation or modification of VIPP® applications
e Full support of the VIPP® command set

e What You See is What You Get (WYSIWYG) representation of the VIPP® application.

The GUI and WYSIWYG provide an interactive environment in which to create the VIPP® applications, and
represent how the application prints on the device.

License required

To use VI Design Pro, a license is required. For more information, refer to FreeFlow VI Design Pro Installation.
Without the license, the program runs in Demonstration mode for a 60-day period, after which VI Design Pro
exists when it is invoked.
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Unsupported software

Operation of the VDP software on a computer with VMWare as the base operating system, and the use of
Remote Desktop or other sharing software, is not tested, and is not supported.

Watermarks

When the program runs in Demonstration mode, the following watermark is produced on every page of the
VIPP® job:
Unlicensed FreeFlow VI Design Pro. Please contact a Xerox Sales representative for more details.
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VI Suite Customer Forum

Xerox hosts a Community Support Forum. The VI Suite Customer forum is now part of the larger support forum,
allowing you to post and review information about Xerox products and services all from one location. Take a minute
to log in to this customer forum community: http://VIPPsupport.xerox.com.
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Using VI Design Pro

To use VI Design Pro you must be familiar with the VIPP® programming language and how VIPP® applications are
created. If you are not familiar with VIPP®, there are other third-party GUI design tools that can be used by non-
programmers, which provide VIPP® design capabilities using a drag-and-drop interface.

For a review of the basic information about the VIPP® program, refer to the following sections of the FreeFlow
Variable Information Suite documentation:

e VIPP® and VI Compose Overview: This chapter in the FreeFlow VI Compose User Guide provides some of the
background information needed to understand what is involved in VIPP® applications. The chapter contains
information about the following subjects:

—  VIPP® and PostScript

—  VIPP®-enabled devices
—  Repositories

— VI Projects

—  VIPP® core functionality

e VIPP® Data Streams: This chapter in the FreeFlow VI Compose User Guide describes the various modes in which
VIPP® applications are used: Native mode, Line mode, Database mode, and XML mode. Other information in
this chapter includes:

— Linking the data with the JDT, DBM, or XJT

—  Record structures

— Record structures and the mode and presentation relationship
—  Functions

— Conditional processing

—  Dynamic boxes

—  Data-Driven Graphics (DDG)

e VIPP® Resources: This chapter in the FreeFlow VI Compose User Guide describes the files stored in the VIPP®
libraries that are used for accessing and processing VIPP® jobs. The chapter includes information about the
different types of resources, the different ways in which VIPP® can access those resources, and the mechanism
and syntax used to embed resources in the data stream. VIPP®-supported resource types include:

— VI Project

— VI Compose and setup files
— Fonts

— Forms

— Segments

- Images

— Job Descriptor Tickets

— XML Job Tickets

—  Data Base Masters
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— Distribution lists
—  Text files

e VIPP® Commands: This chapter in the VIPP® Language Reference Manual provides detailed information about
each of the VIPP® commands. VIPP® commands are included as a separate part of VI Design Pro Help.
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Using Fonts

To read a discussion of how to install PostScript fonts and customize fontlist or nullfl, refer to Adding PostScript
fonts. You can edit the files to change the VIPP® font names or to add font family information.

USING MULTIPLE-BYTE FONTS

The VIPP® and VI Design Pro software support the use of multiple-byte fonts, including fonts designed for vertical
printing. The term multiple-byte or multi-byte font is used to describe fonts that require more characters than can
be specified in an 8-bit byte. VIPP® specifications include Chinese, Japanese, and Korean (CJK) fonts. For more
information about how the SHx commands have been modified for use with these fonts, refer to the FreeFlow VI
Compose User Guide and VIPP® Language Reference Manual.

To meet the requirements for vertical printing with CJK fonts:

e The command syntax for SHP and SHMF has been extended with selectable options for behaviors related to
Asian languages.

e Encoding and special character lists are defined in the xgf/src/cjk.def file.

e The commands SETCJKENCMAP, SETCJKRULES, SETV2HCONYV, and SETV2HTABLE have been added to the
VIPP® programming language.

e Commands such as FROMLINE, RPEKEY, GETFIELD, SETRCD, SETPCD, and GETINTV have been adapted to work
on character boundaries instead of byte boundaries when a multi-byte font is selected.

Vertical Writing

When using vertical multiple-byte fonts with SHx commands, all horizontal behaviors become vertical behaviors:
e Left alignment becomes top alignment.

e Right alignment becomes bottom alignment.

e Horizontal centering becomes vertical centering.

e Horizontal justification becomes vertical justification.

e Column width becomes column height.

e Line spacing is applied horizontally instead of vertically.

e The secondary horizontal position becomes the secondary vertical position.

e Instead of increasing the vertical print position, the horizontal print position is decreased so that vertical text is
forwarded from right to left.

Encoding Multiple-Byte Fonts

To change the encoding used by VI Design Pro software to interpret a resource, select Edit > Choose Resource
Encoding, or press Ctrl+E. Select from the available encoding until the multiple-byte text in the dialog window
appears correct.

f Note: Invoking the Choose Encoding to Use for Resource Display does not change the encoding of the
resource, only the encoding used for the display.
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The dialog is available for use in case VI Design Pro software cannot guess the encoding, or guesses incorrectly.
After the encoding is chosen with the dialog, a tag can be added to the top of the resource file, so that VI Design
Pro can guess correctly next time.

When no tag is present, VI Design Pro looks at the fonts specified in the SETFONT and INDEXFONT commands and
guesses the encoding from the font name.

The encoding options available on this dialog depend upon the settings on the workstation, usually Control Panel >
Regional and Language Options. When no Japanese code page support has been set, the following options are
available:

e Western Europe and Latin Languages, ISO-8859-1

e Unicode UTF-8

When the Japanese code page support has been set, the following options are available:
e Western Europe and Latin Languages, ISO-8859-1

e Unicode UTF-8

e Japanese, Shift-JIS

e Japanese, EUC-JP
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Job Data and Performance

As a Windows application, VI Design Pro software incorporates both the VI Compose runtime and a PostScript
Interpreter and RIP. In addition, VI Design Pro presents a GUI (Graphical User Interface) running on a Windows-
based workstation, which places certain restrictions on the amount of job data that can be handled within VI
Design Pro. When attempting to load production volumes of job data into VI Design Pro, unexpected results can
occur.

VI Design Pro software is a design tool intended for use during application development. Use VI Design Pro with
just enough line mode or database mode data to verify that the application looks the way you think it should look,
and behaves the way you think it should behave, typically on a few pages to a maximum of a couple of dozen
pages. The performance of VI Design Pro during both loading and browsing suffers in direct proportion to the
amount of job data ingested.
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Reconciliation and Graphic Element Restrictions

Immediately after invoking VI Compose and the PostScript Interpreter and RIP to render a given page of your
VIPP® application, VI Design Pro software taps into VI Compose to get information about the graphic elements
that were rendered to the graphic display. Only those graphic elements rendered through the use of VIPP® marking
commands can be accessed for graphic manipulation by VI Design Pro. Graphic elements rendered through use of
raw PostScript are not accessible. VI Design Pro software performs an analysis of the current state of the VIPP®
source code in your application, and references the information against the graphic elements that VI Compose has
rendered to the current page. If a particular rendered element on the graphic display can be matched with a
corresponding fragment of VIPP® source code, it is said to have been reconciled with the source element.

Only reconciled graphic elements can be grabbed, dragged, right-clicked, and so on. To maintain the integrity of
your VIPP® application, any action performed within the graphic display must eventually be realized through
manipulation of the corresponding VIPP® source code fragment. If a graphic element cannot be selected with the
mouse, then it has not been reconciled.

Because PostScript, and therefore VIPP® code can be arbitrarily complex, there are limits to how effective the
analysis portion of the reconciliation activity can be performed. Current limitations in this area include, but are not
restricted to, reconciliation of graphic elements rendered through the use of conditional execution, loops, or variable
substitution. Use of these constructs in your VIPP® application source can confuse the reconciliation process,
resulting in a failure to reconcile or a reconcile mismatch. Failure to reconcile or a reconcile mismatch is where a
View Source for a particular element on the graphic display points to an incorrect location in the VIPP® source.
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Crash Recovery

Upon restart after a crash, VI Design Pro software presents an option to re-instantiate resources from what was in
the resource execution cache when the application terminated abruptly or crashed. The resource execution cache
contains:

e Activities that are performed from the SmartEditor
e WYSIWYG manipulation of graphical elements on the right-side window

e Manual resource edits when the manual edits were sent to VI Compose through an F5 keypress or toolbar
button execution of the resource

Edits that are executed by VI Compose and propagated to the right-side graphical display are saved in the resource
execution cache. Upon restart of VI Design Pro after a crash, if the user chooses, recovery is attempted, based on
the cache contents.

Note that this crash recovery mechanism does not overwrite automatically the original job resources. After the
crash recovery operation completes, it is important to save any changes that were recovered, just as if you had
made a change without an explicit save during a normal editing session. The usual system prompts to save the
changes are presented.
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The VI Design Pro window provides GUI tools to create, view, and modify VIPP® applications. The VI Design Pro
GUI contains information about how those functions relate to the VI Design Pro program.

j’ Note: The GUI display is rendered using an internal PS engine, and therefore cannot render correctly PDF
files with transparency. PDF files are converted internally to EPS for display purposes in the GUI. Although
the GUI cannot render the transparency correctly, if you print to an FFPS APPE engine, transparency is
honored at the device.

The VI Design Pro window consists of these basic components:
e Title, Menu and Tool Bars
— Title bar
— Activity indicator
—  Menu bar
—  First tool bar buttons and list boxes
— Second tool bar buttons and list boxes
e Input Source section
e Resource Notebook section
e Graphical Display section
—  Graphic display tool bar buttons and list boxes

e QOutput Resource section
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e Status bar
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Other functions described are:
e Edit modes of operation

e Control and Function keys
e Using the Smart Editor

e Error handling
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Title, Menu and Tool Bars

The upper most portion of the VDP application consists of components described in these sections:

Xerox FreeFlow VI Design Pro - [C\Program Files (x86)\Xerox\VIPP\vide\xgf\demo\billb.Im] - X
File Edit View Debug Help

BO® = () DEm I ©@ 00 & [bilbim v i @5 0

/acB AvantGarde-Book ~[10 |l /Brack v (none) < U A I reack ~

e Title bar

e Activity indicator
e Menu bar

e Primary Tool bars

TITLE BAR

The title bar provides this information:
e Product name and version

e Folder name

e Project name

e File name, including path

When a project is open, the title bar provides both the folder and project name, for example, folder: xerox, project:
goljob. When working on a single resource, the name of the resource is displayed, for example: [C: \Program
Files (x86) \Xerox\VIPP\xgfc\xerox\goljob\bill. frm].

In addition to the product title, the title bar contains standard Windows buttons that are used to control the size of
the VI Design Pro window on the desktop and to close the program.

ACTIVITY INDICATOR

The activity indicator helps you to determine whether VI Design Pro is still performing the requested operation.
When lengthy VIPP® is processing such as a long file copy or search operation takes place, the gears on the activity
indicator turn.

MENU BAR

When VI Design Pro window is accessed, the menu bar appears near the top of the window.
The drop-down menus available from the menu bar are:

e File menu

e Edit menu

e View menu

e Debug menu

e Help menu
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File Menu
The File menu provides these functions:
New

This option allows you to create a new VIPP® application. When you first select this option, the Welcome to the
VI Design Pro Wizard dialogs display. When the Wizard Classic is clicked, or when Always Use Wizard Classic was
previously enabled on the Welcome to the VI Design Pro Wizard window, the New VIPP Application window
displays.

For detailed information about how to display and use either of these windows, refer to Creating or modifying
applications.

Open

This option allows you to open an existing VIPP® application.

When you access File > Open, the Please choose the file to load window opens, and the Look in field displays
the name of the last directory from which you loaded a file. If this is the first time after installation that you are
loading a file, the Look in field defaults to the VI Design Pro file folder that was loaded on the system when you
installed the VI Design Pro.

For more information about how to use this window, refer to Creating or modifying applications.

Close

This option allows you to close an open VIPP® application. VI Design Pro automatically closes the open
application when it is not closed before opening another application or template. You will be prompted when
you do not save the changes to the application.

Save

This option allows you to save the changes made to the current page of the existing VIPP® application. For
example, when you make changes to the JDT tab and select File > Save, only the changes you made to the JDT
tab are saved. Use File > Save All to save all the changes made to the VIPP® application.

Save As

This option allows you to save the currently active file using a new name. When you select this option, the Save
As window displays, and allow you to specify the directory and file name to use for the new file.

In general, use File > Save As in VI Design Pro to copy a portion of the current application to a different file
name so that you can use it again with a different application. Using the Save As tool bar button has no effect
on the files that are currently included in the current application.

Save All
This option allows you to save all of the changes that you made to the VIPP® application. Use File > Save to
save changes to the current page of the application when you only made changes to the JDT tab.

Copy Project

This option allows you to copy a VI Project, and to use an existing VI Project as a template for a new project.
When you select File > Copy Project, the Please choose the project to copy window displays, this window
allows you to browse for and select the project you want to copy.
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Once the project to copy is selected, you will be prompted to enter a new folder and new project name. If needed,
enable the check box to include the original project's history in the new project.

Merge Database Projects

This option allows you to merge database projects. The option provides the means to merge database files with
disparate header names and to rename the database fields or names in the DBM file.

When you select File > Merge Database Projects, the Merge Database Projects dialog displays. Use the dialog
to browse for, and select the data you want to associate in a VIPP® database project, with the DBM file of
another database project.

When you click on the Browse button next to the Source Database Project or CSV File window, the Please choose a
source database project or CSV file screen is produced. Use the screen browse for and enter a data source. The data
source can be either a VI Project (. vpc or . vpf file) or a CSV file.
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After you select the source database project, use the Browse button next to Target Database Project to open a
similar screen from which to browse for and choose the target database.

When both source and target projects have been selected click OK to continue.

When the data source is a CSV file, you will be prompted to specify the field delimiter of the CSV file. The first line
of the CSV file must contain data field names. The data must begin on the second line.

After the database files and field delimiter have been defined the Map Database Fields dialog displays. Map the
fields of the data source to the fields in the target project.

The Data File Fields column contains the fields found in the source submission file or CSV file. The DBM File Fields
column contains the fields in the target project. When you select an entry from these columns, a sample data value
will be displayed below the column as an aid in mapping the source and target fields.

To map fields with the same values, highlight the fields to map and click on the Map button.

When fields are incorrectly mapped, select the appropriate Mapped Fields entry and click on the Unmap button.
The entry is removed from the Mapped Fields column and the appropriate fields are added to the Data File Fields
and DBM File Fields columns.

When mapping is complete, click on the OK button. The following files will be modified:

e The target project submission file will contain the field names and data from the source project or CSV file. The
SETDBSEP parameter will be modified as necessary.

e The target project DBM file will be modified such that all the original field references (e.g., FIELD1) will be
replaced with the field names from the new target project submission file (e.g., Fname).

The source project files (or source CSV file) will not be modified.
When fields are not mapped, the Project Merge Information dialog will be displayed.

Click OK to confirm, the modified target project will be opened in VI Design Pro.
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Create Project

This option allows you to save an existing VIPP® application as a VI Project.

Export Project Container

This option allows you to create a compressed archive file from the currently loaded VI Project. The compressed
archive file can then be used for activities such as an email attachment, archiving, deployment, and so on.
When you select File > Export Project Container, the Please select export destination window displays, and
allow you to specify the file name and destination for the archived file. Once you specify a directory and file
name and select Save, VI Design Pro creates the compressed archive file. The compressed archive file will have a
file extension of .vpc.

Import Roman PostScript Fonts

Import Special PostScript Fonts

These options allow you to import PFA and PFB type fonts into the VI Design Pro fonts directory.

Use Import Roman PostScript Fonts for fonts using the Standard Roman (or Latin) Character Set as defined in
Adobe's PostScript Language Reference Manual. This is the option generally used for Latin.

Type 1 fonts delivered by font vendors. These fonts are suitable for re-encoding using the default re-encoding
table, and can be referenced in the xgf\encoding\fontlist file.

f Note: Xerox Specialty Imaging fonts must be imported into VI Design Pro using the Import Roman Fonts

‘ option described above in order for VDP to find the fonts and render them on the screen. A pattern
representing the special effect appears on-screen, as the effect is only generated on the FFPS when the
application is printed.

Use Import Special PostScript Fonts for fonts using any other character set (typically barcode fonts or fonts
converted from other legacy formats). These fonts must not be re-encoded and must be referenced in the xgf
\encoding\nullfl file.

Using either option, one or more fonts can be selected. The fonts will be converted into regular PostScript fonts and
placed inthe C: \Program Files (x86) \Xerox\VIPP\vide\fonts directory. Also, as part of the font
conversion process, the file C: \Program Files (x86) \Xerox\VIPP\vide\xgf\encoding\fontlist
(for roman fonts) or C: \Program Files (x86) \Xerox\VIPP\vide\xgf\encoding\nullfl (for
special fonts) will be updated with the newly imported font names. By default, the VIPP® font names are of the
incremental form /RFAAxxxx (in fontlist) or /SFAAxxxx (in nullfl) where xxxx is a number ranging from 0000 to
999999. The resulting fontlist or nullfl file can be edited to change these names or add font family information.

Within VI Design Pro, the font key names cannot be more than 10 characters long, not counting the slash (e.g.
/RFAA123456), due to current constraints in the GUI menu display width format; however, this limit should be
sufficient for most purposes since VIPP® font key names are meant to be short names used as shortcuts for the long
font names.

@ Important: These fonts are often subject to licensing agreements and must be used in accordance with the
terms of the agreement. You are responsible for checking the licensing agreement for any fonts and
complying with the terms before installation for use with VI Design Pro.

Proof Print

This option allows you to print a job to verify the printed output. This option is intended for short-run printing for
use in proofing the output of an application. This option can only be used with a PostScript printer.
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j’ Note: VI Design Pro is a design tool that allows you to test subsets of the print job data. Do not use VI
Design Pro to test print jobs that exceed 100 pages. For best results, Xerox recommends that you limit the
size of the subsets to 20 pages.

When you select File > Proof Print, the Proof Print window displays. Use this window to select the locally attached
or network PostScript printer on which to print the application, specify the print criteria to use, and select any
related resources.

Use the Use Evaluation License box to specify that you are using the VIPP® Evaluation license to print the job. The
default is to leave this box blank. Refer to the VIPP® Language Reference Manual or Help > VIPP Language
Reference Manual for more information about VIPP® evaluation licenses and how they impact the print jobs.

Use the Page Range boxes to define the range of pages to print. The page range selection in File > Proof Print
refers to logical pages, while the graphic display shows the current and total physical pages of the application. This
means that for Multi-Up applications the Proof Print page range selection values may not correspond 1-to-1 with
the actual number or position of logical pages. Select the range of pages to be printed based on the desired logical
page numbers, not the physical page numbers.

Use Select resources for an additional printout list box to select resources to include in the job. The list contains the
VIPP® application resources associated with the item you have selected to print.

Convert PDF to EPS

Use Convert PDF to EPS to manually convert PDF files to EPS. Select the PDF file(s) to convert. You will be
prompted to supply the target folder for the .eps files.

Modify PDF with Embedded EPS

VIPP® supports the use of PDF files as variable resources. However, VIPP® can only use the actual PDF file when
printing to an APPE engine. When printing to a PostScript engine, VIPP® needs to convert the PDF to EPS. The
process to embed the PDF file with EPS can be done in one of two ways:

¢ Inline (using VI Design Pro), when adding PDF files to your project
e In batch mode using the Embed PDF with EPS option.

V1 Design Pro will detect any PDF file added to a Project, and if not embedded with EPS, will embed the EPS
information. This process can take a second or two per PDF. You can avoid this task interrupting your design
work by embedding the EPS information in batch mode prior to editing your job, by using the Modify PDF with
Embedded EPS option. To do so, place all PDF files in a folder, then select the Modify PDF with Embedded EPS
option. Next, point to the folder containing the PDF files and select the PDF file(s) to embed.

Advanced PDF Options
Advanced PDF options such as transparency, are lost when generating the EPS image file, but are still retained in

the PDF file. When printing the PDF to the PS interpreter, VIPP® will use the embedded EPS language.

Do not use this option with the FFPS Adobe Print Engine (APPE)
When you design applications targeting the FFPS APPE that use PDF resources, do not use this option. APPE can
directly ingest the PDF resources in a VIPP® application.

Export Job as PDF

To use the Export Job as PDF option, you first have to open the job in VI Design Pro. VI Design Pro's GUI has been
restricted, for performance reasons when developing VIPP® applications, to only display the first 100 records.
Although you may not be able to load a large job (greater than 100 records) fully into VI Design Pro's GUI, when
you select the option to Export Job as PDF, VI Design Pro will print all records, based on the submission data file you
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selected.

With a job loaded into VI Design Pro, select File > Export Job as PDF. A dialog box will be displayed. Use the
dialog box to specify the name of the PDF file. By default, the system will use the job name, and the folder to store
the PDF file.

Export Job as PDF X
- v H « VIPR » xgfc » projects v 0 Search projects
Organize = New folder = o
A e ~
[ This PC Mame Date modified Type
;, Eln Objed; arabic_utf8 6/1/2022 4:45 PM File f
B Desktop cce 1/21/2022 11:36 AM File f
) cceec 1/21/2022 11:38 AM File f
\z| Documents
copy_1 1/21/2022 11:31 AM File f
* Downloads B T
) copy2_1 1/21/2022 11:33 AM File f
& Music copy123 1/21/2022 12:01 PM File f
& Pictures dddd 1/21/2022 11:49 AM File f
‘ Videos DLTEST 6/1/2022 3:57 PM File f
5 Data (C) fff f25/2022 3:32 PM File f
fehared 1N/28/2021 5:44 PM Filef ¥
¥ Network M L 3
File name: | billg ~
Save as type:  PDF (*.pdf) v

A Hide Folders Cancel

After specifying the PDF file name, browse to the folder in which you want to store the PDF file, then select Save to
move to the next option screen.

f Note: Depending upon the job options used (resolution, etc) and the number of records being processed, the
time taken to create the PDF using the "Export Job as PDF" can take a while (5000 records may take 3
hours), locking up your workstation for this task. We recommend using the Export Job as PDF for small record
counts and using the VI Project Container (.vpc) format for larger record counts. The same 5,000 records
when exported to a .vpc file takes a few seconds to save the .vpc file and depending on the print engine, 25
minutes to print on a Xerox print device enabled with VI Compose.

The Options panel for the Export Job as PDF will be displayed.

These options can be selected:

PDF QUALITY SETTINGS DESCRIPTION

High This will generate print quality PDF. Because the PDF file will
be of a higher resolution, it may take longer to generate the
PDF file and the size will be larger than the other options.

Medium This will generate a PDF of medium print quality. This will be
quicker to produce than the option above and the PDF file
should be smaller in size.
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PDF QUALITY SETTINGS DESCRIPTION

Low Intended for proof or archive & viewing, this will generate a
PDF of low resolution. This will be quicker to produce than
the option above and the PDF file should be smaller in size.

Custom This option allows you to browse your file system for Adobe

Job Option files, which allow total control of the options used
to generate the PDF file.

View PDF after completion

VI Design Pro will generate the PDF file and save to the
location you specified above. If you select View PDF after
completion, VI Design Pro will attempt to open the PDF file
in Adobe Acrobat or Reader. If neither are present on your
PC, then this option will be ignored.

Create Log file

This option will generate a log file detailing JobOptions file
used, Output Folder, font information, etc. This option is
recommended only if you need to trouble shoot the PDF
generation. If this option is used, it is up to the user to
manually delete these log files (located in the same folder as
the PDF file).

Use production data for submission (if available)

If a production data file has been added to the project using
the Add Resource to Project option, you can select to print
that production data file by selecting this option. If this
option is unchecked, VI Design Pro will assume no production
data file exists and will use the data file used during the
design of the application.

42

Xerox® FreeFlow® VI Design Pro Software User Guide



VI Design Pro GUI

PDF QUALITY SETTINGS DESCRIPTION

Include media and finishing options

Select this option to include all of the media and finishing
options that have been defined and enabled for the job in
the finished PDF.

This option is intended for use with FreeFlow Print Server
devices using the Adobe PDF Print Engine (APPE). It will have
no effect on any other printer.

Selecting this option will increase the size of the resulting
PDF, sometimes significantly, depending on the number of
media changes and finishing options defined for the job and
the total number of pages.

Create PDF/VT1 compliant

Select this option to create a PDF/VT1-compliant PDF.

There are two options available to select: PDFX3 2003
Joboptions and PDFX3 2003 JPN Joboptions.

The additional profile options are available when you select
Include media and finishing options and Create PDF/
VT1 compliant PDF to create PDF/VT-1-compliant PDF files
that include media and finishing options.

j’ Note: Not all printers support PDF files that contain
media and finishing requests or that are compliant
with the PDF/VT-1 standard. Only print server systems
support feeding and finishing requests.

The graphic below shows a typical VI Project file. The TestText.dbf file is the test file used during the design of the
application. This is signified by the Printer and Cog wheel icon. The vtpworkshop.dbf file has been added as a
production data file, as signified by the Printer and the number "1".
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Project Resources

roject SI_CK_SingleLayer_
P Project 'SI_CR_SingleLayer_VP'
& Attributes
itle: roject Container: SI_CR_SingleLayer_VP.vpc
EITIVIP' C I SI_CR_SingleL VP
uthor: FreeFlow esign Express 13, _x64 for Win¢
& Author: FreeFlow VID ign Ex 13.0 (CC11_x64 for Wi
(& Creation Date: 2016-10-18, 12:54:07
& Copyright: (c) 2016
Description: VI Project created with FreeFlow VI Express and
P ) P
|;E_| Version: VDE 15.0 (BuildTime: Aug 19 2016, 16:25:44)
ords: g - roject, A
& Keywords: VIPP, VPC, VI Project, VPP, VDE
s Resources
[ Local
O Folder Shared
B3 Global Shared

& History

Recent Files

This option displays the last four files that you loaded on VI Design Pro. Use File > Recent Files to select and
reload one of the listed files.
Exit

This option allows you to exit VI Design Pro. When there are unsaved changes in an open VIPP® application you will
be prompted to save them.

Notes About Exporting a Job as a PDF

VI Design Pro can export the VIPP® application to a PDF file in a location you specify on your file system.
Additionally, if the option is checked, it will open the PDF in Acrobat Reader for viewing purposes. Other options can
be checked to enable a log file or to specify the sample or production data file.

Efficiency

Exporting to a PDF is not as efficient as outputting to VIPP® legacy or VI Project formats.

Caveats when exporting a PDF file:

Unpredictable results will occur if using Xerox Specialty imaging and exporting to PDF. Xerox Specialty Imaging
effects are not supported when exporting to PDF.

Plex changes within a job are not supported unless you are printing to an FFPS APPE engine supporting PDF/VT.
Feeding and finishing options selected within a job may not be supported unless you are printing to an FFPS
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The table shown below is a comparison of printing jobs containing 50, 100, 500, 1000, 3000 and 5000 records,
to exporting the same files using the PDF option. Included in the comparison is the time to generate the files (.

vpc and PDF) and print those files on the same Printer, and a comparison of the file size based on the record

count.

VI Design Pro GUI

e The application used for the performance test below is a 4 up Post Card application printed duplex on a 12’
x 18’ sheet.

e The PDF output was generated using the Standard-USLetter.joboptions file.

e The target print device was an FFPS XC1000.

VPC PDF
PROCESS CREATION PDF VPC TIME
AND PRINT | AND PRINT CREATION SAVINGS 2
NUMBER OF TIME (IN TIME 1 (IN TIME (IN (IN
RECORDS VPC SIZE SECONDS) SECONDS) PDF SIZE SECONDS) SECONDS)
100 129mb 57 66 1.35mb 7 9
500 129mb 152 331 3.84mb 26 179
1000 129mb 736 1,366 6.39mb 46 630
3000 129mb 887 4,151 17.3mb 131 3,264
5000 129mb 1,446 6,932 27.5mb 212 5,486

1. Includes PDF creation time on Workstation.

2. VPC Time Savings is the difference in time when using a .vpc and VI Compose (on the Printer). Based on the
information presented in this chart, there are substantial performance benefits to using VI Compose on the target

print device and the vpc output from VI Design Pro when dealing with large record volumes.
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j’ Note: Times will vary based on the sheet size, the complexity of the application, the type of image, and
conditional logic applied. The chart above should be used as a guide only. For more accurate information
perform the same type of test on your own equipment.

Based on the results shown in the chart above, there are obvious benefits to using VI Compose on a Xerox
print device when printing large volumes of records. If not already enabled, contact your local sales
representative to purchase VI Compose for your print device.

j’ Note: When VI Design Pro is generating the PDF file, the workstation should not be used for other purposes.
Using the workstation for other purposes will greatly affect the time.

EDIT MENU
The Edit menu provides these editing functions:

Undo

This option allows you to reverse the most recent text change, deletion, or addition you made on the Input
Source or Resource Notebook section of VI Design Pro's window.

Redo

This option allows you to reverse the preceding Undo operation.

Cut

This option allows you to remove selected text in the Input Source or Resource Notebook section, or to remove a
selected object in the Graphical Display section. Text or objects removed by Edit > Cut are stored on the
Clipboard.

Copy

This option allows you to copy selected text in the Input Source or Resource Notebook section, or to copy a
selected object in the Graphical Display section. Text or objects copied by Edit > Copy are stored on the
Clipboard.

Paste

This option allows you to paste the contents of the Clipboard at the current cursor position in the Input Source,
Resource Notebook, or Graphical Display section.

Select All

This option allows you to select all of the text in the area in which the cursor is currently positioned. Cursor
position and related options are described here:

Input Source section all text in that section will be selected

Resource Notebook section all text for the file displayed for the resource listed
under the current tab will be selected. To select the text
for more than one tab in the Resource Notebook
section, you must access each tab separately and then
choose Edit > Select All again.

Selected text is highlighted with a dark blue background. Once the text is selected, a cut or copy operation can be
performed.
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Find

This option allows you to search either the Input Source section or the currently tabbed resource in the Resource
Notebook section for the first occurrence of a text string. Narrow the search criteria by enabling the Match
whole word only or Match case fields.

Once you select Edit > Find, VI Design Pro locates the specified string. When a matching string is found, VI
Design Pro highlights the found string.

Find In Project

This option allows you to search an entire project for all occurrences of a particular text string. When you select
this option, the Find In Project window displays. Narrow the search criteria by enabling the Match whole word
only or Match case fields. Refer to Output Resource section for more information.

Replace

This option allows you to search either the Input Source section or the currently tabbed resource in the Resource
Notebook section for each occurrence of a text string and replace the string with another string. The search
begins following the current cursor position.

Use Find what in this window to identify the string to locate and replace. Narrow the search criteria by enabling
the Match whole word only or Match case fields.

Use Replace with to specify the string with which to replace the found text. To selectively replace the found
strings, use Find Next and Replace. Use Replace All to make global changes.

Choose Resource Encoding...
This option invokes the Choose Encoding to Use for Resource Display dialog. Refer to Encoding multi-byte fonts
for more information.

Mark text as Comments
This Ctrl+Alt+C allows you to add the % that marks a comment to the beginning of each line in a block of
selected text.

Unmark commented text

This Ctrl+Alt+U allows you to remove the % from the beginning of each line of selected text. Any lines in the
selected block of text that do not begin with a % will be ignored.

VIEW MENU

The View menu provides the capability to display these views in VI Design Pro window:

j’ Note: If no view options are selected, VI Design Pro window displays only the graphical representation of
the current page.
Source

This option performs the same task as the View Source button on the first tool bar.
When you enable View > Source variable data, the resource notebook containing the source code for the
resources, and the graphical representation of the current page are displayed. Resize the windows and edit the
contents in this mode.

Hexadecimal

This option performs the same task as the View Hexadecimal button on the first tool bar.
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When you enable View > Hexadecimal, the variable data, the resource notebook containing the source code
for the resources, and a graphic representation of the variable data or resource selected in hexadecimal format
are displayed. The windows can be resized, however, you will not be able to edit the contents.

The next time you select the option which removes the checkmark, the graphical representation in the Graphical
Display section returns to its original state.

j’ Note: The Hexadecimal option cannot be selected unless the Source option is already enabled.

Output

This option allows you to display the results of the most recent Find in Project operation. The section windows
can be resized and the contents edited. This option performs the same task as the View Output button on the
first tool bar.

Full Screen

This option allows you to display a graphical representation of the current page in full screen mode, the same
task as the Full Screen button on the first tool bar.

To disable full screen mode and return to the original view, select the End Full-Screen Mode button located at
the end of the top tool bar.

DEBUG MENU

The Debug menu provides access to start, stop and reset a debug session, as well as a way to inspect breakpoints
and run to and step past a set breakpoint. The menu consists of these options:

Insert/Remove Breakpoint

This option inserts or removes a breakpoint at the line of the current cursor location of the active text resource,
the same task as the Insert/Remove Breakpoint button on the first tool bar. This option can only be selected
when there is no active debug session in progress. A set breakpoint is indicated by a red stop sign indicator on
the left edge of the text resource.

View Breakpoints

This option displays a list of the currently set breakpoints by filename and line number, the same task as the
View Breakpoints button on the first tool bar. This option can only be selected when there is no active debug
session in progress. You can browse through the currently set breakpoints by double-clicking the left mouse
button on a breakpoint in the list, which will set a small green search marker at the selected breakpoint. Once
you have selected the desired breakpoint, you can close the breakpoint list and, if desired, use the Insert/
Remove Breakpoint menu option to remove the breakpoint.

Start/Stop Debug Session

This option is used to begin or end a debug session, the same task as the Start/Stop Debug Session button on
the first tool bar. This option can only be selected when there are one or more breakpoints set. During a debug
session, most of the rest of the user interface including the Resource Notebook tabs and Graphical Display
buttons, is disabled, this is done to prevent operations that would disrupt debug operations. Details about
running a debug session and recommendations are discussed in more detail in its own Debug Session section.

Run to Next Breakpoint

This option is used to execute the current page of the loaded job until the next breakpoint is hit, the same task
as the Run to Next Breakpoint button on the first tool bar. This option can only be selected during a debug
session. If a breakpoint is hit a yellow arrow marker, also referred to as the program counter, will indicate the
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location of the breakpoint on the line which was just executed. If there are no more breakpoints encountered
the debug session will display the current page of the loaded job and the debug session will automatically end.

Step to Next Line

This option is used to step from the most recent executed line to the next, the same task as the Step to Next
Line button on the first tool bar. The next line may or may not be the next physical line of the text resource
depending on the logical conditions or other operations that are determined by the contents of the text
resource. The yellow arrow marker (program counter) will relocate to indicate the location of the line which was
just executed. If there are no more lines left to execute for the current page of the loaded job the debug session

will display the current page of the loaded job and the debug session will automatically end.

Reset Debug Session

This option is used to reset the current debug session, the same task as the Reset Debug Session button on the

first tool bar. When this option is selected the internal history of which breakpoints have been hit and the

location of the program counter are both wiped clean, just as if the debug session had been started fresh. This
option is useful if the user accidentally steps past a point of execution and wishes to run or step to that location

again without having to stop the debug session entirely and restart it again.

HELP MENU

The Help menu provides access to the online help for VI Design Pro and VIPP®, as well as version and copyright
information about VI Design Pro. The menu consists of these options:

VI Design Pro Help
This option accesses the VI Design Pro Online Help. Use the Contents, Index and Search tabs to locate help
information.
VIPP® Language Reference Manual
This option accesses the VIPP® Language Reference Manual Online Help facility. Use the Contents, Index,
Search, and Favorite tabs to locate the related help topics, for example, VIPP® command information.
Install/Update Software License

This option allows you to identify the name and location of a valid license file to VI Design Pro. Some of the
conditions under which you would use this option include:

e Avalid license file was not available at the time of installation
e The current license is about to expire or has expired
e To convert from the demonstration version of VI Design Pro to the fully licensed software version.

When you select this option, the Please select the license file window appears. Use this window to select the
directory and name of the file that contains the valid license information. Once the appropriate file name
appears in the File name field, select Open.

When the License Update Requires Restart window appears, select OK to install or update the license file.

About VI Design Pro

This option provides copyright and version information for the VI Design Pro application.
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PRIMARY TOOL BARS

The tool bars in the upper most section of the VDP application window consist of:
e First Tool Bar Buttons and List Boxes

e Second Tool Bar Buttons and List Boxes

First Tool Bar Buttons and List Boxes
Use the buttons on the first tool bar of VI Design Pro window to perform numerous tasks relating to file operations.

(B = JORO) = o EeEm I ©@ (] <X SICR SingleLayer sdat.sub v i 88 0

This section describes the function of each button or list box available on the first tool bar, in order, beginning at
the left-most button.

f Note: Windows ToolTips are enabled on each button and list box found on all VI Design Pro tool bars. The
pop-up information allows you to quickly identify each of the available functions.

New VIPP® Application

This button allows you to create a new VIPP® application. When you select this button, either the VI Design Pro
Wizard window or the New VIPP Application window appears.

The window that appears depends on whether the Always Use Wizard Classic box is enabled on the VI Design
Pro Wizard window. For detailed information about how to display and use either of these windows, refer to
Creating or modifying applications.

Open VIPP® Application or Project

This button allows you to open an existing VIPP® application. When you open an existing VIPP® application,
you can view the application information, modify the existing information, execute the application, and so on.
When you select this button, the Please choose the file to load window appears. Use this window to select an
existing VIPP® application. When you first access this window, the Look in field view shows the name of the last
directory from which you loaded a file. If this is the first time after installation that you are loading a file, the
Look in field view defaults to the VI Design Pro file folder that was loaded on the system when you installed VI
Design Pro.

For more information, refer to Creating or modifying applications.

Save file

This button allows you to save the changes you made to the current page of the existing VIPP® application. For
example, when you make changes to the JDT tab and click this button, only the changes you made to the JDT
tab are saved. To save all changes that you have made to the VIPP® application, use Save all files.

Save all files

This button allows you to save all of the changes that you made to the VIPP® application. If you only want to
save the changes you made to the current page of the application, for example, when you only made changes
to the JDT tab, use the Save file button instead.

Create VI Project from currently loaded application

If you have an application that was created with an earlier release of VIPP® and want to create a Project for
that application, use this button . Using this button allows you to create a Project directory for the application,
copy the associated resources from their previous location to the Project directory, and create a VI Project File. A
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VI Project file has a file extension of vpf. After the . vpf file is created, VI Design Pro automatically loads the
new file into VI Design Pro window.

Export VI Project Container

This button allows you to create a compressed archive file from the currently loaded VI Project. The compressed
archive file can be used for activities such as an email attachment, archiving, deployment, and so on.

When you select this option, the Please select export destination window allows you to specify the directory and
file name to use for the archive file to be created. When you specify a directory and file name and select Save,
VI Design Pro creates the compressed archive file. The compressed archive file has a file extension of vpc.

Cut (Ctrl+X)

This button allows you to remove selected text from the Input Source or Resource Notebook section, or remove
a selected object from the Graphical Display section. Removed text or objects are stored on the Clipboard.

Copy (Ctrl+C)

This button allows you to copy selected text in the Input Source or Resource Notebook section, or copy a
selected object in the Graphical Display section. Copied text or objects are stored on the Clipboard.

Paste (Ctrl+V)

This button allows you to paste the contents of the Clipboard at the current cursor position in the Input Source,
Resource Notebook, or Graphical Display section. The paste operation does not erase the Clipboard.

Find in Project

This button allows you to search a project for all occurrences of a particular text string. When you select this
button, the Find In Project window displays. Use this window to identify the string to locate. This option is the
same as the Edit > Find in Project option.

Undo

This button allows you to reverse the text change you just made to the Input Source or Resource Notebook
section of VI Design Pro window. Use this button to undo the most recent text change, deletion, or addition that
you made to the VIPP® application. This option is the same as the Edit > Undo option.

Redo

This button allows you to reverse the Undo operation you just made to the Input Source or Resource Notebook
section of VI Design Pro window. This option is the same as the Edit > Redo option.

View Source

This button displays the variable data, the resource notebook containing the source code for the resources, and
the graphical representation of the current page. The windows can be resized and the contents edited in Source
mode.

View Hexadecimal
This button displays the resource notebook containing the source code for the resources, and a graphical
representation in hexadecimal format. The windows can be resized, however, the contents cannot be edited.

j’ Note: The View Hexadecimal button cannot be selected unless the View Source option is already enabled or
the View Source button is toggled to display the source code and graphical representation of the current

page.
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View Output

This button allows you to display the results of the most recent Find in Project operation. The section windows
can be resized and the contents edited.

Full Screen

This button displays a graphical representation of the current page in full screen mode. In full screen mode, only
the top and bottom tool bars of the Graphical Display section appear in the window.
To disable full screen mode and return to the original view, select the End Full-Screen Mode button.

Insert/Remove Breakpoint

This option inserts or removes a breakpoint at the line of the current cursor location of the active text resource.
This option can only be selected when there is no active debug session in progress. A set breakpoint is indicated
by a red stop sign indicator on the left edge of the text resource.

View Breakpoints

This option displays a list of the currently set breakpoints by file name and line number. This option can only be
selected when there is no active debug session in progress. You can browse through the currently set breakpoints
by double-clicking the left mouse button on a breakpoint in the list, which sets a small green search marker at
the selected breakpoint. Once you have selected the desired breakpoint, you can close the breakpoint list and, if
desired, use the Insert/Remove Breakpoint menu option to remove the breakpoint.

Start/Stop Debug Session

This option is used to begin or end a debug session. This option can only be selected when there are one or
more breakpoints set. During a debug session most of the rest of the user interface including the Resource
Notebook tabs and Graphical Display buttons is disabled, this is done to prevent operations that would disrupt
debug operations. Details about running a debug session and recommendations are discussed in more detail in
its own Debug Session section.

Run to Next Breakpoint

This option is used to execute the current page of the loaded job until the next breakpoint is hit. This option can
only be selected during a debug session. If a breakpoint is hit a yellow arrow marker, often referred to as the
program counter, indicates the location of the breakpoint on the line which was just executed. If there are no
more breakpoints encountered the debug session displays the current page of the loaded job and the debug
session will automatically end.

Step to Next Line

This option is used to step from the most recent executed line to the next. The next line may or may not be the
next physical line of the text resource depending on the logical conditions or other operations that are
determined by the contents of the text resource. The yellow arrow marker or program counter, relocates to
indicate the location of the line that was just executed. If there are no more lines left to execute for the current
page of the loaded job, the debug session displays the current page of the loaded job and automatically ends.

Reset Debug Session

This option is used to reset the current debug session. When this option is selected the internal history of which
breakpoints have been hit and the location of the program counter are both wiped clean, just as if the debug
session had been started fresh. This option is useful if the user accidentally steps past a point of execution and
wishes to run or step to that location again without having to stop the debug session entirely and restart it
again.
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Refresh current page of application

This button allows you to execute the current page of the VIPP® application along with any variable data
associated with the page. The current page appears at the bottom of the Graphic Display section.

j’ Note: Pressing the Refresh current page of application button is not equivalent to resubmitting the job to a
printer. In VI Design Pro, the memory is not reset when you press Refresh current page of application and
the Ghostscript interpreter continues to run without update for optimization purposes. Only pressing Reset
VIPP then Refresh current page of application, in that order, runs a new instantiation of the Ghostscript
interpreter. Refer to Reset VIPP.

Refresh currently active text resource

This button allows you to execute the currently selected resource. Use this button, or F5, to redisplay the
information for the current resource showing any changes that you have made.

Drop target for Graphic Editing tools

This box displays the name of the resource into which VIPP® commands are inserted when the insert buttons
found on the vertical tool bar in the Graphic Display section are used.

When you have cleared the View Source check box, the drop target box is the only way to select individual
resources for viewing.

View PostScript Segment Anchors

This button allows you to display PostScript segment anchors. If you select this button, the graphic shown on
the button appears in the Graphical Display section to indicate each position at which a PostScript segment
anchor exists.

In general, segments are fragments of VIPP® or PostScript code that are placed on a page. Each placement of a
segment that consists of only PostScript code is noted with an icon in the Graphical Display section of VI Design
Pro window when you enable the View PostScript Segment Anchors button.

To place a segment in the desired position on the page use the drag and drop feature to move the anchor.
When you move a segment anchor, the new position is updated in the code for the application. Segments that
contain VIPP® code have bounding boxes and are not represented by a segment icon.

Reset VIPP®

This button resets VI Compose. This option may be required if you accidentally introduce a VIPP® or PostScript
error when manually editing a VIPP® resource.

Use this button with Refresh current page of application to run a new instantiation of the Ghostscript interpreter
when you have made changes to VIPP® configuration files xgf/src or xgf /encoding.

j’ Note: The only method to reset memory and run a new instantiation of the Ghostscript interpreter is to
press Reset VIPP then Refresh current page of the application, in that order.

Proof Print

This button allows you to print a job to verify the printed output. This option is intended for short run printing
for use in proofing the output of an application. Only use this option with a PostScript printer. This option is the
same as the File > Proof Print option.

Help

This button performs the same task as the Help > VI Design Pro Help option. Use the Contents, Index, and
Search tabs to locate help information. You also can access the VIPP® Language Reference Manual online help
information.
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Second Tool Bar Buttons and List Boxes

Use the buttons and list boxes on the second tool bar of VI Design Pro window to select the font and color options
to be applied when performing operations in Graphic Editing mode.

/HAGB AvantGarde-Book vl ~| Il rsuack ~ (none) ~ U A [ reack v

This section describes the function of each button or list box, in order, beginning at the left most list box.
Font

This box allows you to select the font to use. This list includes all fonts that are currently available.

Font Size

This box allows you to select, or manually enter, the size of the font to use.

Font Foreground Color (Colorkey)

This box allows you to select the name of the text Colorkey to use. The box on the left side of the box displays
the color that you selected. This list includes all of the font Colorkeys that are currently available for use.

Active Font Background Color (BATKey)

This box allows you to select the name of the background attribute key to assign to the background attribute
key index. The box on the left side of the box displays the background that you selected. This list includes all of
the background attribute keys that are currently available for use.

Underline

This button allows you to underline subsequently inserted text. After selecting this button, use Insert Text, or
Insert Paragraph on the vertical tool bar in the Graphic Display section.

Font and Effects Preview/Select/Sample

This button allows you to preview fonts, GEPKey and BATKey effects. It also allows you to change the text
displayed in the Font Sample boxes found in many VDP dialogs.

To change the sample text viewed in the Sample Font window on some Wizard screens, and the Index Font and
Set Font Command dialogs, enter the desired text in the Sample Text box, then select any of the defined effects
and click OK.

Graphic Element Property

This box allows you to select the Graphic Element Property (GEP) key to use. The box on the left side of the box
displays the color that you selected. The list includes all of the GEP keys currently available for use.
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Input Source Section

To display the Input Source section on VI Design Pro window, View > Source or the View Source button on the first
tool bar must be enabled.

Once you open an existing VI Project or VIPP® file, or create a new VI Project using a template, the Input Source
section contains the input data for the project or application. This data can be real data that was created and
obtained from an external application, or it can be sample data that was created while using VI Design Pro to test
the output.

Use the Input Source section to modify the data for an existing VI Project or application, or to enter the data
needed when creating a new VI Project or application. You enter data in either of these ways:

Text Editor mode Place the cursor in the correct position in the section
and enter the changes.

Smart Editor mode Place the cursor in this section and right-click to display
the right mouse button menu.

Key Strokes and Mouse Clicks

When the code for your job is visible on the VDP GUI, you have options for marking or highlighting sections of that
code:

e Use Ctrl+Alt+C, and Ctrl+Alt+U to add or remove a % (comment indicator) from the beginning of the line in
which your cursor is positioned.

e Use your mouse to click one character inside a beginning brace, or an IF/ENDIF, or CASE/ENDCASE command
keyword, to highlight the section of code encapsulated by that brace or keyword.

TLAND
[[0152 2190 3000 1670 0]] SETLEF
/HHE 12 SETFONT
{ [ [ /MaxHeight 80 /CellFill LBLUE /Margins [25 0 10 0] /CellStroke W_S51 ]
fWidth 500 /fCellText (Account Name S5SRPCOUNT.) VSUE ]
/Width 500 /CellText (SBU Acct DIT) 1]
fWidth 500 fCellText (ULtDUNS with Max MIF) 1]
/Width 500 JCellText (Lssessment) ]
/Width 500 fCellText (Proposal) ]
[ /Width 500 fCellText (Mo Opportuntity) ]

] SHROW

} 50 REPEAT
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Resource Notebook Section

To display the Resource Notebook section on VI Design Pro window, the View > Source option or the View Source
button on the first tool bar must be enabled.

Once you open a VIPP® application, file, or VI Project, the resources associated with the application are displayed in
the Resource Notebook section. The code for each resource can be displayed using the tabs that are produced
across the top of the Resource Notebook section. If the application you open or create is a VI Project a Project tab
and window will also be produced. The information for a project includes VI Project attributes, resources, and the
project’s history.

If the number of tabs exceeds the tab space available at the top of this section, a horizontal scroll bar will appear to
allow you to access the remaining tabs.

Use the tabs or click on a resource to view or make changes to the files or resources. Any changes you make are
updated in the code and display in the Graphical Display section of VI Design Pro window once you press F5 or the
Refresh currently active text resource button. This functionality is equivalent to printing the changes on the printer
to verify how they affect the output of the application.

The Resource Notebook section contains the following types of tabs:
e Project Tab

e JDT Tabs

e DBM Tabs

e Segment Tabs

e Form Tabs

e Image Tab

e XJT Tabs

Refer to Creating or Modifying Applications for more information.

PROJECT TAB

When you open or create a VI Project with VI Design Pro, the Resource Notebook section of VI Design Pro window
displays a Project tab. The Project tab contains information identifying the attributes, resources, and history
associated with the project. Use this tab to make changes to the application using left mouse functions, or to
display the contents or attributes of a specific resource.
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B Project 'SI_CR _SingleLayer_VP'
& Attributes
B Title: VI Project Container: SI_CR_SingleLayer_VP.vpc

&) Creation Date: 2016-10-18, 12:54:07
& Copyright: (c) 2016

E] Version: VDE 15.0 (BuildTime: Aug 19 2016, 16:25:44)
& Keywords: VIPP, VPC, VI Project, VPP, VDE
o Resources

B2 Local
[ Folder Shared

[ Global Shared
( History

<

& Author: FreeFlow VI Design Express 15.0 (CC11_x64 for Wing

E] Description: VI Project created with FreeFlow VI Express and

>

VI Design Pro GUI

f Note: Existing VIPP® applications that have not been saved as a VI Project will not display this tab.

The Resource Notebook Project tab is divided into three main sections:

NAME OF THE

SECTION DESCRIPTION

Attributes the project name, title, author, creation date, copyright information, a brief
description of the project, and the version number and keywords associated with the
project.

Resources the files and folders used by the project. Resources are contained in three nodes
named: Local, Folder-shared, and Global-shared.

History The actions included in project history are additions and deletions of resources,
resource movement from one scope to another, and resource modification. When a
project is saved the accumulated actions taken during the session become
modification entries in the project history. Each modification entry is tagged with the
user name and the date and time of the modification.
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Mouse Functions in the Project Tab

Use these mouse functions to make changes to the project within the Project tab:

Drag and drop; dragging resources between folders will cause the corresponding resource files to be moved at
the file system level.

The resources that appear within the Resource Notebook window may be reordered within a folder by using the
mouse to drag and release them. The insertion point is immediately below the drop target. The resource may
be moved to the first position in the folder by dropping it on its parent folder.

Change the order of the submission files (displayed in the Local node) by using the mouse to drag and drop a
new position in the submission order. The entire submission file list will be re-ordered.

Point and click to select a resource. This action executes either the resource or the print file, as appropriate.

Right-click any resource to produce a right mouse button menu. The pop-up menu will contain commands that
can be invoked for the selected resource. Depending upon the type of resource selected, the following
commands can appear:

Properties Allows you to enter text describing the resource. The
entered text will appear after the resource name on
the Project tab.

Launch Associated Application Allows you to launch a Windows application
associated with the selected resource. For example, if
you use a third party graphic editing program, right-
click an image resource in the project, then select this
option to launch the graphic editor.

Add Resource to Project Allows you to add a new resource to a project.

Remove Resource from Project Allows you to remove the resource from the project.

Double-click a resource to cause VI Design Pro to display the resource text in VI Design Pro window, or to open
the notebook tab.

Click the left or right Home button, found at the lower left corner of VI Design Pro window, to display the first or
last tab in the Notebook display.

When multiple graphics are placed in the same area so that they overlap, they are layered. In many graphic
applications the order of the layers can be manipulated by sending a layer to the back, or by bringing a layer to
the front. However, with VIPP®, the order is a function of where the source line appears in the VIPP® Resource
Notebook.

Therefore, rather than reordering layers to select a specific layer, use the Shift/Left-click combination to select and
deselect specific layers until you access the desired layer. In addition, use the rubber band group select functionality
and then deselect until you access the desired layer.

Keyboard Functions in The Project Tab

Use these keyboard functions to make changes on the Project tab:
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Use the Up and Down arrows to select or execute resources in sequence.
Delete resources using Delete.

Add a resource to a project using Insert once any node of the Project tree has been selected. If the currently
selected node is a resource, a new resource will be inserted immediately below the selected node. If the
currently selected node is the Local, Folder-shared, or Global-shared node the new resource will be inserted as
the first resource under the node. When any other node is selected the user will be prompted for the target
scope of the resource then the resource will be added in the first position in the selected node.

The position of a selected resource can be changed by using Shift in combination with the up or down arrow
key.

Change the order of the submission files (displayed in the Local node) by using Shift in combination with the up
or down arrow key. Moving a file to a new position in the submission order causes the entire submission file list
to be re-ordered.

f Note: No more than one node of the Project tree may be selected or manipulated at one time as conflicts

may occur.

Project Tab Icons

Several kinds of icons are displayed in the Project tab area of the Resource Notebook window. The icons are graphic
representations of the resources’ type, submission order, and the active state of each icon.

Resource type icons

The left-most icon indicates the type of resource listed. Unique icons are produced for each of the following
resource types:

e forms

e images

e segments

e text, data, and program files
e PostScript files

e submission files
Submission order icons

The names of submission files appear in the Local node of the Resource section of the Project tab. These files
are accompanied by small printer icons superimposed with a number between 1 and 9, or by a for numbers
greater than 9. The number O is reserved for the PrintFile and VI Design Pro. The PrintFile is displayed as a small
printer icon with a gear alongside.

Submission files always appear in their submission order. Submission file order can be changed by shifting a
submission file in relation to other submission files using the mouse to drag and drop the file, or by selecting the
file then using Shift in conjunction with the up or down arrow key to move it.

Resource state icons

The icons found to the immediate right of the resource type icon reflect the active state of each of the listed
resources.
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e An outlined checkmark appears when the resource has been referenced or executed at least once.

e Asolid checkmark indicates that the file has been referenced or executed in the context of the most recently
executed resource.

The absence of an icon indicates that the resource has not yet been referenced or executed by the VIPP®
interpreter in the context of the current project.

JDT TABS

When you open or create a line mode application with VI Design Pro, the Resource Notebook section of VI Design
Pro window section displays the .jdt tab, which contains the Job Descriptor Ticket (JDT) information for the
application. Use this tab to make changes to the application using the right mouse button menu. Refer to Creating
or modifying applications for further information.

When you select the JDT tab, the Graphical Display section of VI Design Pro window displays and processes the
entire application, including the application data, segments, forms and other resources, as well as any instructions
included in the JDT.

DBM TABS

When you open or create a Database mode application with VI Design Pro, the .dbm tab, which contains the Data
Base Master (DBM) information for the application, is displayed. Use this .dbm tab to make changes to the
application using the right mouse button menu. Refer to Creating or modifying applications for further information.

When you select the DBM tab, the Graphical Display section of VI Design Pro's window displays and processes the
entire application, including the application data, segments, forms and other resources, as well as any instructions
included in the DBM.

SEGMENT TABS

When you access an application that includes segments, or add a segment to an application, .seg tabs appear in
the Resource Notebook section of VI Design Pro window. A separate segment tab appears for each segment that is
associated with the application. These segment tabs contain all the information for the related segments. You can
find segments in applications created in Native Mode, Line Mode, or DataBase Mode.

In general, segments are fragments of VIPP® or PostScript code that are placed on a page. Each segment that
consists of only PostScript code is noted with an icon in the Graphical Display section of VI Design Pro window
when you enable the Show Anchor for PostScript Segments button. Segments that contain VIPP® code have
bounding boxes and a segment icon does not represent it. Refer to First tool bar buttons and list boxes for more
information.

Use the Drag and Drop feature from the Graphical Display section of the window to move this anchor. This action
helps to place the segment in the desired position on the page.

FORM TABS

When you access an existing application that includes forms, or you add a form to an application, .frm tabs display
in the Resource Notebook section of VI Design Pro’s window. A separate form tab displays for each form that is
associated with the application. Forms can be found in applications created in Native Mode, Line Mode, or
DataBase Mode.
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IMAGE TAB

When you access an existing application that includes images, or add an image to an application, the images tab
displays in the Resource Notebook section of VI Design Pro window. Images can be found in applications created in
Native Mode, Line Mode, or DataBase Mode.

The top section of the images tab contains a list of all of the images associated with the application. The bottom
section displays the information for the image that is currently selected. Only one image tab displays, regardless of
the number of images that are associated with the application.

Project Resources

Q@ sampff.dbm [ ps/eps aA fonts ~ images

C\Program Files (x86)\Xerox\VIPP\xgfc\projects\sampff\boy1.jf
CA\Program Files (x86)\Xerox\VIPP\xgfc\projects\sampff\boy2.jf
C\Program Files (x86)\Xerox\VIPP\xgfc\projects\sampff\girl1.)p
CA\Program Files (x86)\Xerox\VIPP\xgfc\projects\sampff\girl2.)p

JPEG Image: C:\Program Files (x286)\Xerox\VIPP
\xgfc\projects\sampff\boyl.jpg

Width: 300

Height: 300

Number of Components: 3

Density Units: Dots Per Inch

Horizontal (X) Density: 300
Vertical (Y) Density: 300

Changes to an image in VI Design Pro cannot be made from this window. Refer to Mouse functions in the project
tab for more information.
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XJT TABS

When you access an existing XML application, or you an XML resource to an application, .xjt tabs display in the
Resource Notebook section of VI Design Pro’s window. A separate XJT tab displays for each XML resource that is
associated with the application.
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Debug Session Section

Once one or more breakpoints have been set and a debug session started an additional tabbed notebook will be
displayed on the left side of the user interface immediately below the Resource Notebook. The tabs in the notebook
are:

Variables

This is a list which shows the name, value, and type of the currently active user variables set direct or indirect
use of the VI Compose SETVAR command. The list is shown in alphabetical order. Double-clicking the left
mouse button on a variable adds that variable to the Watch list.

Watch

This is a list of the name and value of the variables, parameters, or definitions the user has selected for
watching. During a debug session, there can be a great number of variables, parameters and definitions active,
and the watch list provides a convenient way to monitor the value of a specific few of those in a single list
during job execution. The list is shown in the order in which an entry was added to the Watch list. Double-
clicking the left mouse button on a Watch list entry will remove that entry from the Watch list.

Definitions

This is a list of current definitions that do not fall into the category of user variables or system parameters, it
includes things like font definitions, GEPKeys, and database field values at this point of job execution. The list is
shown in alphabetical order. Double-clicking the left mouse button on a definition will add that definition to the
Watch list.

Call Stack

This is a list of what text resource called or caused the current text resource to execute, by filename and line
number, in most recent order. Another way of looking at the call stack is as a list that answers the question: How
did I get here?. The top entry of the call stack is always the current location of the program counter. Double-
clicking the left mouse button on a call stack entry shows the relevant text resource and line marked by the
green search marker at the left edge of the text resource. The number of entries in the call stack list varies
depending on how many times one text resource calls or causes execution of another text resource, but there is
at least one (the current location of the program counter).

Breakpoints

This option displays a read-only list of the currently set breakpoints by filename and line number. You can
browse through the currently set breakpoints by double-clicking the left mouse button on a breakpoint in the
list, which sets a small green search marker at the selected breakpoint. This option is useful if you want to
browse through breakpoints during a debug session but would otherwise be unable to due to the user interface
lock down imposed during a debug session.

A debug session is always in the context of the loaded job and its current page, as selected in the right-hand side of
Graphical Display. To debug for a specific page, ensure that you are not in an active debug session then browse to
the desired page using the Previous and Next page buttons of the Graphical Display. Once you have the desired
page, begin your debug session.

In most programming environments when a breakpoint on a line is hit it is understood that this line is about to
execute, but hasn't yet. For VI Design Pro, when a breakpoint is hit it means this line has just executed. This is a by-
product of how breakpoints are implemented in VI Compose. If you want to break execution before a particular
piece of code is executed, adjust your breakpoint earlier in the text resource as appropriate.
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It is currently possible to set a breakpoint in a text resource that will never be hit during execution. More specifically,
avoid setting breakpoints on lines that consist entirely of comments, or on lines beyond the first line of a string that
contains new lines. Examples:% This is a comment, a breakpoint set on this line will not be
hit. or

(You can set a breakpoint on this first line and it will hit,
but don't set a breakpoint on this line
or on this line, as they won't be hit.) SHP

There may be other circumstances where this situation can occur. If so, stop the debug session and set a new
breakpoint further back in the applicable code, restart the debug session until the breakpoint is hit, (repeating as
necessary), then use the Step to Next Line option to step through subsequent lines.

Interactions with the Input Source and Resource Notebook, along with most other user interface elements, such as
the Graphical Display, are disabled during a debug session. Adding or removing breakpoints can also only be done
when not in an active debug session.

This is a by-product of how breakpoints are implemented for VI Compose, which involves code instrumentation in
combination with a per-breakpoint reference count, all in the context of running in a non-imaging mode from the
first page up until imaging mode is enabled for the currently displayed page. Allowing text resource changes during
a debug session would invalidate code instrumentation, while allowing page number changes or addition/removal
of breakpoints during a breakpoint session would invalidate the reference counts. Any of these would interfere with
the debug state and result in undefined behavior.
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Graphical Display Section

Once you open a VIPP® application or create one using a template, the Graphical Display section contains the
PostScript RIP image of the VIPP® application in WYSIWIG format.
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The displayed image represents the current output of the project or application. Use this section to verify how the
application will look when it is output and to verify that any changes or additions that you make display correctly.

The Graphical Display section can also be used to move information within the display, rather than by using
commands and keywords in the Resource Notebook section of the window. This is known as operating in Graphic
editor mode.

Move or change the output shown in the Graphical Display section using the mouse to drag and drop elements or
data items, or by right-clicking and element to display the element right mouse button menu. Refer to Mouse
functions in the Graphic Display for more information.

When changes are made to the application (for example, to the data, color, formatting, fonts, placement, etc.), or
after you clear the existing image displayed in the Graphical Display section, and you want to redisplay the results
of the current page, select the Refresh current page of application button the first tool bar or F5. This redisplays the
information for the current page with any changes that you have made.

Incorrect display of the job in the Graphical Display section may be the result of multiple SETPAGESIZE
commands within the job.

To display correctly, the SETPAGESIZE parameters must be the same as the VI Design Pro Graphical Display
section’s media size setting. For more information on media size settings see the description of the Media size
drop-down menu in Bottom graphic display tool bar.

Items in the Graphic Element Display cannot be selected on back pages if multi-up and tumble duplex are
used at the same time.

Workaround: selection can be performed on back pages by temporarily commenting out TUMBLEDUPLEX_on or
TWOUP/SETMULTIUP commands; selection can still be performed on front pages.
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Elements seem to disappear if they are dragged outside of the bounding box.

When moving segment elements in the Graphic Element display, elements seem to disappear if they are
dragged outside of the bounding box. This is the expected behavior. The bounding box (defined by the % %
BoundingBox comment and highlighted by the dotted lines) is the area in which you can place elements of the
segment. Anything placed outside of this area will not be imaged. If you want to enlarge this area you need to
modify the % % BoundingBox statement (coordinates in this statement are always in points, see PLRM/2nd ed.
[Red Book] p. 641).

Frames defined via ‘SETLKF' can be selected, moved and resized.

Since a frame overlies the elements within it, to make it easier to select the frame itself the hotspot for the
frame has been enlarged slightly. Left-clicking just outside the outermost of the elements within the frame
should highlight the frame, indicating that the frame itself can then be moved/resized. To visibly differentiate a
selected frame from other elements, the frame when selected will be highlighted in green.

MOUSE FUNCTIONS IN THE GRAPHIC DISPLAY

Right-clicking an element in the Graphical Display section of VI Design Pro window produces the element right
mouse button menu. The menu provides access to the properties dialog related to the selected item, or will display
the source of the selected item in the Resource Notebook section. These options are described in more detail in
Smart Editor.

Individual elements or data items, or a group of elements and data items can be selected to move and then
dragged and dropped in a new position. When this is done, the related information for the moved element is
updated in the Resource Notebook section. This allows both elements and data to be moved at the same time,
rather than having to access the element tab in the Resource Notebook section to move the element, and then
access the JDT tab to move the data that displays within the element.

When you select an element or data item that is dependent on the placement of other elements or data items, all
of the related items are selected indicated by a red, rather than a black, selection box around the items. When this
occurs, and you move the item that you originally selected, all of the dependent items are moved as well.

Remove the dependency between items by right-clicking the item to produce the element right mouse button
menu, selecting Properties, and changing the X and Y coordinates for the item to move.

j’ Note: Graphical Element display support for VIPP® fragments within VIPP® frames (defined via the VIPP®
SETLK command) is limited to selection, view source and properties. Dragging or resize of VIPP® elements
within frames (where detectable by VI Design Pro) is disallowed in the current version of VI Design Pro. In
these circumstances, VIPP® elements within frames will show a red outline when selected, indicating that
they cannot be moved or resized. In some cases (as with the use of the NEWFRAME command) VI Design
Pro cannot determine whether an element is within a frame or not and may not disable movement or resize
for that element. If such an element is moved or resized, the result can be unpredictable.

GRAPHIC DISPLAY TOOL BAR BUTTONS AND LIST BOXES

Use the buttons on the three graphics tool bars on VI Design Pro window to perform tasks related to viewing or
changing the information that appears in the Graphical Display section. The elements found on each of the three
tool bars are described in these sections:

e Top Graphic Display Tool Bar
e Vertical Graphic Display Tool Bar
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e Bottom Graphic Display Tool Bar

Top Graphic Display Tool Bar

The tool bar displayed horizontally across the top of the Graphical Display section of VI Design Pro window
contains these buttons:

LRC >» DD EaE

Hand Tool

This button allows you to move, or pan, the image displayed in the Graphical Display section of VI Design Pro
window.

Zoom In Tool

This button allows you to enlarge the view of a particular portion of the displayed output. To return to the
original view use the Zoom menu found on the horizontal tool bar at the bottom of the screen.

First Page

This button allows you to directly access the first page of a multi-page VIPP® application.

Previous Page

This button allows you to access the previous page of a multi-page VIPP® application.

Next Page

This button allows you to access the next page of a multi-page VIPP® application.

Last Page

This button allows you to access the last page of a multi-page VIPP® application.

Portrait

This button allows you to change the Graphical Display section to portrait orientation display height which is
greater than width.

Landscape
This button allows you to change the Graphical Display section to landscape orientation display width which is
greater than height.

j’ Note: Selecting landscape or portrait orientation does not determine the actual orientation that is used to
print the job. You must ensure that the actual job is formatted correctly, and that you select the correct
orientation for the job when you specify the options for the printer you will use to print the job. In general,
when you print the application, specify the same orientation that you selected using the graphics tool bar.

Actual Size
This button allows you to expand the viewed page in the Graphical Display section to the actual size of the
page

Fit In

This button allows you to visually reduce the page so that the entire page can be viewed in the Graphical
Display section.
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Fit Width

This button allows you to visually expand or reduce the page so that the viewed page is the width of the
Graphical Display section.

End Full-Screen Mode

This button disables full screen mode and returns VI Design Pro window to the original view. Use this button
after you have selected either the View Full Screen option or the Full Screen button and are finished viewing the
contents of the displayed full screen.

Vertical Graphic Display Tool Bar

The tool bar displayed vertically to the left of the Graphical Display section of VI Design Pro window contains these
buttons:

G E

> B
e =

= B

Selection Tool
This button enables the cursor to be used as a selection tool. This allows you to use the mouse to define an area
or select an object. When this button is selected, the cursor displays as an arrow.

Position Tool

This button enables the cursor to be used as a position tool. When this button is selected, the cursor displays as
a crosshair, and a real-time display of the current cursor position is displayed in the status bar at the bottom of

the VI Design Pro screen.
Grid Bottom Left

This button provides a convenient, transparent method of applying the VIPP® BLGRID command to the
currently displayed page or resource. For more information on BLGRID refer to the VIPP® Language Reference
Manual.
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Grid Top Left

This button provides a convenient, transparent method of applying the VIPP® TLGRID command to the
currently displayed page or resource. For more information on TLGRID refer to the VIPP® Language Reference
Manual.

Insert Text

This button allows you to insert text at the point at which the cursor resides.

Insert Paragraph

This button allows you to insert an entire paragraph at the cursor position.

Insert Image

This button allows you to edit an ICALL command.

Insert Segment

This button allows you to edit an SCALL command.

Insert Box

This button allows you to use the Graphical Display window to insert a box into the application.

Insert DDG

This button allows you to insert a bar chart, curve, or pie chart at the current cursor position.

Align Left

This button aligns selected text or objects to the left.

Align Right
This button aligns selected text or objects to the right.

Align Top

This button aligns selected text or objects to the top.

Align Bottom

This button aligns selected text or objects to the bottom.

Align Centered Horizontally

This button aligns selected text or objects horizontally to the center.

Align Centered Vertically

This button aligns selected text or objects vertically to the center.

j’ Note: The alignment buttons on the vertical tool bar always adjust alignment relative to the physical CRT
display, regardless of the orientation of the application. The buttons allow you to move and align selected
objects, but do not change the coded command. For example, using the Align Left button to align a group
of objects entered with the SHC command will not change the SHC (centered) command to a SHL (left
aligned) command.
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Bottom Graphic Display Tool Bar

The tool bar displayed horizontally across the bottom of the graphical display section of VI Design Pro window
contains these buttons and list boxes:

FHAGE AvanctGarde-Book ~ |10 - - /BLACK w (none) b

Zoom menu

This box allows you to indicate or select the percentage by which to increase or decrease the magnification of the
contents of the Graphical Display section.

Change the magnification using one of these methods:

e Manually enter a magnification percentage value in the zoom menu box and the n press Enter. If you exceed
the maximum allowed zoom value an error message will be produced.

e Use the drop-down Zoom menu to select one of the following options:
- 50%
- 75%
- 100%
- 150%
- 200 %
—  Maximum (value)
— Actual Size
—  Fitin Window
—  Fit Width

f Note: VI Design Pro automatically calculates the maximum magnification value available and indicates that
value in parentheses. The calculated value will change depending on the current view produced in the
graphical display.

Page indicator

These buttons allow you to access the first, next, previous or last page of a multi-page VIPP® application. You also
can enter a specific page number and press Enter to access that page.

Media size drop-down menu

This box allows you to select the media for which to size the job as well as to view how the job displays on various
paper sizes. A checkmark displays next to an item when it is selected.

In general, the option selected on this menu indicates the paper size on which to print the job. When changing the
paper selection using this menu, the Graphical Display section of the window automatically changes based on the
selection.

f Note: Although the Media menu can be used to select and view how the application will print on various
paper sizes, the option selected on this menu does not determine the actual paper size used to print the job.
Ensure that the actual job is formatted correctly, and that the correct paper size is selected for the job when
you specify the options for the printer used to print the job. In general, when printing the application, specify
the same paper size selected from this menu.
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@ Caution: Changing the media selection can cause problems with the VIPP® application. For example, a
form that is formatted for A4 may not print at all when Tabloid is selected from the Media menu; and an
application that is set up for US Letter may not look the same when you change the media to A4.
Therefore, always make sure to check the Graphical Display section each time the media selection is
changed to verify if the application displays correctly.

Select any of the following paper sizes, or enter a custom page size:

Index Card (3 x 5in)

ISOB5 (176 x 250 mm)

Postcard (3.5 x 5.5 in)

ISO B4 (250 x 353 mm)

Statement (5.5 x 8.5 in)

ISO B3 (353 x 500 mm)

Executive (7.25 x 10.5in)

ISO B2 (500 x 707 mm)

US Letter (8.5x 11 in)

ISO B1 (707 x 1000 mm)

US Folio (8.5 x 13 in)

JISB7 (91 x 128 mm)

US Legal (8.5 x 14in)

JISB6 (128 x 182 mm)

Tabloid (11 x 17 in)

JISB5 (182 x 257 mm)

Tabloid Oversized (12 x 18 in)

JIS B4 (257 x 364 mm)

A7 (74 x 105 mm)

JISB3 (364 x 515 mm)

A6 (105 x 148 mm)

JISB2 (515 x 728 mm)

A5 (148 x 210 mm)

JISB1 (728 x 1030 mm)

A4 (210 x 297 mm)

PRC16K (195 x 270 mm)

A3 (297 x 420 mm)

PRC 8K (270 x 390 mm)

A2 (420 x 594 mm) (7x71in)

A1 (594 x 841 mm) (8x10in)
AO (841 x 1189 mm) (8x13in)
A4 Oversized(223 x 297 mm) (9x11in)

A4 Tab (225 x 297 mm)

(13x19.21in) (330 x 488 mm)

SRA4 (225 x 320 mm)

(14.33 x 20.5in) (364 x 521 mm)

SRA3 (320 x 450 mm)

(1433 x 22.5in) (364 x 572 mm)

SRA2 (450 x 640 mm)

(14.33 x 26.0 in) (364 x 660 mm)

ISOB7 (88 x 125 mm)

Custom Media

ISOB6 (125 x 176 mm)

The Custom Media selection allows you to specify a custom paper size. When you select this item, the Custom
Media window displays. Enter the paper size using points as the unit of measurement and click OK. Minimum and
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maximum values are displayed on the Custom Media window.

Media specification indicator

This box indicates the defined specifications for the media used for this application.
Page side indicator

This box indicates the side of the page on which the currently selected information will print.
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Output Resource Section

To display the Output Resource section on VI Design Pro window, use View > Output or the View Output button on
the first tool bar.

The Output Resource section is also displayed when you select Edit > Find in Project, enter a search string and
select Find. When VI Design Pro locates the specified string a list of all occurrences of the string appears in the
Output Resource section of VI Design Pro window.

The results of the search operation provide the following information:

e The string for which the search was requested

e The name of the resource and the line of code in which each match is found
e The total number of occurrences found for the requested string

Double-clicking a specific occurrence of a found string in the Find In Project section will immediately locate the
desired line within either the Input Sources section or the Resource Notebook section and highlight the found string
in the corresponding source line of that section.

To close the Find In Project section, toggle the View Output button on the first tool bar, or deselect View > Output.
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Status Bar

The status bar contains information about the current status of the VIPP® application, and contains two navigation
buttons. The left and right Home buttons allow you to display the first or last tabs in the Resource Notebook.

The text displayed in the status bar changes depending upon the placement of the cursor, or the current activity of
the program. In addition to the current status of the program, the status bar can contain expanded ToolTip
information, information about the cursor location, etc.
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Edit Modes of Operation

When using VI Design Pro window to work with the application, manipulate and modify the application information
using any combination of the following interaction modes:

e Text Editor Mode
e Graphic Editor Mode
e Smart Editor Mode

TEXT EDITOR MODE

This capability allows you to place the cursor at any position in the Input Source section or the Resource Notebook
section of VI Design Pro window and use the keyboard to change existing information, add new information, or
delete information from the section. The changes you make display in the Graphical Display section of VI Design
Pro window after you select the Refresh current page of application button or F5.

The text editor uses color to help you easily identify these VIPP® language elements:
e VIPP® commands appear in blue.

e DSC statements (that is, % % commands) appear in light green.

e Text strings within encapsulating parentheses () appear in purple.

e Comments (%) and PostScript or VIPP® start-of-file ( % !) commands appear in dark green.

GRAPHIC EDITOR MODE

This capability allows you to manipulate some of the application information using the display in the Graphical
Display section of VI Design Pro’s window, rather than using commands and keywords. Refer to the Graphical
Display section for detailed information about the graphic editing capabilities of VI Design Pro.

Keep the following in mind when working in Graphic Editor mode:
e Currently, not all graphical elements are supported for manipulation in graphic editor mode.

e Some elements that are supported, are not functional under all circumstances. The following commands are
currently supported, or partially supported, in graphic editor mode:

BEGINRPE and ENDRPE DRAWRDR SCALL

BEGINXPD and ENDXPD ETAand ETS SH

BTA and BTS FILLOMR SHC and SHc

DRAWB and DRAWBR FROMLINE SHJ and SH;j

DRAWBAR ICALL SHMF, SHMf, and SHmf
DRAWBM and DRAWBRM MOVETO SHP

DRAWC MOVEH SHR

DRAWCRV PDF417 SHT and SHt
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DRAWPIE RPEKEY SHX

DRAWPOL

Rotating graphic elements may cause the hotspot to shift slightly below the bottom edge of the display. Because a
graphic element is rotated, the bottom edge may now display on the right or left side, or on the top. Clicking in this
bottom edge area will activate the hotspot.

SMART EDITOR MODE

The right mouse button menu provides this capability. When you click the right mouse button in any text area of VI
Design Pro window, you access the right mouse button menu. This menu provides access to all the Smart Editor
functions that are available in VI Design Pro.

These menu options provide you with a quick and easy way to create or modify the VIPP® application, by specifying
VIPP® command information or adding images to the VIPP® application with the easy-to- use windows that display.
Refer to Smart Editor for further information.

The changes you make display in the Graphical Display section of VI Design Pro window after you select the
Refresh current page of application button or F5.
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Syntax and Formatting Considerations

Since VI Design Pro uses VIPP® and a PostScript RIP to process applications, use any valid VIPP® syntax or
formatting when you manipulate the application using text editor mode. However, neither the Graphic editor mode
nor the Smart Editor mode use VIPP® directly to verify the application source files.

Therefore, if you do not use the VIPP® syntax and formatting conventions as they are described in the VIPP®
Language Reference Manual, you can be unable to use Smart Editor mode or graphic editor mode with that
application. For example, the following example contains both VIPP® and PostScript formatting:

100 0 0 pop pop 200 MOVETO (Hello!) SH

Although this example does not cause problems when edited or executed in Text editor mode, it is problematic in
both Smart Editor mode and graphic editor mode.

j’ Note: VIPP® is a variable document composition and assembly language that uses a postfix notation syntax
similar to PostScript. For this reason, the VIPP® interpreter provided by Xerox has been implemented using
the PostScript language and is required to run inside a PostScript interpreter. Therefore, intermixing VIPP®
and PostScript code can work in some circumstances. This kind of mixed code is not compliant with the
VIPP® language specifications and will break any application or utility expecting a compliant VIPP® data
stream. There is no assurance that such jobs will work correctly with future VIPP® releases. For this reason,
mixed code is not supported and must be absolutely avoided.

However, PostScript code can be used in self-contained resources such as EPS files to be used as form or segments
in a VIPP® job.
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Control and Function Keys

When a project is open in VI Design Pro, some key combinations and function keys on the keyboard have
specifically assigned functions.

The key combinations are listed here:

Ctrl+C

This key copies selected text in the Input Source or Resource Notebook section, or copy a selected object in the
Graphical Display section. Copied text or objects are stored on the Clipboard.

Ctrl+V

This key pastes the contents of the Clipboard at the current cursor position in the Input Source, Resource
Notebook, or Graphical Display section. The paste operation does not erase the Clipboard.

Ctrl+X

This key cuts selected text from the Input Source or Resource Notebook section, or removes a selected object
from the Graphical Display section. Removed text or objects are stored on the Clipboard.

Ctrl+E

This key invokes a Choose Encoding to Use for Resource Display dialog. When the cursor is placed in the Input
Source or Resource Notebook section and Ctrl+E is entered, the Choose Encoding Dialog for that resource is
invoked. Use the dialog to change the encoding used by VI Design Pro to interpret the resource. For more
information, refer to Encoding multi-byte fonts.

The function keys and their assigned functions are listed here:

F1

This function key accesses Help.

F3

This function key finds the next occurrence of a string defined in Edit > Find > Find what: in the currently
selected text window only. Selectable text windows are the Resource Notebook, Input Source or Graphical
Display windows.

F4
This function key inserts XY.

Shift-F4
This function key enters an Insert XY MOVETO.

F4 followed by F5

This function key inserts XY and executes the code.

j’ Note: The F4 and F5 key commands are intended for use with the position tool on the vertical tool bar.

F5

This function key refreshes the currently active resource.
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F9

This function key inserts the « character used to delimit VIPP® arithmetic sub-expressions.

F10

This function key inserts the » character used to delimit VIPP® arithmetic sub-expressions.

Other PC keyboard functions

The Page Up, Page Down, Home and End buttons on the PC keyboard can be used for movement through the
application, and screens within VDP.

The « and » characters are used in arithmetic expressions because parentheses are used as string delimiter only.
The F9 and F10 keys will have this effect only when the cursor is in a VIPP® source code window, or when the cursor
is in a parameter entry field in a SmartEditor dialog.

The « and » characters must be used in pairs (just like parentheses) or a VI Compose error will be generated.

«123» or «VAR1» are legal in VIPP® and VI Design Pro, but are functionally equivalent to just 123 and VAR1.
However, when using a string such as:

(/VARL (456) SETVAR)

WARL will produce “(456)™, and «VARl» will produce “456".
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Using the Smart Editor

Using the Smart Editor content-sensitive right mouse button in the Input Source, Resource Notebook, or Graphical
Display section of VI Design Pro’s GUI pops up menus that provide access to various functions of VI Design Pro
such as:

e Inserting or editing commands, properties, and project attributes
e Adding or deleting project resources

e Launching applications

Smart Editor menus also allow you to view lists of:

e DataBase Field Names

e 'SETVAR'ed Variables

e System Defined Variables

e XML Data Variables

e Date and Time Variables

SMART EDITOR MENU

When you right-click in any text area of VI Design Pro window, you access the Smart Editor menu also known as the
Right Mouse Button menu. This menu provides access to all the Smart Editor functions that are available in VI
Design Pro.

These menu options provide a quick and easy way to create or modify the VIPP® application by specifying VIPP®
command information or adding images to the VIPP® application with the easy-to-use dialogs that display.

The first two options on the Smart Editor menu are Edit this Cmd or Keyword, and Insert the Following Commands,
which are described in these sections:

e Editing a Selected Command or Keyword
e Insert the Following Commands

Descriptions of the Dialogs produced when other Smart Editor menu and submenu options selected are described
in Smart Editor. These functions are described in the following sections of Smart Editor command dialogs:

e Fonts, Colors, and Variables
e Page Layout

e Page Marking

e RPE Items

e QOutput Device Control

e Print File Processing

e Cyclecopy Control

e Page Control

e PDF Interactive Features

e Custom Color Lists
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Editing a Selected Command or Keyword

Use the Smart Editor to edit this Cmd or Keyword option to make changes to the current settings for the selected
or highlighted command or keyword.

To make changes select the command or keyword from either the Input Source section or the Resource Notebook
section of VI Design Pro's window, click the right mouse button to access the Smart Editor menu, then select the
Edit this Cmd or Keyword option. You will be presented with one of the following scenarios:

e The Smart Editor produces a dialog on which to make changes to existing parameters
e The Smart Editor produces a window with a pointer to the help reference for the command
e The Smart Editor menu disappears when the selected command or keyword cannot be edited using this option

In addition, when placing the cursor on an element in the Graphical Display section of VI Design Pro's window and
clicking the right mouse button, the Element menu displays. Use the Properties option on this menu to access the
Smart Editor Edit dialog for the element.

Also double-click on an element in the Graphical Display section of VI Design Pro’s window to access and make
changes in the Smart Editor Edit dialog for that element. When this task is performed, the data that represents the
element is located and highlighted in the Resource Notebook section of the window. If changes to the element are
made using either of these methods, the changes are also made in the related code in the Resource Notebook
section of the window.

In general, the dialogs used to edit a command or keyword contain the same fields that are displayed when the
command or keyword is inserted. However, when a command is edited, the dialog will contain the actual values for
the command, and when inserted it will contain default values. Each of the fields on these dialogs is described in
detail in the related sections of Smart Editor.

When you right-click the color, pattern, or GEPkey of any VIPP® command that supports GEPkey or Color/Pattern,
the Select GEPkey or Color/Pattern dialog appear. Use the dialog to edit the existing color, pattern or GEPKey
settings.

When you right-click any color or pattern name in a VIPP® command that allows a color and/or pattern but does
not allow a GEPKey, the Select a Colorkey dialog will appear. Use the dialog to edit existing color or pattern settings
for the command.

Insert the Following Commands

The Insert the Following Commands option allows you to manually insert commands at the current cursor position.

BASIC COMMAND AND MENU CONTROL

Control the menu options and commands that can be accessed in the Smart Editor by using the SmartEditor
SafeMode option at the bottom of the Smart Editor menu. This option toggles between SmartEditor Safe Mode On
and SmartEditor SafeMode Off.

e When SafeMode is on, (default value) only the commands and command categories available to insert at the
current cursor position are enabled. All other commands are disabled.

e When Safe Mode is turned off, all of the commands are enabled on the Smart Editor menu, regardless of
whether they are functional based on the current cursor location.

All of the Smart Editor command dialogs contain a standard set of control buttons that have specific functions:
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OK Inserts the requested command at the current cursor position using
the parameters you have specified on the Smart Editor dialog. If OK
is not selected the new or edited command will not be inserted.

Help Opens the VIPP® Language Reference Manual help option, which
displays information about the VIPP® command being inserted by
the Smart Editor.

Cancel Cancels any changes you made to the Smart Editor dialog. The
requested command will not be inserted nor will the selections or
changes be saved.

VARIABLE RIGHT MOUSE BUTTON OPTIONS

The Smart Editor produces a variable right-mouse-button menu when you right-click the information in the Input
Source, Resource Notebook, or Graphical Interface windows. Depending on the type of entry that is allowed in the
field from which you access the variable right mouse button menu, the menu can include one or more of the
following options:

e Database Field Names

e 'SETVAR'ed Variables

e System Defined Variables
e XML Data Variables

e Date and Time Variables

When the projects tab is selected in the Resource window, clicking the variable right mouse button displays one or
more of these options:

Add Resource to Project

Remove Resource from Project

Launch Associated Application

Properties (project)

Edit Project Attributes

Database Field Names

When you right-click and the variable right mouse button menu displays the DataBase Field Names option,
selecting that option produces a list containing all database field names defined for the current job, along with
sample field values in parentheses.

Depending on the placement of the cursor in the string field, the item that you select from this list either replaces
the current field entry, or is appended to the field entry at the current cursor position.

e When the cursor is placed in front of the existing string in the field, or the entire string in the field is selected,
the selected item replaces the current string text in the field.

e When placing the cursor at any other position in the field, for example, at the end of the current string, the
selected item is added to the existing string text in the field at the current cursor position.
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'SETVAR'ed Variables

When you right-click a field that accepts integer, real, or string values, or arrays of integer, real, or string values, the
variable right mouse button menu display includes the SETVAR'ed Variables option. If you select the SETVAR ed
Variables option, it displays a list that contains all of the variables defined by SETVAR for the current job.

The item that you select from this list always replaces the current field entry.

System Defined Variables

When you right-click a field that accepts integer, real, or string values, or accepts arrays of integer, real, or string
values, the variable right mouse button menu displays the System Defined Variables option. Selecting the System
Defined Variables option displays a list that contains all of the system defined variables:

BPCOUNT LSP VPOS
cow PAGEH YINIT
CPCOUNT PAGEW ZSPAGE
CURLINE PPCOUNT 417VER
FRCOUNT PRODUCT DDGVER
FRLEFT RPCOUNT DMXVER
HDISP RPLEFT MAXVER
HPOS SHEETH QRCVER
HPOS2 SHEETW SPIVER
LNCOUNT SHPOS VSIVER
LPCOUNT SVPOS VSMVER
LPINDEX VDISP XGFVER

When accessed from an XML job, these XML variables are also included in the system-defined variable list:

XMLATN XMLPAR XMLTAG
XMLATV XMLPATH XMLVAL
XMLDTH

The item that you select from this list always replaces the current field entry.

XML Data Variables

When you right-click a Smart Editor Edit dialog while in an XML job, and the cursor is over a string field, the variable
right mouse button menu displays the XML Data Variables option. Selecting theXML Data Variables option
produces a Choose XML Variable dialog containing a list of the XML variables that can be used in the current job.
Use the list to choose the XML variable you wish to insert.
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Date and Time Variables

When you right-click on the String to Show field of an Insert or Edit Text dialog (SH commands), the variable right
mouse button menu displays the Date and Time Variables option. Date and Time variables can be inserted into the
string, and appended to the current String To Show with a space separator. Date and time variables are:

D_DWL Day (Sunday, Monday, etc.)
D_DWS Day (Sun, Mon, etc.)

D_DD Date (01-31)

D_MOL Month (January, February, etc.
D_MOS Month (Jan, Feb, etc.)
D_MO Month (01 - 12)

D_YY Year (00-99)

D_YYYY Year (1970 - 9999)

D_DOY Day of Year (1-366)

T HH Hours (00-23)

T _HH2 Hours (1-12)

T_MM Minutes (00-59)

T_SS Seconds (00-59)

T_AMPM AM/PM

T_TZN Time Zone (PST, PDT, etc.)

Add Resource to Project

When you right-click any of the resource folders in the Resource Notebook, the variable right mouse button displays
the Add Resource to Project option.

Use this option to browse for and select one or more resources for the project displayed in the Resource Notebook.
When you select a resource to add to the project, the Indicate Resource Destination dialog is opened.

84 Xerox® FreeFlow® VI Design Pro Software User Guide



VI Design Pro GUI

Indicate Resource Destination

The resource 'C:\Program Files (x86)\Xerox\VIPP\xgfc\projects\arabic_utf8\arabic_utf8_vipp.jdt’ is
referenced within your project but is not yet part of your project.

Where would you like this resource to be placed?

® Local
(O Folder Shared
O Global Shared

What would you like to name this resource?

. arabic_utf8_vipp.jdt

0K

Use the Indicate Resource Destination dialog to select the location for the resource, and, if required, to rename the
resource.

For information on the types of resources used in VI Projects, refer to VIPP® Resources in the FreeFlow VI Compose
User Guide.

Resource Conversion

A feature of the add resource to project option is resource conversion. When a file in Adobe PDF or Word format is
selected for addition to a project, VI Design Pro automatically converts the resource to a PostScript file as it adds it
to the selected folder. The original file remains in its original location, VI Design Pro places a converted PostScript
version of the file in the project folder (optionally, VI Design Pro also places the original resource in the project
folder).

In order to successfully convert Word and Adobe PDF files you must have Word and Adobe Reader installed on the
workstation. The feature uses the functions of those programs to convert the files.

Remove Resource from Project

When you right-click any resource in the Resource Notebook, the variable right mouse button displays the Remove
Resource from Project option. Use this option to remove the selected resource or resources from the project. The
files are removed from the project but are not deleted from the system.

Launch Associated Application

When you right-click a resource in the Resource Notebook, the variable right mouse button displays the Launch
Associated Application option. Use this option to launch the program related to the resource. For example, choosing
this option after right-clicking an Adobe PDF file will launch Adobe Reader.
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Properties (project)

When you right-click a resource in the Resource Notebook, or an object in the Graphical Display section of VI Design
Pro window, the variable right mouse button displays the Properties option. When this option is selected VI Design
Pro produces a dialog containing property information about the resource's properties. Add or change the
information in the dialog as necessary.

Edit Project Attributes

When you right-click any of the listed attributes in a project displayed in the Resource Notebook, the variable right
mouse button displays the Edit Project Attributes option. When this option is selected VI Design Pro produces a
dialog containing information about the project’s attributes. Add or change the information in the dialog as
necessary. The attributes for a project are:

o Title

e Author

e Creation date
e Copyright

e Version

e Keywords
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Using the Element Right Mouse Button Menu

When placing the cursor on an element in the Graphical Display section and right-clicking, the element right mouse
button menu displays. Use the options available from this menu to access the Edit a Show String Command
window for the element, or to identify the corresponding source information for the element in the Resource
Notebook section. Options on the element right mouse button are:

e Properties (element)

e View Source

PROPERTIES (ELEMENT)

The Properties option allows you to access the Smart Editor Edit window for the selected element. When you make
changes to the element using the window that displays, the changes are made in the related code in the Resource
Notebook section of the window.

For example, if you select and right-click a text string element in the Graphical Display section, the Element right
mouse button menu appears.

If you then select Properties from the Element right mouse button menu, the Edit a Show String Command window
appears.

The title and selectable options on this window vary with the command type selected. For detailed information
about how to use this window, refer to Insert Text for the Smart Editor page marking commands.

VIEW SOURCE

The View Source option allows you to locate and highlight the VIPP® command that represents the selected
element.

For example, if you select and right-click a graphic element in the Graphical Display section, the Element right
mouse button menu appears. If you then select the View Source right mouse button menu, the source command is
highlighted in the Resource Notebook section of VI Design Pro window.
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Error Handling

If VI Design Pro detects a VIPP® or PostScript error in the VIPP® application page or resource just executed, an error
window appears in the Graphical Display section.

Press Help to open the online VIPP® Language Reference Manual. The text relative to the error produced will
appear in the right hand window.

An offending command can be difficult to locate, especially when the error occurs in a JDT or DBM file. Therefore, it
may be more time effective for you to interpret the VIPP®/PostScript error and attempt to locate the offending
command yourself.
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This section contains information on how to create or modify the VIPP® applications using the VI Design Pro
Wizard or Wizard Classic facilities. The section also provides information about opening raw XML, Database, or Line
mode files using the VIPP® Cold Start method.

e Creating an XML job from an initial XML data file is a unique process described in VIPP® cold start. This process
varies from the process used to create new native mode projects, referred to as form resource projects, database
mode projects, or line mode projects using the VI Design Pro Wizards. However, after the XML job is created, it
can be accessed and modified as you would any other VIPP® job.

e The VI Design Pro Wizard facility, described in detail in VI Design Pro Wizard overview, allows you to create a
new native mode form resource, project, database mode project, or line mode project. This facility provides step-
by-step windows to help a novice user provide the parameters needed to create a VIPP® job.

e The Wizard Classic facility, described in detail in Using Wizard Classic, allows you to create a new application or
use an existing template. Additionally, you can change data file information, to the associated Data Base
Master (DBM), or to the Job Descriptor Ticket (JDT) file. In addition, you can create a sample data file for use
while testing the application, or associate a new DBM or JDT with a selected data file. This facility is intended for
more knowledgeable or experienced VIPP® users.

When you create or modify any VIPP® application, use File > Open or File > New. Alternatively use the
corresponding Open VIPP® application or project, and the New VIPP® application buttons on the toolbar. When you
make the selection, VI Design Pro produces a series of windows containing information that guide you through the
creation or modification process.
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VIPP® Cold Start

VI Design Pro provides a mechanism to open raw XML data, line mode, and database mode files to create a VI
Project, or otherwise amend the file using VI Design Pro. The instructions provided here are to create an XML mode
VIPP® job, modify them as appropriate to create line or database mode jobs.

Use File > Open then browse for and select the XML data file to use for job submission. Click Open. VI Design Pro
loads the file into the Input Source window, and produces VIPP® cold start instructions in the Graphical Display
areq.

Place the cursor at the beginning of the raw data file and right-click to produce the Smart Editor menu. Select the
Smart Editor Print File Processing > Start XML Mode Processing option to open the STARTXML dialog.

Browse for the desired xijt file, or use the default, then click OK. VI Design Pro inserts the command, an xjt tab is
created in the Resource Notebook section, and a graphical display of the file is presented in the Graphical Display
section of VI Design Pro's window.

To save the file and create a new project press the Create a project from a currently loaded application button on
the menu bar or select File > Save as. You will be prompted to save the file and the VI Project wizard will be
invoked. Follow the on-screen instructions to create and save the project. For information on saving projects using
this wizard, refer to VI Project wizard windows.

Once the project is created, the Resource Notebook section will contain a Project tab in addition to the xjt tab.
Graphic elements on the right side can be selected by the mouse and either double-clicked to bring up the Smart
Editor for the element, or right-clicked to bring up a menu allowing you to invoke the Smart Editor for the element
(Properties) or view the VIPP® source code for the element (View Source) in the same way as line mode and
database mode jobs are edited and viewed.
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VI Design Pro Wizard Overview

VI Design Pro Wizards use some or all of the following standard options on each window:

Back Use to go back to the previous window

Next Use to accept any changes and proceed to the next window

Cancel Use to cancel the wizard. You will be prompted to verify this action

OK Use to approve entries on the screen

Finish Prompts the program to save the entries and complete the file generation
process

You must select one of these options to proceed to the next logical window. To cancel the operation without saving
any changes, click on the button at the top right corner of the wizard window.

When you open a new or existing project or file, or a file template, you access the data file for the application. The
data file references all of the resources that are associated with the application. When you open a file or a file
template, the information for the application (including the actual data file information and the related resources)
displays in VI Design Pro's window.

Always make sure that any files you open are coded for use with VIPP®. For example, make sure that the forms you
access are coded in VIPP® native mode. Forms that are encoded in EPS or TIFF cannot be accessed or edited.

To access the VI Design Pro Wizard, use File > New or the New VIPP® application button on the tool bar. This will
display the Welcome to the VI Design Pro Wizard dialogs.

These are the selections available on the Welcome dialog:

Wizard Classic

Refer to Using Wizard Classic for detailed information on how to use this facility.
Always Use Wizard Classic

Enable the Always Use Wizard Classic box to always invoke Wizard Classic when you select either File > New or
the New VIPP® application button. If you later want to access the Welcome to the VIPP® Wizard window, select
Wizard on the New VIPP® Application window.

Next

Select Next to use the Wizard facility to create a new project. The VI Design Pro Wizard will be invoked whether or
not the Always Use Wizard Classic box is selected.

Enable the button next to the type resource or project to create or modify. Refer to the following sections for more
information about using the individual Wizards:

e (Creating a Form Resource
e (Creating a DataBase Mode Project

e Creating a Line Mode Project
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VI Project Wizard Windows

Whenever you create a new VI Project using the VI Design Pro Wizard facility the VI Design Pro Wizard produces a
series of windows containing this information:

e New VI Project field descriptions
e Optional Project Attributes Field Descriptions

The titles of the screens vary according to the mode in which the job is being created. For example, the title of the
first screen will be one of these:

e VI Design Pro Form Resource Wizard
e VI Design Pro DataBase Mode Wizard
e VI Design Pro Line Mode Wizard

The screen title is the only variation between the s eries of windows. The windows and corresponding fields are
described in the order they are produced.

NEW VI PROJECT FIELD DESCRIPTIONS
Entries in these fields will be used to define folder and project information for the new VI Project.

Folder Name

Enter the name of the folder in which to store the project. Use up to 32 characters for the folder name.

Project Name

Enter the name to assign to the project. This name will be used both as the directory name for the Project and
as the name of the project file. The .vpf extension will be added automatically by VI Design Pro as the extension
for the project file. Use up to 32 characters for the project name.

When specifying a folder or project name, constrain the name to 32 characters or less, and do not use a space
or any of these characters:

[\ <> 1O 1) " ~1@#$ % ~&+=,;

f Note: Only one project file can be associated with a project directory. The Wizard displays a message box if

‘ an existing project name is specified in the Project Name field when you select Next. You will be asked to
overwrite the existing project that is, delete the old project and replace it with a new project. If you respond
Yes, a message box will appear asking you to confirm the action.

Setting Default Directories for the Project Wizard

To specify the default Folder and Project directory names that appear in the Project Wizard dialog when creating a
VI Project, edit these entries in the vide.ini configuration file:

VPC Default Folder DirName=projects
VPC Default Project Di rName=myproject

These INI entries must follow the same restrictions placed by the operating system when naming directories, and
the same limita tions currently set by the VI Projects specifications, for examples,no blank spaces, max 32
characters, and so on.
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OPTIONAL PROJECT ATTRIBUTES FIELD DESCRIPTIONS

Entries in these fields will be used as part of the Project tree displayed on the Project tab in the Resource Notebook
section of VI Design Pro’s window once the project is created and loaded.

Author

Enter information about the author. Entries in this panel are limited to 512 characters.

Title

Enter the title of the project. Entries in this panel are limited to 512 characters.

Version

Enter the version information. Entries in this panel are limited to 512 characters.

Description

Enter a project description. Entries in this panel are limited to 512 characters.

Keywords

Optional keywords are used when searching, archiving, or indexing the project. Keywords must be separated by
commas. Limit the entries to 512 characters or less.

Copyright

Use the boilerplate copyright information provided the Copyright field or add additional information. Limit the
entries to 512 characters or less.

Use a Copyright File Template

Enable Use a Copyright File Template to import a file that contains boilerplate copyright information into the
project attributes. This enables Browse, which allows you to select the file to import. The file size limitation is
512 bytes. Format checks are not performed for the file that is imported.
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Create a VI Project from an Existing VIPP® Application

To create and load a new VI Project File from an existing VIPP® application open the existing VIPP® application
using File > Open. Select the Create VI Project from currently loaded application button, or the File > Create
Project option.

Refer to VI Project wizard windows for information on the first four screens produced when this option is selected.

RESOURCE PROPERTIES ENTRIES

Entries in these fields will define the resource properties for the project.
Name

Use this window to review the names of the resources that will be associated with the project, and to determine
the scope of each resource. The scope of the resource defines its use as a Local, Folder- shared, or Global-shared
resource. For more information about scope refer to VI Projects in the FreeFlow VI Compose User Guide.

Description

Entries in the Description panel are limited to 512 characters.
Once you are finished with the window, select Finish. VI Design Pro will then create the new project directory,
copy in the appropriate files, and load the newly created project into VI Design Pro's window.
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Creating a Form Resource

When you enable the Create a Form Resource button on the VI Design Pro Wizard Job Selection window, a series of
V1 Design Pro Form Resource Wizard windows are dis played. Refer to Form Resource Wizard field descriptions for
descriptions of the Form Resource windows.

FORM RESOURCE WIZARD FIELD DESCRIPTIONS
Entries in these fields define the form resources for a VI Project.

Select/Create Folder and Project

Use this box to indicate whether to place the new form resource in a particular Folder and Project or in the
standard template directory \xgfc\formlib\.

When you enable Select/Create Folder and Project the wizard allows you to define the new VI Project using the
four wizard windows described in VI Project wizard windows. Refer to that section for information about the
fields found on those screens.

If you do not enable Select/Create Folder and Project you will be required to complete destination information.

Destination

Select a destination from the drop-down list of available folders.

Graphical Units

Use this box to select the unit of measure for the form file; for example, DOT3 (1/300 inch). The value you
select here will be used as the parameter for a SETUNIT command which will be inserted in the form file.

Orientation

Use this box to select the default page orientation to use for the form file. Options are as follows:

PORT (portrait) Display the form in portrait mode.

LAND (landscape) Display the form in landscape mode.

IPORT (inverse portrait) Display the form in inverse portrait mode.
ILAND (inverse landscape) Display the form in inverse landscape mode.

The value you select here will be used to insert a PORT, LAND, ILAND, or IPORT command in the form file.

Sample Font

This box provides a sample of the font selections. Refer to Font and Effects Preview/Select/Sample in the VI
Design Pro GUI chapter of this document for information on changing the sample font viewed here.

Font Name

Select the name of the font to use.

Font Size

Select the size of the font to use. If the font size is not listed, manually enter the desired value. Integer and real
numbers are allowed.
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Font Color

Select the name of the text Colorkey to use.

Line Spacing
Enter the amount of space between each line of type. This is also known as the leading. Integer and real
numbers are allowed.
The values you select or enter in these fields will be used as parameters for the SETFONT, SETTXC, and SETLSP
commands which will be inserted in the form file.

Form Resource Filename
Enter the name of the form with the appropriate extension. When specifying a form name, constrain the name
to 32 characters or less, and do not use a space or any of these characters:
2\ <> 1O 1) " ~1@#$ % ~&+=,;

Selected Settings

Use this window to review the values you specified for the form.

To leave values unchanged, select Finish. VI Design Pro will create the form in the specified Destination directory
and then display VI Design Pro's window with the associated information. Use VI Design Pro's window to add
information and to make changes to the form.

To change one or more values, use Back to return to a previous window.
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Creating a DataBase Mode Project

When you enable the Create a DataBase Mode Project button on the VI Design Pro Wizard Job Selection window
the wizard allows you to define the new VI Project using the four windows described in VI Project wizard windows.
Refer to that section for information about the fields found on those screens.

When you complete the common windows the wizard will produce a series of DataBase Mode Wizard windows. The
field descriptions in DataBase Mode Wizard initial field descriptions are common to all Database mode projects.

DATABASE MODE WIZARD INITIAL FIELD DESCRIPTIONS

When you begin any DataBase mode project, the fields described below are produced by the DataBase Mode
Wizard. The information you supply here will be used for all DataBase Mode projects.

At the end of this wizard you will be presented with these options:
e Generate a sample data file

e Acquire sample data from a file

e Acquire sample data from a database

Each one of these selections produces a unique wizard that will help you complete the project, and are described in
detail in their respective sections.

The fields common to each DataBase Mode project are:

Graphical Units

Use this box to select the unit of measure; for example, DOT3 (1/300 inch). The value you select here will be
used as the parameter for a SETUNIT command which will be inserted in the file.

Orientation

Select the default page orientation for the master file:

PORT (portrait) Display the project output in portrait mode.

LAND (landscape) Display the project output in landscape mode.

IPORT (inverse portrait) Display the project output in inverse portrait mode.
ILAND (inverse landscape) Display the project output in inverse landscape mode.

The value you select here will be used to insert a PORT, LAND, ILAND, or IPORT command in the file.

Duplex Mode
Select the default duplex print mode for the master file:
None output the application in simplex mode.
Regular Duplex output the application in regular duplex mode.
Tumble Duplex output the application in tumble duplex mode. This option rotates
the even page (back page) images.
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Media Size

Select the paper size on which to print the job (for example, A4). When you select Custom another window will
appear on which paper width and height can be entered using the previously selected graphical units of
measure. The valid range for custom page width and height depends on the previously entered graphical units.

Media Color

Select the paper color to use (for example, goldenrod). If the paper color is not on the list, enter the appropriate
information in this field.

Media Type

Select the type of paper stock to use (for example, Drilled). If the type is not on the list, enter the appropriate
information in this field.

Media Weight

Specify the weight of the paper stock to use. For example, enter a value of 60 to indicate 60 Ib. stock. The valid
range for this value is 1 to 500.

Sample Font

This box provides a sample of the font selections. Refer to Font and Effects Preview/Select/Sample in the VI
Design Pro GUI chapter of this document for information on changing the sample font viewed here.

Font Name

Select the name of the font to use.

Font Size

Select the size of the font to use. If the font size is not listed, manually enter the desired value. Integer and real
numbers are allowed.

Font Color

Select the name of the text Colorkey to use.

Line Spacing

Enter the amount of space between each line of type. This is also known as the leading. Integer and real
numbers are allowed.

The values you select or enter here will be used as parameters for the SETFONT, SETTXC, and SETLSP
commands, which will be inserted in the file.

Form Resource

Select Browse to browse the directories and locate the form file to be used. Once you specify a file, the Preview
button will become accessible if it is available for this form.

Preview

Displays the Form Resource Preview window. The Landscape button on this window toggles alternately with a
Portrait button so the form can be viewed in either mode.

Data Base Master Filename

Specify the master file name to use. The name should have an extension of .dbm.
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Selected Settings

Provides a list of settings you have selected up to this point. To change any of the entries, use Back to return to
a previous window.

SAMPLE DATA FILE
When the Sample Data File wizard opens select the method to use to create a sample data file for the project.
Choose from these options:
Generate Sample Data File

Allows you to create a sample data file that can be used during the design phase of the project.

Refer to Generate a sample data file for the series of windows that will appear next when you select this option.
Acquire Sample Data From a File

Allows you to select an existing data file to use in the design phase of the project.

Refer to Acquire sample data from a file for the series of windows that will appear next when you select this
option.
Acquire Sample Data From a Database

Allows you to create a sample file from data extracted from a database. The database must be set up as an
Open Database connectivity (ODBC) data source. For information about ODBC refer to the documentation
about the database system software, or the Windows ODBC Data Source Administrator.

Refer to Acquire sample data from a database for the series of windows that will appear next when you select
this option.
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Generate a Sample Data File

When the Generate Sample Data File option is selected a series of Sample Data File Parameters windows appear.
Enter the values for each of these fields:
Number of Sample Data Records

Use to indicate the number of data records (lines) in the data file. Specify a value from 1 to 500.

Number of Sample Data Fields
Use to indicate the number of data fields for the DataBase Mode data file. The valid range is from 1 to 1200.

Data Field Delimiter

Use to enter the default single-character field delimiter character for the DataBase Mode data file. This is the
character that is used to separate fields in the data file; for example a colon (:) or a dash (-). You must enter a
value in this field. However, forward slash (/), backslash (\), or a blank space cannot be entered. A two-digit
character hex value in the range 21...FF or the tab hex value of 09 can be entered in this field.

This information is used to generate the SETDBSEP command that is located at the beginning of the data file.

j’ Note: Do not place the cursor in this field and press Tab to specify a tab character, the tab hex value must
be entered as a two-digit number 09 rather than 9. If you enter a character hex value that is not in the
range 21 ..FF, an error occurs.

Use Record Number

Allows the data file to contain each data record number.

Use Data Field Number

Allows the data file to contain each data field number.

Use Custom Data Pattern

Specifies a custom data pattern.

Field Names
Contains the default field names for the fields that will be included in the first record of the data file.

New Field Name

Use to change or rename the selected Field Name.

Sample Data Filename

Specify the name to use for the sample data file. The name should have an extension of .dbf.

Selected Settings

Use this window to review the values you specified.

To leave values unchanged select Finish. VI Design Pro will create the DataBase Mode master file and the
sample data file in the locations that you specified and then display VI Design Pro’s window with the associated
information. Use VI Design Pro's window to add information and to make changes to the files.

To change one or more values use Back to return to a previous window.
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Acquire Sample Data from a File

When the Acquire Sample Data from a File option is selected a series of windows appear on which information
about the source data file can be specified.

Sample data file field selections are described here:

Sample Data Source File

You must use Browse to locate the file to use.

Data Field Delimiter

Use this field to indicate the default single-character field delimiter character for the DataBase Mode data file.
This is the character that is used to separate fields in the data file; for example a colon (:) or a dash (-). You must
enter a value in this field. However, a forward slash (/), backslash (\), or a blank space cannot be entered.

A two-digit character hex value in the range 21 ...FF or the tab hex value of 09 can be entered in this field. In
cases where a one field per record data file will be generated, or is loaded, valid entries also include the special
hex values for carriage return (OD), line feed (0OA), and NULL (00), which allows each line of data to be taken as
a single field. However, if more than one field per record has already been declared in the data file, the special
hex-value field delimiters are not valid and may result in a VIPP® or PostScript error if used.

This information is used to generate the SETDBSEP command that is located at the beginning of the data file.

j’ Note: Do not place the cursor in this field and press Tab to specify a tab character, enter the tab hex value as
a two-digit number 09 rather than 9. If you enter a character hex value that is not in the range 21..FF, an
error occurs.

Use the second window to indicate whether the first row of the data file contains the necessary field information:

Yes, First Row contains all Field Names

Causes the wizard to proceed to the Generate a Data Submission File window.

No, First Row does NOT contain Field Names

Displays the Field Names window for the sample file.

The third window contains the default field names for the fields that will be included in the first record of the data
file:

New Field Name

Use to change a default field name.

Create a Data Submission File

Enable this box to create a data submission file that references the sample data source file.

Strip Leading and Trailing Blanks

Use to strip the leading and trailing blanks in the delimited fields. Strip Leading and Trailing Quotes.
Use to strip the first and last quotes from the delimited fields.

Sample Data Filename

Specify the name to use for the sample data file. The name should have an extension of .dbf.

Selected Settings

Use this window to review the values you have specified.
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To leave values unchanged select Finish. VI Design Pro will create the DataBase Mode master file and the
sample data file in the locations that you specified and then display VI Design Pro's window with the associated
information. Use VI Design Pro’s window to add information and to make changes to the files.

To change one or more values use Back to return to a previous window.
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Acquire Sample Data from a Database

V1 Design Pro allows you to create a sample file from data extracted from a database. The database must be
connected to at least one Open Database Connectivity (ODBC) data source.

e ODBC is a software layer that allows access to many different types of database management systems
(DBMSs) such as Oracle, MS Access, and SQL Server. In order for ODBC to be used with a particular DBMS, there
must be an ODBC driver installed on the system for that DBMS. Drivers exist for most commonly used relational
DBMSs as well as non-relational DBMSs such as Excel and plain files.

e An ODBC data source represents a particular connection to an ODBC driver and a DBMS. If the database does
not have any data sources that connect to it, use the Windows ODBC Data Source Administrator to set a data
source up.

e When the Acquire Sample Data from a Database option is selected a series of windows app ear on which a
data source, and data from that source for output to a sample file, can be selected.

ODBC Data Source field selections are described here:
Select the data source from which to extract data.

The list of data sources contains the following information for each source.

Name The name of the data source.

Type Either System, User, or File.
System data sources are available to anyone who logs into the system.
User data sources are available only to the user who created them.

Data source information for a File data source is stored in a file. The data source list on this
window includes file data sources whose files are in a standard Windows folder.

DBMS The database management system for the data source.
Description Descriptive text appears when available.
Browse

Use this button to locate a file data source that is not in the standard Windows folder.

Data Source Admin

Use this button to invoke the Windows ODBC Data Source Administrator, which allows you to add, modify, or
delete data sources.
If the data source requires a log on, the Enter User Name and Password screen will display.

User Name

Enter the user name. This field may not be required for all databases. Check with the database administrator if
you are not sure.

Password

Enter the password. This field may not be required for all databases. Check with the database administrator if
you are not sure.
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Tables

Select one table in the selected data source from which to extract data.
The table can be one of these four types:

e Table
e View
e Alias
e Synonym

A View is a virtual table that is the result set of a stored query, and can be accessed as though it were a real
table. An Alias or Synonym is simply another name for a table.

To select data from more than one table, create a view that combines data from multiple tables. Extract data
from that view by selecting it in the table list. Creating a view is outside the scope of VI Design Pro; one way to
do this is to use the CREATE VIEW command in Structured Query Language (SQL).

View Table

Use this button to display a grid containing the data in the selected table. This grid can also be displayed by
double-clicking the table in the list.

The Select Output Columns window allows you to choose the columns (fields) in the selected table that will
appear in the sample file.

Table Columns

A list of all columns in the selected table.

Output Columns

A list of the fields that will appear in the sample file.

To put columns into the Output Columns list, select one or more columns in the Table Columns list and press >.
The columns will be added below any currently selected item in the output list. Alternatively, double-click an
item in the Table Columns list to add it to the Output Columns list.

To put all items in the Table Columns list into the Output Columns list click >>.

To remove a column from the Output Columns list or double-click the column name, or select it and press <.
To remove all items in the Output Columns list click <<.

Use the up or down arrows to move a selected item up or down in the Output Column list. This controls the
order in which the columns are output to the sample file.

View Table
Use this button to produce a menu containing the following options:
View All Columns displays a grid containing the entire table.
View Selected Columns displays a grid containing only the columns in the Output Columns
list.

Include Column Names in Output

This box is checked by default. Deselect this box if you do not want the column names written to the output file
as the first row of data.

f Note: To change names of columns included in the output edit the sample file or the sample data source
file, within VI Design Pro, after leaving the Wizard.
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The Specify Row Selection Criteria window allows you to determine which rows of the selected table will be
output to the sample file.

Limit the rows selected for the sample file in one or both of these ways:
e Enter one or more selection criteria
e Specify the maximum number of rows to select

Row Selection Criteria

Each criterion is made up of four fields ordered from left to right:

Not

Check this box to negate the meaning of the criterion. See examples below.

Column Selector

Select the column to compare. The drop-down box contains a list of all columns in the selected table, not just
the columns selected for output.

j’ Note: To clear all fields in a criterion, select Clear from the Column Selector field.

Operator Selector

Use one of the operators listed here for the comparison:

OPERATOR COLUMN DATATYPE MEANING
= number is equal to
date/time is the same date/time as
text is the same as
< number is less than
date/time is earlier than
text precedes alphabetically
<= number is less than or equal to
date/time is earlier than or the same date/
time as
text precedes alphabetically or is the
same as
> number is greater than
date/time is later than
text follows alphabetically
>= number is greater than or equal to
date/time is later than or the same date/
time as
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OPERATOR COLUMN DATA TYPE MEANING
follows alphabetically or is the
same as
begins with number the text representation begins
with (does not apply to
floating point numbers)
date/time N/A
text begins with
contains number the text representation
contains (does not apply to
floating point numbers)
date/time N/A
text begins with
ends with number the text representation
contains (does not apply to
floating point numbers)
date/time N/A
text ends with
is null any column that can have NULL has a NULL value in the
values database

fe Note: When a column has some rows with NULL values, those rows will only be selected when the is null
operator is selected.

Value Entry

Enter a value to compare the column against. When is null is the selected operator the Value Entry field is
grayed out and cannot be used. When the selected column contains non-text data, guide text will appear above
this data entry field. The guide text specifies the category of the value to be entered:

e number
e date
e time

e date and (optional) time

e Qor1

All non-text values must follow one of several formats. To see a description of the allowable formats for a non-
text column, select the column in the Column Selector, then move the cursor to the Value Entry (last) field.
Allowable formats will be displayed as a tool tip.

Allowable formats are determined by the Regional Settings for the operating system. Refer to the operating
system documentation for help changing the regional settings on the computer. The various elements
determined by the regional settings are:
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decimal point character
thousands separator

currency symbol

currency decimal point character
date order

date separator

time separator

12- or 24-hour format

AM and PM designators

And/Or

When specifying multiple rows of criteria select one of these buttons between adjacent criteria.

SELECTION MEANING

Creating or Modifying Applications

All And All criteria must be met for a row to be selected

All Or” At least one criterion must be met for a row to be selected

Combination Adjacent criteria connected by and are grouped together, the resulting groups are
connected by or

This table provides examples of selection criteria:

NOT COLUMN OPERATOR

To select all rows for which
Birthdate is later than 1/
15/1961, enter:

VALUE

Birthdate >

1/15/1961

To select all rows for which
MailingListID is not 5,
enter:

X MailingListID =

To select all rows for which
DuesAmount is less than or
equal to $10.00, enter:

DuesAmount <=

$103

To select all rows for which
Photograph is not null,
enter:

X Photograph is null

3.

The currency symbol is always optional
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(N[0} COLUMN OPERATOR VALUE
To select all rows for which
Notes contains the text
"diagram”, enter:
Notes contains diagram
To select all rows for which
MailingListID is either 6 or
8, enter:
MailingListID = 6
Or
MailingListID = 8
To select all rows for which
Birthdate is in the year
1953, enter:
Birthdate >= 1/1/1953
And
Birthdate < 1/1/1954
To select all rows for which
MailingListID is 42, or
Birthdate falls between
1974 and 1978, enter:
MailingLIstID = 42
Or
Birthdate >= 1/1/1974
And
Birthdate < 1/1/1979

Maximum Number of Rows to Select

Enter a value in this field to specify a maximum number of rows to select. When row selection criteria is not
specified, the output will consist of the number of rows specified here, beginning at the top of the table.

Set Default

The system default for the maximum number of rows to select is 10. To change the default, enter a value in the
maximum number field then click this button.

Date-Time Columns

The Date-Time Columns list shows columns that contain both date and time information in the database. Use
the boxes to select whether to output the date, time, or both. When the window is first displayed the Show Date
box will be checked. Show Time will be checked for a column if there is at least one row in the database with a
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non-zero time in that column.

Numeric Columns

The Numeric Columns list shows columns that are stored as numbers in the database. If you check Currency? for
a column, values for that column are output to the sample file with a currency symbol and using the currency
format settings; refer to Output Data Formatting. The Digits After Decimal field allows you to override standard
settings for currency and non-currency numbers.

When the window is first displayed, Currency? is set according to a flag in the database, which may not be
available for all databases. If Currency? is checked the Digits After Decimal value is set to the standard setting
for currency, otherwise the standard setting for non-currency is used.

View Formatted Output Data

Click this button to display a grid with the output data formatted according to the output format settings and
the per-column settings set on this window.

VI Designer Wizard FE

VI Designer DataBase Mode Wizard

Sample Data File Parameters

Data Field Delimiter:

-

v Strip Leading and Trailing Blanks

Select this option ta stip leading and trailing blank =
from e:ach data field.

< Back MNewxt > Cancel

Data Field Delimiter

Use this field to enter the delimiter character that will separate field values in the output file. You must enter a
value in this field. A forward slash (/), backslash (\), or a blank space cannot be entered. The character may also
be entered as a two-digit hexadecimal value in the range 21 ... FF, or 09 for a tab character.

If you enter a character that occurs in one or more of the data fields, the field values will be enclosed in double
quotes in the output file. VI Design Pro will notify you if this is required.

In addition to separating the data fields, the delimiter character also appears in the SETDBSEP command near
the beginning of the sample file.

f Note: To specify a tab character, you must enter the hexadecimal value 09 (not 9) rather than pressing Tab.

Strip Leading and Trailing Blanks
Deselect this box to put a BSTRIP_off line in the sample file. The BSTRIP_off command tells VIPP® not to strip
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leading and trailing blanks from field values. The field values written to the sample file are not affected.

Create a Data Submission File

Check this box to create a data submission file that references the sample data source file. If this box is checked
a window containing two fields (Sample Data Filename and Sample Data Source File) will follow. If the box is
not checked a screen containing only the Sample Data Filename window will follow.

Sample Data Filename

Specify the name to use for the sample data file (if Create a Data Submission File was checked on the previous
window the sample file will be created as a data submission file referencing the source file specified in the field
below). The name should have an extension of .dbf.

Sample Data Source File

Specify the name to use for the source data file that will contain the data selected from the database. This field
will not appear if you have not opted to create a data submission file.

Selected Settings

Use this window to review the values you have specified.

View Output Data

Use this button to view the selected data that will be output to the Sample File in the format in which it will be
written.

To leave values unchanged select Finish. VI Design Pro will create the DataBase Mode master file and the
sample data file in the locations that you specified and then display VI Design Pro’s window with the associated
information. If you opted to create a data submission file a data source file is also created. Use VI Design Pro's
window to add information and to make changes to the files.

To change one or more values use Back to return to a previous window.
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Output Data Formatting

The following tables show variables that can be set in the vide.ini file to control how the data being extracted from
a database is formatted when it is output to the sample file. Except for the Boolean settings, all of these default to
the Windows regional settings of the system running VI Design Pro.

Set one or more of the following variables to override the regional settings.

These settings affect all columns of output data. There are additional settings that can be set on a per- column
basis, for information refer to Date-Time Columns or Numeric Columns.

DATE SETTINGS ‘ DESCRIPTION

Wizard.ODBC.Date.Separator Separator character between month, day, and year

Wizard.ODBC.Date.Format 0- for month-day-year
1- for day-month-year

2- for year-month-day

Wizard.ODBC.Date.FourDigitYear 1- for 4-digit year

0- for 2-digit year

Wizard.ODBC.Date.DaylLeadingZero 1- for leading zero for the day

0- for no leading zero for the day

Wizard.ODBC.Date.MonthLeadingZero | 1- for leading zero for the month

0- for no leading zero for the month

TIME SETTINGS DESCRIPTION
Wizard.ODBC.Time.Separator Separator character between hours, minutes, and seconds
Wizard.ODBC.Time.Format24 1- for 24-hour format

0- for 12-hour AM/PM format

Wizard.ODBC.Time.Am String to use for the AM indicator
Wizard.ODBC.Time.Pm String to use for the PM indicator
Wizard. ODBC.Time.ShowSeconds 1- to include seconds in the time

0- to show hours and minutes only

Wizard.ODBC.Time.HourLeadingZero 1- for leading zero for the hours O- for no leading zero for the hours

Wizard. ODBC.Number.DecimalChar The decimal character
Wizard. ODBC.Number.DigitsAfterDecimal The number of digits to display after the decimal character
Wizard.ODBC.Number.GroupingChar The grouping character (thousands separator)
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NUMBER SETTINGS DESCRIPTION

Wizard.ODBC.Number.GroupingFormat

0- for 123456789
1-for 123,456,789
2-for 12,34,56,789

Wizard.ODBC.Number.NegativeParens

1- to use parentheses to indicate a negative number, e.g. (1.1)

0- to use the negative sign to indicate negative numbers

Wizard.ODBC.Number.NegativeSign

The character to use for the negative sign (also used for
currency values)

Wizard.ODBC.Number.NegativePrecedesVal

1- if the negative sign precedes the number

0- if the negative sign follows the number

Wizard.ODBC.Number.NegativeSpace

1- if there is a space between the negative sign and the number

0- if there is no space

Wizard.ODBC.Number.LeadingZero

1- to display a leading zero before decimal values with an
absolute value less than 1.0, e.g. 0.7

0- to not display a leading zero, e.g. .7

Wizard.ODBC.Currency.Symbol

CURRENCY SETTINGS ‘ DESCRIPTION

The currency symbol

Wizard.ODBC.Currency.SymbolPrecedesPosVal

1- if the currency symbol precedes positive values

0- if the currency symbol follows positive values

Wizard.ODBC.Currency.SymbolPrecedesNegVal

1- if the currency symbol precedes negative values

0- if the currency symbol follows negative values

Wizard.ODBC.Currency.SymbolSpacePosVal

1- if there is a space between the currency symbol and
positive values

0- if there is no space

Wizard.ODBC.Currency.SymbolSpaceNegVal

1- if there is a space between the currency symbol and
negative values

0O- if there is no space

Wizard.ODBC.Currency.DecimalChar

The decimal character for currency values

Wizard.ODBC.Currency.DigitsAfterDecimal

The number of digits to display after the decimal character

Wizard.ODBC.Currency.GroupingChar

The grouping character (thousands separator)

Wizard.ODBC.Currency.GroupingFormat

0- for 123456789
1- for 123,456,789
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CURRENCY SETTINGS DESCRIPTION

2-for 12,34,56,789

Wizard.ODBC.Currency.NegativeParens

1- to use parentheses to indicate a negative currency values,
eg. (1.1)

0- to use the negative sign to indicate negative currency
values

Wizard.ODBC.Currency.NegativePrecedesVal

1- if the negative sign precedes the value

0- if the negative sign follows the value

Wizard.ODBC.Currency.NegativePrecedesSymbol

1- if the negative sign precedes the currency symbol

0- if the negative sign follows the currency symbol

Wizard.ODBC.Boolean.TrueString

BOOLEAN SETTINGS DESCRIPTION

The string to display for true values (defaults to 1)

Wizard.ODBC.Boolean.FalseString

The string to display for false values (defaults to 0)
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Creating a Line Mode Project

When you enable the Create a Line Mode Project button on the VI Design Pro Wizard Job Selection window, the
wizard allows definition of the new VI Project using the four windows described in VI Project wizard windows. Refer
to that section for information about the fields found on those screens.

When you complete the common windows the wizard will produce a series of Line Mode Wizard windows
containing these fields:

Graphical Units

Use this box to select the unit of measure; for example, DOT3 (1/300 inch). The value you select here will be
used as the parameter for a SETUNIT command which will be inserted in the file.

Orientation

Select the default page orientation for the master file:

PORT (portrait) Display the project output in portrait mode.

LAND (landscape) Display the project output in landscape mode.

IPORT (inverse portrait) Display the project output in inverse portrait mode.
ILAND (inverse landscape) Display the project output in inverse landscape mode.

The value you select here will be used to insert a PORT, LAND, ILAND, or IPORT command in the form file.

Duplex Mode
Select the default duplex print mode for the master file:
None output the application in simplex mode.
Regular Duplex output the application in regular duplex mode.
Tumble Duplex output the application in tumble duplex mode. This option rotates the
even page (back page) images.

Media Size

Select the paper size on which to print the job (for example, A4). If you select Custom another window will
appear on which paper width and height can be entered. The valid range for custom page width and height
depends on the previously entered graphical units.

Media Color

Select the paper color to use (for example, goldenrod). If the paper color is not on the list, enter the appropriate
information in this field.

Media Type

Select the type of paper stock to use (for example, Drilled). If the type is not on the list, enter the appropriate
information in this field.

Media Weight

Specify the weight of the paper stock to use. For example, enter a value of 60 to indicate 60 Ib. stock. The valid
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range is 1 to 500.

Sample Font

This box provides a sample of the font selections. Refer to Font and Effects Preview/Select/Sample in the VI
Design Pro GUI chapter of this document for information on changing the sample font viewed here.

Font Name

Select the name of the font to use.

Font Size

Select the size of the font to use. If the font size is not listed, manually enter the desired value. Integer and real
numbers are allowed.

Font Color

Select the name of the text Colorkey to use.

Line Spacing

Enter the amount of space between each line of type. This is also known as the leading. Integer and real
numbers are allowed.

The values you select or enter here will be used as parameters for the SETFONT, SETTXC, and SETLSP commands
which will be inserted in the file.

Form Resource

Select Browse to browse the directories and locate the form file to be used. Once you specify a file, the Preview
button will become accessible if it is available for this form.

Preview

Displays the Form Resource Preview window. The Landscape button on this window toggles alternately with a
Portrait button so the form can be viewed in either mode.

Use Record Processing Entry (RPE)
Enables use of a Record Processing Entry (RPE) library definition in the Job Descriptor Ticket (JDT) file.

Char/Lines and Lines/Page

Allows you to specify the default values for character per line and line per page information for the JDT. When
you check this box, the Characters per Line and Lines per Page boxes are enabled.

Characters per Line

Specify the default value for the maximum number of characters per line. Valid values are 1 to 255.

Lines per Page

Specify the default for the maximum number of lines per page. Valid values are 1 to 255.

Job Descriptor Ticket Filename

Specify the name to use. The name should have an extension of jdt.

Selected Settings

Provides a list of settings you have selected up to this point. To change any of the other entries, use Back to
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return to a previous window.

Generate Sample Data file
Allows creation of a sample data file to be used during the design phase of the project.
Refer to Generating a sample data file for the series of windows that will appear next when you select this
option.

Acquire Sample Data From a File

Allows selection of an existing file to use during the design phase of the project.
Refer to Acquiring sample data from a file for the series of windows that will appear next when you select this
option.

GENERATING A SAMPLE DATA FILE

When the Generate Sample Data File option is selected a series of Sample Data File Parameters windows on which
these fields appear:

Characters per Line

Indicates the default for the maximum number of characters per line to use for the line mode data file. The
valid range is from 1 to 255. This parameter will not be accessible if it was previously delimited for the JDT file.

Lines per Page
Indicates the default for the maximum number of lines per page to use for the line mode data file. The valid
range is from 1 to 255.This parameter will not be accessible if it was previously delimited for the JDT file.
Number of Pages

Indicates the default number of pages to use for the line mode data file. The valid range is from 1 to 100.

Use Line Number

Allows line numbers in the data pattern.

Use Page Number

Allows page numbers in the data pattern.

Use Custom Data Pattern

Allows you to specify a custom data pattern

Sample Data Filename

Specify the name to use for the sample data file. The name should have an extension of .Im.

Selected Settings

Use this window to review the settings you have selected. To leave values unchanged select Finish. VI Design Pro
creates the JDT master file and the sample data file in the specified locations, then displays VI Design Pro's
window with the associated information. Next, use VI Design Pro’s window to add information and to make
changes to the files.

To change one or more values use Back to return to a previous window.
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ACQUIRING SAMPLE DATA FROM A FILE

When the Acquire Sample Data from a File option is selected a series of windows appear on which to specify source
data file information in these fields:

Sample Data Source File
The Browse button must be used to locate the file.
Create a Data Submission File

Enables creation of a data submission file that references the sample data source file.

Sample Data Filename

Specify the name to use for the sample data file. The name should have an extension of .Im.
Selected Settings
Use this screen to review the settings for this Line Mode resource.

To leave values unchanged select Finish. VI Design Pro will create the DataBase Mode master file and the
sample data file in the locations that you specified and then display VI Design Pro's window with the associated
information. Use VI Design Pro’s window to add information and to make changes to the files.

To change one or more values use Back to return to a previous window.
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Using Wizard Classic

To access the Wizard Classic facility, use File > New or the New VIPP® application button on the tool bar. This will
display the Welcome to the VI Design Pro Wizard window, from which to make these selections:

Wizard Classic

Select the Wizard Classic button to display the New VIPP Application window.

New VIPP Application X

Form DataBase Line
Resource Mode Job Mode Job

Wizard OK Help Cancel

On the New VIPP® Application window, select the type of Wizard Classic to use in either of these ways:
e By double-clicking with the left mouse button on an icon

e By clicking with the left mouse button once on one of the icons and then selecting OK.

Refer to the following sections for more information about using an individual Wizard Classic:

e Using Wizard Classic

e Using Wizard Classic to Create Database Mode Jobs

e Using Wizard Classic to Create Line Mode Applications

Always Use Wizard Classic

Enable Always Use Wizard Classic to invoke Wizard Classic when you select either File > New or the New VIPP®
application button on the tool bar. If you later want to access the Welcome to the VI Design Pro Wizard window,
select Wizard on the New VIPP® Application window.

USING WIZARD CLASSIC TO CREATE FORM RESOURCE TEMPLATES

This section describes how to create new VIPP® forms or access existing VIPP® forms for editing using the Form
Resource Wizard Classic. To access and edit an existing form, the form must be coded in VIPP® native mode. Forms
coded in EPS or TIFF format cannot be loaded or edited.

To use the Form Resource Wizard Classic, you must first access the New VIPP® Application window and then double-
click on the Form Resource icon to display the VI Design Pro Form Resource window.

This window allows you to load an existing form, use a form template to create a new form, or create a new form
without using a template. After specifying the information to use, click OK and VI Design Pro’s window displays with
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the associated information. Then use VI Design Pro’s window to add information and to make changes to the form.
The following fields and information display on the VI Design Pro Form Resource window:
Load

Use this button to access an existing form file. When you click this button, the Choose a New FRM Form File to Load
window displays. Use this window to select the form file to access.

After you select a form file and click OK on the Choose a New FRM Form File to Load window, the information for
the form file displays in the box to the right of this field, and the file you selected is the only item available from the
Form File (FRM) box.

Create

Use this button to create a new form file. When you click this button, the default Form file information displays in
the box to the right of this field, and newFormFile.frm displays in the Form File (FRM) box. Use the Form File (FRM)
Options section to specify the options to use for the new Form file. Use the Save Form File As field to specify the file
name to use for the new Form file.

Templates
Use this button when to use a for file template. This is the default mode.

When you select this button, the Form File (FRM) box displays a list of all of the Form file templates that are
currently available. These templates are stored in the VI Design Pro installation directory (generally vide\wizlib
\wizFRM).

When you select a template from this list, the information for the template you select displays in the box. When you
have clicked Load or Create, you must click this button again to return the window to Template mode, and to
enable the template selections from the Form File (FRM) box.

j’ Note: Make sure to specify a new name in the Save Form File As field so that you do not permanently
change the template file.

Form File (FRM)

Use this box together with Load, Create, and Templates to select the appropriate Form file. The information related
to the button you click and the Form file you select displays in the box to the right of this field.

Select/Create Folder and Project

Use this box to create a new project containing the form.

Save Form File As

Enter the name to use for the form file. This file should have an extension of .frm.
Location

Use this box to select the location in which to save the form file. The directories that are available are those that are
defined in the xgf\src\xgfdos.run file by the SETFPATH command. This option is not accessible if creating a project.

Graphical Units

Use this box to select the default unit of measure to use for the form file (for example, DOT3 (1/300 inch)). This
field is available only when you are creating a new form file.

Orientation
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Use this box to select the default page orientation to use for the form file (for example, PORT (portrait)). This field is
available only when you are creating a new form file.

Options are as follows:

PORT (portrait) Display the form in portrait mode.

LAND (landscape) Display the form in landscape mode.

IPORT (inverse portrait) Display the form in inverse portrait mode.
ILAND (inverse landscape) Display the form in inverse landscape mode.

USING WIZARD CLASSIC TO CREATE DATABASE MODE JOBS

This section describes how to use the Database Mode Job Wizard Classic to perform the activities described in
these sections:

e Creating a New Database Mode Application

e Creating a New Line Mode Application Using a Template

e Creating a Data Base Master for Use with an Existing Data File
e Creating a Data File for Use with an Existing Data Base Master
e Using the VI Design Pro Database Mode Window

To use the Database Mode Job Wizard Classic, you must first access the New VIPP® Application window and then
double-click on the DataBase Mode Job icon. This displays the VI Design Pro DataBase Mode window, which
contains all of the buttons and fields necessary to access or create database files and DBMs. This window allows
you to load existing database mode files, use a template to create a new data file or DBM, or create a new dat a
file or DBM without using a template. The following sections describe how you perform these tasks.

Creating a New Database Mode Application

Once you access the VI Design Pro DataBase Mode window, use Create to create a new database mode application
without using an existing template. To perform this task, click Create in both the Data File (DBF) and the Master File
(DBM) sections.

When you click this button in the Data File (DBF) section, the basic default information displays in the box to the
right of this field, and newTemplate.dbf displays in the Data File (DBF) box. Use the Data File (DBF) Options section
to specify the options for the new data file.

When you click this button in the Master File (DBM) section, the basic default DBM information displays in the box
to the right of this field, and newTemplate.dbm displays in the Master File (DBM) box. Use the Master File (DBM)
Options section to specify the options for the new DBM.

Use the Save Data File As and the Save Master File As fields to specify the names to use for the new files.

When you click OK on the VI Design Pro DataBase Mode window, the new database file and the DBM file are saved
and the VI Design Pro Project Wizard windows display to create a new project. The windows contain all of the
information for the new database mode application you created. Use VI Design Pro's window to add information
and to make changes to the database mode application.
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Creating a New Database Mode Application Using a Template

In the VI Design Pro DataBase Mode window, use the Templates buttons to select the database mode templates
to use to create a new database file and a corresponding Data Base Master (DBM) file. This is the default mode for
the VI Design Pro Database Mode window.

In general, when you click either of the Templates buttons available on this window, the Data File (DBF) and the
Master File (DBM) boxes provide a list of all of the database mode templates that are currently available. These are
the templates that are stored in the VI Design Pro installation directory (generally vide\wizlib\wizDBM).

The database file template and DBM file template must always be of the same type (for example, barchart.dbf as
the database file and barchart.dbm as the DBM file). Therefore, when you select a template from one of these
boxes, the information for the template you selected displays in that box and the corresponding template displays
in the other box. For example, when you select barchart.dbf from the Data File (DBF) box, barchart.dbm is
automatically selected in the Master File (DBM) box.

When you create a new database mode application using a template, change the options for the data file using the
fields located in the Data File (DBF) Options section of the window. However, the options for the DBM cannot be
changed.

When you create a new database mode application using an existing template, specify a new name in the Save
Data File As and the Save Master File As fields so that you do not permanently change the template files.

When you click OK on the VI Design Pro DataBase Mode window, the new database file and the DBM file are saved
and the VI Design Pro Project Wizard windows display to create a new project. The windows contain all of the
information for the new database mode application you created. Use the VI Design Pro window to add information
and to make changes to the database mode application.

When you have selected Load or Create, you must select one of the Templates buttons available on this window to
return the window to Template mode, and to enable the template selections in the Data File (DBF) and the Master
File (DBM) boxes.

Creating a Data Base Master for Use with an Existing Data File

Once you access the VI Design Pro DataBase Mode window, access the existing data file and then create the new
DBM to use to process the data file. To access the existing data file, click Load in the Data File (DBF) section to
access the Choose a New Data File to load window. Use this window to select the data file to access and click
Open. The Data Fields Information window displays.
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Field Delimiter

Specify the field delimiter for the data file (for example, :) and select the appropriate button to specify whether the
first row of the data file contains the necessary field name information.

e When you select Yes... and click OK, the VI Design Pro DataBase Mode window displays with the name of the
data file you select ed in the Data File (DBF) box and the information for the data file displayed in the
associated box.

e When you select No... and click OK, the Data Record Field Names Definitions window displays.

This window contains the current field values and default field names for the fields that are included in the first
record of the selected data file. To change the default field names, use the mouse or the arrow keys to select a field
value/field name item from the boxes and use Selected Field Name to change the field name information.

When you have made all of the field name changes, or to keep the existing field values, click OK. The VI Design Pro
DataBase Mode window displays with the name of the data file you selected contained in the Data File (DBF) box
and the information for the data file displayed in the associated box.

Once you perform this task, Create is disabled in the Data File (DBF) section, Load is disabled in the Master File
(DBM) section, the Master File (DBM) box defaults to *NONE* with no other selections available, and only changes
to the Duplex Mode, BSTRIP_off, and QSTRIP_on fields can be made in the Data File (DBF) Options section.

Use the fields that are available in the Master File (DBM) section to specify the orientation and select the form for
the DBM. Use the Orientation box to select the orientation to use for the DBM and then click Browse (next to the
Form File field) to access the Select Form Resource File window. Use this window to select the form file to use for the
DBM you are creating. Make sure that the form you select is coded in VIPP® native mode; forms that are encoded
in EPS or TIFF cannot be accessed or edited.

To create the DBM, click Create in the Master File (DBM) section. The basic default DBM information displays in the
box to the right of this field, and newTemplate.dbm displays in the Master File (DBM) box. Use the Master File
(DBM) Options section to specify the options for the new DBM.

Make sure to specify a new name in the Save Master File As field to save the new DBM.

When you click OK on the VI Design Pro DataBase Mode window, the database file and the new DBM file are
saved, and the VI Design Pro Project Wizard windows display to create a new project. VI Design Pro’'s window
contains all of the information for the database mode application. Use VI Design Pro's window to add information

122 Xerox® FreeFlow® VI Design Pro Software User Guide



Creating or Modifying Applications
and to make changes to the application.

Creating a Data File for Use with an Existing Data Base Master

Once the VI Design Pro DataBase Mode window is accessed, create a new database file for use with an existing
DBM file to test the design and output of an application. To access the existing DBM file, click Load in the Master
File (DBM) section to access the Choose a New DBM Master File to load window. Use this window to select the
DBM file to access and click Open.

j’ Note: Make sure that the DBM you select includes the required WIZVAR comments at the beginning of the
file. This is necessary so that the field name and number information is available. When the WIZVAR
comments are not available in the comment section of the DBM file you select, an error occurs.

Once you perform this task, Create is disabled in the Master File (DBM) section, Load is disabled in the Data File
(DBF) section, and the Data File (DBF) box defaults to *NONE * with no other selections available.

To create the data file, click Create in the Data File (DBF) section. The basic default data file information displays in
the box to the right of this field, and newTemplate . dbf displays in the Data File (DBF) box. Use the Data File
(DBF) Options section to specify the options for the new data file.

When you click OK on the VI Design Pro DataBase Mode window, the new database file and the DBM file are saved
and the VI Design Pro window displays. The VI Design Pro window contains all of the information for the database
mode application. Use the VI Design Pro window to add information and to make changes to the application.

Using the VI Design Pro Database Mode Window

This section describes the information that you select, and that displays, when you access the VI Design Pro
DataBase Mode window. You access this window when you select File > New and double-click on the DataBase
Mode Job icon. Use the DataBase Mode window to access an existing DataBase mode data file or Data Base
Master (DBM) file, create a new DataBase mode data file or Data Base Master (DBM) file, or access an existing
DataBase mode data file template and Data Base Master (DBM) file template.

After using the VI Design Pro DataBase Mode window to specify the information to use to access an existing
DataBase mode application, create a new DataBase mode application, or use a DataBase mode template, and click
OK, the VI Design Pro Project Wizard windows display to create a new project.

Use VI Design Pro’s window to manipulate, test, and print the DataBase mode application information and to
prepare it for output to a PostScript printer.
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Data File (DBF)

barchart.dbf
Load
Create

Templates

Master File (DEM)
barchart.dbm

Load
Create

Templates

Save Data File As:

Data Records:

Field Delimiter:
Duplex Mode:
BSTRIP_off:

QSTRIP_on:

Xerox FreeFlow VI Design Pro DataBase Mode

%!

XGF

150 SETBUFSIZE
(:) SETDBSEP

(dbm-templlate) STARTDEM

TITLEFNAMELNAME:ADDRESS:ZIP: CITY:LAB1:VALT:LAB2:VALZ: LAB3:VA

L3:LAB4:VAL4

RecOTitle:RecOFirstNlame:RecOLastName:Rec0Addr:Rec0Zip:RecOCity:Rec
OLab1:XXX:RecOLab2:XXX:RecOLab3;: XXX:RecOLab4: XXX

%%EQF

%!
%% Title: dom-template

%% Creator:Xerox FreeFlow VI Design Pro 18.0.0 DataBase Mede.
%% CreationDate: 08-24-1999,
%% This sample draws a bar chart from database fields.

% WIZVAR:BEGIN

%% WIZVAR TITLE, FNAME, LNAME, ADDRESS, ZIP, CITY
%% WIZVAR LABT, VALT, LAB2, VAL2, LAB3, VAL3, LAB4, VAL4

9% WIZVAR:END
9%%EndComments

| newjob.dbf }

Data File (DBF) Options

Save Master File As: | newjob.dbm ]

Master File (DBM) Options

DOT3 (1/300 inch)
PORT (portrait)

Browse...

About 0K Help Cancel

These fields and information display on the VI Design Pro DataBase Mode window:

Data File (DBF)

Use this box together with the Load, Create, and Templates buttons to select the appropriate DataBase mode data
file. The information related to the button you click and the data file you select displays in the box to the right of
this field. Use this box and the buttons as follows:

Load

Click this button to access an existing DataBase mode data file. When you click this button, the Choose a New
Data File to Load window displays. Use this window to select the DataBase mode data file to access. After you
select the DataBase mode data file and click OK, the data stream information for the DataBase mode data file
displays in the box to the right of this field, and the file you selected is the only item available from the Data File
(DBF) box. This option allows you to import a data file that was created by a third-party application (such as
Access) for use with the application. Use Create and Master File (DBM) to create a DBM for use with the data
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file.

Create

Click this button to create a new DataBase mode data file. When you click this button, the basic default
information displays in the box to the right of this field, and newTemplate.dbf displays in the Data File (DBF)
box. Use the Data File (DBF) Options section to specify the options for the new data file. In addition, use the
Master File (DBM) box and buttons to select or create a DBM for use with the new DataBase mode data file.
Use the Save Data File As field to specify the file name to use for the new DataBase mode data file.

Templates

Click this button to use a DataBase mode data file template. When you click this button, the Data File (DBF) box
contains a list of all of the DataBase mode data file templates that are available. When you select a template
from this list, the information for the template you selected displays in the box and the corresponding Data
Base Master (DBM) file template displays in the Master File (DBM) box. The database file template and DBM
file template must always be of the same type (for example, barchart.dbf as the database file and barchart.dbm
as the DBM file). Make sure to specify a new name in the Save Data File As field so that you do not
permanently change the template file.

The following options are currently available from this box:

barchart.dbf use a barchart file template.
curvechart.dbf use a curvechart file tem plate.
letter.dbf use a letter file template.
payoff.dbf use a payoff file template.
piechart.dbf use a piechart file template.

Master File (DBM)

Use this box together with the Load, Create, and Templates buttons to select the appropriate Data Base Master
(DBM) file. The information related to the button you click and the DBM you select displays in the box to the right
of this field. Use this box and the buttons as follows:

Load

Click this button to access an existing DBM. When you click this button, the Choose a New DBM Master File to
Load window displays. Use this window to select the DBM to access. After you select the DBM and click OK, the
information for the DBM displays in the box to the right of this field, and the DBM you selected is the only item
available from Master File (DBM). Use Create a Data File (DBF) to create a DataBase mode data file for use
with the DBM.

Create

Click this button to create a DBM. When you click this button, the basic default DBM information displays in the
box to the right of this field, and newTemplate.dbm displays in the Master File (DBM) box. Use the Master File
(DBM) Options section to specify the options for the new DBM. In addition, use the Data File (DBF) box and
buttons to select or create a DataBase mode data file for use with the new DBM. Use the Save Master File As
field to specify the file name to use for the new DBM.

Templates

Click this button to use a DBM template. When you click this button, the Master File (DBM) box contains a list of
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all of the DBM templates that are available. When you select a template from this list, the information for the
DBM template you selected displays in the box and the corresponding DataBase mode data file displays in the
Data File (DBF) box. The DBM file template and database file template must always be of the same type (for
example, barchart.dbm as the DBM file and barchart.dbf as the database file). Make sure to specify a new name
in the Save Master File As field so that you do not permanently change the template file.

The following options are currently available from this box:

barchart.dbm use a barchart DBM file template.
curvechart.dbm use a curvechart DBM file template.
letter.dbm use a letter file DBM template.
payoff.dbm use a payoff file DBM template.
piechart.dbm use a piechart file DBM template.

Save Data File As

Enter the name to use for the DataBase mode data file. This file should have an extension of .dbf.

Save Master File As

Enter the name to use for the DBM. This file should have an extension of .dbm.

Data Records

Use this box to specify the number of data records (lines) in the data file. When using a template with increased
values specified, additional records with programmatically generated data are created. Specify a value from 1 to
500. This field is only available when you are creating a new DataBase mode data file.

Data Fields

Displays the number of data fields for the DataBase mode data file. This field is informational only.The
information in this field cannot be changed.

Record Buffer Size

Use this box to specify the default record buffer size for the DataBase mode data file. Specify a buffer size from
150 to 32,000. This field is only available when creating a new DataBase mode data file.

Field Separator

Enter the default single-character field delimiter character for the DataBase mode data file. This is the character
that is used to separate fields in the data file (for example a colon (:) or a dash (-)). You must enter a value in
this field. However, a forward slash (/), backslash (\), or a blank space cannot be entered. A two-digit character
hex value in the range 21 ..FF, or the tab hex value of 09 can be entered in this field.

This information is used to generate the SETDBSEP command that is located at the beginning of the data file.
This field is only available when you are creating a new DataBase mode data file.

j’ Note: Do not place the cursor in this field and press Tab to specify a tab character, enter the tab hex value as
a two-digit number 09 rather than 9. When a character hex value that is not in the range 21 ..FF is entered,
an error occurs.

Duplex Mode

Use the box to select the default duplex print mode to use for the DataBase mode data file. This field is only
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available when you are creating a new DataBase mode data file. Options are as follows:

None

Output the application in simplex mode.

Regular Duplex

Output the application in regular duplex mode.

Tumble Duplex

Output the application in tumble duplex mode. This option rotates the even page (back page) images.

BSTRIP_off

Use the box to specify the default BSTRIP setting for the DataBase mode data file and to strip the leading and
trailing blanks in the delimited fields.

Enable

Turn on this function.

Disable

Turn off this function.
This field is only available when you are creating a new DataBase mode data file.
QSTRIP_on

Use the box to specify the default QSTRIP setting for the DataBase mode data file and to strip the first and last
characters from the delimited fields.

Enable

Turn on this function.

Disable
Turn off this function.
This field is only available when you are creating a new DataBase mode data file.

Graphical Units

Contains the unit of measure in use for the DBM (for example, DOT3 (1/300 inch)). This field is informational
only. The information in this field cannot be changed.

Orientation

Use the box to select the default page orientation for the DBM (for example, PORT (portrait)). This field is only
available when you are creating a new DBM. Options are as follows:

PORT (portrait)
Output the application in portrait mode.

LAND (landscape)

Output the application in landscape mode.
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IPORT (inverse portrait)

Output the application in inverse portrait mode.

ILAND (inverse landscape)

Output the application in inverse landscape mode.

Form File

Click Browse to access the Select Form Resource File window and select the default form to use with the DBM.
This field is only available when you are creating a new DBM.

This option allows you to access VIPP® Native format files created using the Forms Resource Wizard Classic and
valid Encapsulated PostScript (EPS) files created using a third-party application (such as PageMaker) and to
merge these forms with the application.

USING WIZARD CLASSIC TO CREATE LINE MODE APPLICATIONS

This section describes how to use the Line Mode Job Wizard Classic to perform the activities described in these
sections:

e Creating a New Line Mode Application

e (Creating a New Line Mode Application Using a Template

e Creating a Job Descriptor Ticket for Use with an Existing Line Mode Data File
e Creating a Line Mode Data File for Use with an Existing Job Descriptor Ticket
e Using the VI Design Pro Line Mode Window

To use the Line Mode Job Wizard Classic, you must first access the New VIPP® Application window and then double-
click the Line Mode Job icon. This displays the VI Design Pro Line Mode window that contains all of the buttons
and fields necessary to access or create line mode files and JDTs. This window allows you to load existing line mode
files, use a template to create a new line mode data file or JDT, or to create a new line mode data file or JDT
without using a template. The following sections describe how you perform these tasks.

Creating a New Line Mode Application

Once you access the VI Design Pro Line Mode window, use the Create buttons to create a new line mode
application without using an existing template. To perform this task, you click Create in both the Data File (LM) and
the Job Descriptor Ticket (JDT) sections.

When you click this button in the Data File (LM) section, the basic default information displays in the box to the
right of this field, and newTemplate.lm displays in the Data File (LM) box. Use the Data File (LM) Options section to
specify the options for the new data file.

When you click this button in the Job Descriptor Ticket (JDT) section, the basic default JDT information displays in
the box to the right of this field, and newTemplate.jdt displays in the Job Descriptor Ticket (JDT) box. Use the Job
Descriptor Ticket (JDT) Options section to specify the options for the new JDT.

Use the Save Data File As and the Save JDT File As fields to specify the names to use for the new files.
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Creating a New Line Mode Application Using a Template

In the VI Design Pro Line Mode window, use the Templates buttons to select the line mode templates to use to
create a new line mode data file and a corresponding Job Descriptor (JDT) file. This is the default mode for the VI
Design Pro Line Mode window.

In general, when you click either of the Templates buttons available on this window, the Data File (LM) and the Job
Descriptor File (JDT) boxes provide a list of all of the line mode templates that are currently available. These are the
templates that are stored in the VI Design Pro installation directory in vide\wizlib\wizILM.

The line mode data file template and JDT file template must always be of the same type (for example, checks.Im as
the data file and checks.jdt as the JDT file). Therefore, when you select a template from one of these boxes, the
information for the template you selected displays in that box and the corresponding template displays in the other
box. For example, when you select checks.Im from the Data File (LM) box, checks.jdt is automatically selected in the
Job Descriptor Ticket (JDT) box.

When creating a new line mode application using a template, the options for the data file or the JDT cannot be
changed. The fields located in the Data File (LM) Options and the Job Descriptor Ticket (JDT) sections of the
window are disabled.

When you create a new line mode application using an existing template, specify a new name in the Save Data File
As and the Save JDT File As fields, so that you do not permanently change the template files.

When you have selected Load or Create, you must select one of the Templates buttons available on this window to
return the window to Template mode, and to enable the template selections in the Data File (LM) and the Job
Descriptor Ticket (JDT) boxes.

Creating a Job Descriptor Ticket for Use with an Existing Line Mode Data File

Once you access the VI Design Pro Line Mode window, access an existing data file and then create the new JDT to
use to process the data file. Before you access the data file, you must determine whether you intend to use RPEs.
When you do not intend to use RPEs, make sure that there is no check in the Use RPE box in the Job Descriptor
Ticket (JDT) Options section of the window. When you do intend to use RPEs, check Use RPE.

To access the existing data file to use, click Load in the Data File (LM) section to access the Choose a New Data
File to load window. Use this window to select the data file to access and click Open. When the file is loading, VI
Design Pro locates the longest record and any Form Feed characters and uses this information to enter the SETGRID
parameters in the Characters per Line and Line per Page fields in the Job Descriptor Ticket (JDT) Options section of
the window.

Once you perform this task, Create is disabled in the Data File (LM) section, Load is disabled in the Job Descriptor
Ticket (JDT) section, and the Job Descriptor Ticket (JDT) box defaults to NONE with no other selections available.

To create the JDT, click Create in the Job Descriptor Ticket (JDT) section. The basic default JDT information displays
in the box to the right of this field, and newTemplate.jdt displays in the Job Descriptor Ticket (JDT) box. Use the Job
Descriptor Ticket (JDT) Options section to specify the options for the new JDT.

Make sure to specify a new name in the Save JDT File As field to save the new JDT.

Creating a Line Mode Data File for Use with an Existing Job Descriptor Ticket

Once you access the VI Design Pro Line Mode window, create a new line mode data file for use with an existing JDT
file to test the design and output of an application. To access the existing JDT file, click Load in the Job Descriptor
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Ticket (JDT) section to access the Choose a New JDT File to load window. Use this window to select the JDT file to
access and click Open.

When the file is loading, VI Design Pro searches for the SETGRID and orientation values and enters any available
information in the Characters per Line, Line per Page, and Orientation fields in the Job Descriptor Ticket (JDT)
Options section of the window. This information is used to create the data file. Modify these values using the fields
available in the Data File (LM) section.

Once you have selected the JDT, Create is disabled in the Job Descriptor Ticket (JDT) section, Load is disabled in the
Data File (LM) section, and the Data File (LM) box defaults to NONE with no other selections available.

To create the data file, click Create in the Data File (LM) section. The basic default data file information displays in
the box to the right of this field, and newTemplate.lm displays in the Data File (LM) box. Use the Data File (LM)
Options section to specify the options for the new data file.

Make sure to specify a new name in the Save Data File As field.

Using the VI Design Pro Line Mode Window

This section describes the information that you select, and that displays, when you access the VI Design Pro Line
Mode window. Use this window to access an existing Line mode data file or Job Descriptor Ticket (JDT) file, create a
new Line mode data file or Job Descriptor Ticket (JDT) file, or to access an existing Line mode data file template
and Job Descriptor Ticket (JDT) file template.

After specifying the information used to access an existing Line mode application, create a new Line mode
application, or use a Line mode application template, click OK to display the VI Design Pro Project Wizard window
to create a new project. Then use VI Design Pro’s window to manipulate, test, and print the application information
and prepare it for output to a PostScript printer.

The following fields and information display on the VI Design Pro Line Mode window:

Data File (LM)

Use this box together with the Load, Create, and Templates buttons to select the appropriate line mode data
file. The information related to the button you click and the data file you select displays in the box to the right
of this field. Use this box and the buttons as follows:

Load

Click this button to access an existing line mode data file. When you click this button, the Choose a New Data
File to Load window displays. Use this window to select the line mode data file to access. After you select the
line mode data file and click OK, the data stream information for the line mode data file displays in the box to
the right of this field, and the file you selected is the only item available from the Data File (LM) box.

This option allows you to import a data file that was created by a third-party application (such as Access) for
use with the application. Use Create and the Job Descriptor Ticket (JDT) box to create a JDT for use with the
data file.

Create

Click this button to create a new line mode data file. When you click this button, the basic default data stream
information displays in the box to the right of this field, and newTemplate.lm displays in the Data File (LM) box.
Use the Data File (LM) Options section to specify the options for the new data file. Use the Save Data File As
field to specify the file name to use for the new line mode data file.
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Templates

Click this button to use a line mode data file template. When you click this button, the Data File (LM) contains a
list of all of the line mode data file templates that are available. When you select a template from this list, the
data stream information for the template you selected displays in the box and the corresponding JDT displays in
the Job Descriptor Ticket (JDT) box. Make sure to specify a new name in the Save Data File As field so that you
do not permanently change the template file.

Job Descriptor Ticket (JDT)

Use this box together with the Load, Create, and Templates buttons to select the appropriate Job Descriptor Ticket
(JDT) file. The information related to the button you click and the JDT file you select displays in the box to the right
of this field. Use this box and the buttons as follows:

Load

Click this button to access an existing JDT. When you click this button, the Choose a New JDT File to Load
window displays. Use this window to select the JDT to access. After you select the JDT and click OK, the
information for the JDT displays in the box to the right of this field, and the JDT you selected is the only item
available from the Job Descriptor Ticket (JDT) box. Use Create and the Data File (LM) box to create a line mode
data file for use with the JDT.

Create

Click this button to create a JDT. When you click this button, the basic default JDT information displays in the
box to the right of this field, and newTemplate.jdt displays in the Job Descriptor Ticket (JDT) box. Use the Job
Descriptor Ticket (JDT) Options section to specify the options for the new JDT. Use the Save JDT File As field to
specify the file name to use for the new JDT.

Templates

Click this button to use a JDT template. When you click this button, the Job Descriptor Ticket (JDT) box contains
a list of all of the JDT templates that are available. When you select a template from this list, the information for
the JDT template you selected displays in the box and the corresponding line mode data file displays in the
Data File (LM) box. Specify a new name in the Save JDT File As field so that you do not permanently change the
template file.

Save Data File As

Enter the name to use for the line mode data file. This file should have an extension of .Im.

Save JDT File As

Enter the name to use for the JDT. This file should have an extension of jdt.

Characters per Line

Use this box to specify the default for the maximum number of characters per line to use for the line mode data
file. This field is only available when you are creating a new line mode data file. The valid range is from 1 to
255.

Lines per Page

Use this box to specify the default for the maximum number of lines per page to use for the line mode data file.
This field is only available when you are creating a new line mode data file. The valid range is from 1 to 255.
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Record Buffer Size

Use this box to specify the default maximum record buffer size to use for the line mode data file. Specify a
buffer size from 150 to 32,000. This field is only available when you are creating a new line mode data file.

Number of Pages

Use this box to specify the default number of pages to use for the line mode data file. This field is only available
when you are creating a new line mode data file. The valid range is from 1 to 100.

Graphical Units

Contains the unit of measure in use for the JDT file, for example, DOT3 (1/300 in.). This field is for information
only. The information in this field cannot be changed.

Orientation

Use this box to select the default page orientation to use for the JDT file, for example, PORT (portrait). This field
is only available when you are creating a new JDT. Options are as follows:

PORT (portrait)

Display the application in portrait mode.

LAND (landscape)

Display the application in landscape mode.

IPORT (inverse portrait)

Display the application in inverse portrait mode.
ILAND (inverse landscape)

Display the application in inverse landscape mode.
Duplex Mode

Use this box to specify the default duplex print mode to use for the JDT. This field is only available when you are
creating a new JDT. Options are as follows:

None

Do not output the application in duplex mode.

Regular Duplex

Output the application in regular duplex mode.
Tumble Duplex

Output the application in tumble duplex mode. This option rotates the even page (back page) images.
Use SETGRID

Select this check box to specify the default values that will be used to insert character per line and line per page
information for the JDT. When you select this check box, the Characters per Line and Lines per Page fields for the
JDT are enabled. This field is only available when you are creating a new JDT. By default, the check box is selected.

Use RPE

Select this check box to use a Record Processing Entry (RPE) library definition in the Job Descriptor Ticket (JDT) file.
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By default, the check box is not selected.
Characters per Line

Use this box to specify the default for the maximum number of characters per line to use for the JDT. This field is
only available when you are creating a new JDT and you select the Use SETGRID check box. The valid range is
from 1 to 255.

Lines per Page

Use this box to specify the default for the maximum number of lines per page to use for the JDT. This field is only
available when you are creating a new JDT and you select the Use SETGRID check box. The valid range is from 1 to
255.

Form File

Click Browse to access the Select Form Resource File window and select the default form to use with the JDT. This
field is only available when you are creating a new JDT.
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The Smart Editor is an interactive facility that allows you to add or edit VIPP® commands, parameters, and values in
the source files. When you right-click on most areas in VI Design Pro’s GUI, a menu will pop up. The contents of the
menu is context-sensitive and allows access to all the commands and functions available in VI Design Pro.

SmartEditor and Error Correction

In general, the SmartEditor cannot be relied on to automatically fix errors in VIPP® command arguments or
syntax that may exist in the VIPP® source code. This is because the number of different ways a given VIPP®
command can be improperly formed is potentially infinite. Beyond a certain point, the SmartEditor can no
longer determine the intent of the code well enough to decide how to present editing options. If, upon
invocation, the SmartEditor detects command parameter problems (either wrong parameter type or missing
parameters) that it cannot handle, it will notify you of the failure to successfully parse the command. If this
happens, select the VIPP® command with the mouse and use the F1/Help feature to determine the nature of
the problem and to correct the syntax manually.

Depreciated Commands

In order to maintain backward compatibility, the Smart Editor contains some menu items and dialogs for
deprecated commands. Although the commands are supported, Xerox recommends that the replacement
command, SETFINISHING, be used in lieu of the older commands.

Command dialogs for deprecated commands are not discussed in this document. For information on
deprecated command dialogs, refer to earlier versions of this document, and of the VIPP® Language Reference
Manual.
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Command Dialogs

The Smart Editor menu provides access to all VIPP® commands and parameters via dialogs, each of which are
described in detail in the following sections. The information found in these sections can be applied to both the
Insert a ... Command dialogs, and the corresponding Edit a ... Command dialogs.

The Smart Editor menu provides access to these general groups of VIPP® commands:

Fonts, colors, and variables

Output Device Control

PDF Interactive Features

Page Layout

Print File Processing

Job Data Capture

Page Marking

Cyclecopy Control

Custom Color Lists

RPE Items

Page Control

The command dialogs contain fields in which you can enter variable and parameter information specific to the

command being entered.
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Fonts, Colors, and Variables

The Smart Editor produces these options when Font, Colors, and Variables is selected from the Smart Editor menu:

Index Font Set Color Definition Set Text Bkgrd Att ribute
Index Font Kerning Set GEP Definition Set Sub/SuperScript
Index Color Define Layout Set Variable
Index BAT Key Set Layout Store Variable
Index Line Spacing Set Font Save Current Context
Index Sub/Superscript Set Font Kerning Reset Current Context
Index Align Set Text Color Set Date

INDEX FONT

The Index Font option accesses the Insert INDEXFONT Command dialog. Use this dialog to specify the information
to use to create a font index and then insert the font index command at the current cursor position.

These fields appear on the Insert INDEXFONT Command dialog:

Font Sample

Refer to Font and Effects Preview/Select/Sample in the VI Design Pro GUI chapter of this document for
information on changing the sample font viewed here.

Font Index Name

Enter the name to use for the font index.
e When used externally, to enter any alphanumeric string starting with an alphabetic character.
e When used inside printable data, to enter a string that consists of a single alphanumeric character.

Font Name

Use the Font Name box to select the font to assign to the font index. This list includes all of the fonts currently
available for use.

Font Type

Choose one of the following font types:
e Normal

e Microprint

e Gloss Text

These options are also included to facilitate changing the font face to a different member of the same font
family without having to respecify the Fontname:

/~REG Regular font of current family

/~BLD Bold font of current family
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/~ITL Italic font of current family

/~BDI Bold Italic font of current family

/~CUR Current font of current family
Specify Height and Width

Select the Specify Height and Width check box to specify a different font size for the font height and width.

Font Width

Enter a value specifying the font width for the font index. Enter a value that includes integers or real numbers.
The font size is based on units of 1/72 points. When you enter O, the font is automatically scaled based on the
margins and grid that are specified in the SETMARGIN and SETGRID commands.

Initially, this field is labeled FontSize. When you check the Use X and Y size box, this field name displays as X
FontSize and the font size value you enter applies only to the X (horizontal) axis.

Font Height

Enter a value specifying the font height. Use a value that includes integers or real numbers. The font size is
based on units of 1/72 points. When 0 is entered, the font is automatically scaled based on the margins and
grid specified in the SETMARGIN and SETGRID commands. This field is only enabled when the Specify Height
and Width box is checked.

INDEX FONT KERNING

The Index Font Kerning option accesses the Insert INDEXKERN Command dialog. Use this dialog to specify the
information to use to create a font kerning index and then insert the font kerning index command at the current
cursor position.

More information about font kerning can be found in the VIPP® Language Reference Manual, and in Adding
PostScript fonts.

These fields appear on the Insert IndexKERN Command dialog:
Kern Index
Insert an alphanumeric string defining the Kern Index, the default is /K1.

Once defined by INDEXKERN, Kernindex can be used externally as a stand-alone command between subsequent
SHx commands, or following a switch prefix inside printable data processed by SHMF or SHP. The switch prefix is
defined by SETFTSW (the default is "//").

When used externally, the kern index can be any alphanumeric string starting with an alphabetic character. When
used inside printable data, the kern index must be an alphanumeric character string whose length is defined by
SETFTSW (the default is 1).

Pair-wise Kerning

Select the pair-wise kerning option. Selections include:

0 Disable

null Keep current
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.5 Looser
1 Regular
1.5 Tight
2 Tighter
Generic Track Kerning
Select generic track kerning values:
0 Disable
null Keep current
-3 Tightest
-2 Tighter
-1 Tight
1 Loose
2 Looser
3 Loosest

Track Kerning Degree

Define the track kerning degree. Choose one of these values:

0 Disable

null Keep current
-3 Tightest

-2 Tighter

-1 Tight

1 Loose

2 Looser

3 Loosest

INDEX COLOR

The Index Color option accesses the Insert INDEXCOLOR Command dialog. Use this dialog to specify the

information to use to create a color index and then insert the color index command at the current cursor position.

These fields appear on the Insert IndexColor Command dialog:

Index Name

Enter the name to use for the color index.
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e When used externally, enter any alphanumeric string starting with an alphabetic character.
e When used inside printable data, enter a string that consists of a single alphanumeric character.

Colorkey

Use this box to select the name of the text Colorkey to assign to the color index. The box on the right side of
the dialog displays the color that you selected. This list includes all of the font Colorkeys that are currently
available for use.

Transparency level
Enter O to 1

Tint
Enter O to 1

Pattern

Use this box to select the name of the pattern to assign to the color index. This list includes all of the patterns
that are currently available for use.

INDEX BAT KEY

The Index BAT Key option accesses the Insert INDEXBAT Command dialog. Use this dialog to specify the
information to use to create a background attribute key index and then insert the background attribute key index
command at the current cursor position.

These fields appear on the Insert IndexBAT Command dialog:
Index Name
Enter the name to use for the background attribute key index.
e When used externally, enter any alphanumeric string starting with an alphabetic character.
e When used inside printable data, enter a string that consists of a single alphanumeric character.

BAT Key

Use this menu to select the name of the background attribute key to assign to the background attribute key
index. This list includes all of the background attribute keys that are currently available for use.

INDEX LINE SPACING

The Index line Spacing option accesses the Insert INDEXLSP Command dialog. Use this dialog to specify the
information to use to create a line spacing index and then insert the line spacing command at the current cursor
position. INDEXLSP is mainly intended to be used inside text blocks printed with SHP in conjunction with fonts of
different sizes.

Index Name

Enter the name to use for the line spacing index.

Spacing Value

Use this box to enter a value for line spacing in the application.
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INDEX SUB/SUPERSCRIPT

The Index Sub/Superscript option accesses the Insert INDEXSST Command dialog. Use this dialog to specify the
parameters for subscript or superscript and insert the command at the current cursor position.

These fields appear on the Insert INDEXSST Command dialog:

Index Name

Enter the name to use for the Sub/Super parameter index.

Sub/Super Parameter

Use this drop down list to select the name of the subscript or superscript parameter to assign to the sub/super
attribute key index. This list includes all of the sub/super attribute keys that are currently available for use.

INDEX ALIGN

The Index Align option accesses the Insert INDEXALIGN Command dialog. Use this dialog to specify the
information to use to create an alignment index and then insert the align parameter at the current cursor position.
INDEXALIGN is only effective inside text blocks printed with SHP.

Alignment Index Name

Enter the name to use for the alignment index.
Text Alignment

Select one of the following values:

e Left or Top

« Right or Bottom

e Center

e Justified

e Right-align Last Line

e (Center Last Line

e Justify All Lines

SET COLOR DEFINITION

The Set Color Definition option accesses the Insert SETCOL Command dialog. Use this dialog to define colors used
in the application, including those applied to graphic elements and gradient fills. (The dialog depicted below is a
composite of all selections, boxes on the screen will be greyed out.)

These fields appear on the Insert SETCOL Command Dialog:
Color Name

Enter the name of the color you are defining.

Color Type

Select one of these color types:
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Grayscale

Activates the Grayscale field

RGB
Activates the Red, Green, and Blue fields

CMYK

Activates the Cyan, Magenta, Yellow, Black and Separation Color Space fields
Gradient
Activates the Start, Middle and End Color/Weight, tint, and Direction fields on the dialog
Color Sample
Displays a sample of the color being defined.
Grayscale

Used when the Grayscale color type is selected. Enter the grayscale value used. the range is from 0O (black) to 1
(white).

Red
Active when the RGB Color type is selected, enter a value between 0 and 1.
Green

Active when the RGB Color type is selected, enter a value between 0 and 1 or when the CMYK Color type selected
and Separation Color Space is /CMYKG.

Blue

Active when the RGB Color type is selected, enter a value between 0 and 1 or when the CMYK Color type selected
and Separation Color Space is /CMYKB.

Cyan

Active when the CMYK Color type is selected, enter a value between 0 and 1.
Magenta

Active when the CMYK Color type is selected, enter a value between 0 and 1.
Yellow

Active when the CMYK Color type is selected, enter a value between 0 and 1.
Black

Active when the CMYK Color type is selected, enter a value between 0 and 1.
Orange

Active when the CMYK Color type is selected, enter a value between 0 and 1. Fifth color support.
Separation Color Space

Choose a value from the drop-down list. When a selection is made the color boxes for the available colors are
activated. (For example, if /SCS_CMY is chosen, the Cyan, Magenta and Yellow boxes are available for input.)
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Start Color

Active when the Gradient Color type is selected, use the drop-down to define the start color.
Middle Color

Active when the Gradient Color type is selected, use the drop-down to define the middle color.
End Color

Active when the Gradient Color type is selected, use the drop-down to define the end color.
Start Color Weight

Active when the Gradient Color type is selected, use the drop-down to define the color weight, or gradation,
between the Start and Middle colors.

Middle Color Weight

Active when the Gradient Color type is selected, use the drop-down to define how long the Middle color is
maintained unchanged in the middle (between the Start and End colors).

End Color Weight

Active when the Gradient Color type is selected, use the drop-down to define the End color weight, or gradation,
between the Middle and End colors. When the weight is equal to zero only the Start and Middle colors are used.

Tint

Active when the Gradient Color type is selected, enter a number ranging from 0 to 2, which is used to apply a
common tint to the entire gradient.

Oto1 Light tints from white to plain colors

1 Plain color

Tto2 Dark tints from plain colors to black
Direction

Active when the Gradient Color type is selected, select either horizontal or vertical direction in which to apply the
gradient.

Clear Dry Ink

Active when the CMYK Color type is selected and Separation Color Space is either /SCS_SV or /SCS_V or /SCS_
CMYKYV, enter a value between 0 and 1.

Spot Color

Active when the CMYK Color type is selected and Separation Color Space is /SCS_SV, populated custom PANTONE
color list.

SET GEP DEFINITION
The Set GEP Definition option accesses the Insert SETGEP Command dialog. Use this dialog to define a GEPkey.
GEP Key Name
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Enter the name of the GEPKey you are defining.

Line Width

Enter the value for the line width of the outline border. O indicates no border.
Border Color

Use the drop-down list to select the border color.

Border Pattern

Use the drop-down list to select the border pattern.

Dash Pattern

Use to define the dash pattern for the outline border. O indicates a solid line. It may be either a single number
defining the equal width of filled and unfilled portions or a list specifying the initial offset and a width sequence.

Fill Color
Use the drop-down list to select the fill color.
Fill Pattern

Use the drop-down list to select the fill pattern.

DEFINE LAYOUT

The Define Layout option accesses the Insert DEFINELAYOUT Command dialog. Use this dialog to define different
logical page layouts for Multi-Up applications. The layouts defined here are used with the SETLAYOUT command.

These fields appear on the Insert Command dialog:

Layout Name

Enter a name for the layout being defined.

/PageWidth
Enter the width of the logical pages.

/PageHeight
Enter the height of the logical pages.

/LayoutMarks
Choose one of the following options:
0 No Marks, default
1 Crop Marks
2 Bleed Marks
3 Both

Layout Mark Pages

Choose one of the following options:
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00 Front Pages Only

10 Back Pages Only

20 Front and Back Pages
Omit Marks

Choose one of the following options:

000 None

100 Inside Crop Marks

200 Inside Bleed Marks

300 Inside Crop and Bleed Marks
/MarkLength

Enter the length of the layout marks. The default value length is 18 points.

/MarkWidth
Enter the width of the layout marks. The default value width is .5 points.

/MarkOffset

Enter offset for mark from the corner. The default value of offset is 4.5 points.

/TopBleed

Enter a value for the amount of bleed allowed at the top margin of the logical page. The default value is O.

/BottomBleed

Enter a value for the amount of bleed allowed at the bottom margin of the logical page. The default value is 0.

/LeftBleed

Enter a value for the amount of bleed allowed at the left margin of the logical page. The default value is O.

/RightBleed

Enter a value for the amount of bleed allowed at the right margin of the logical page. The default value is O.

/HGutter

Enter a value for the horizontal gutter. The default value is O.

/VGutter

Enter a value for the vertical gutter. The default value is O.

/Across

Enter the number of logical pages across the sheet. The default value is 1.
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/Down

Enter the number of logical pages down the sheet. The default value is 1.

/Rotate

Enter the degrees of rotation for the logical pages. The possible values are: 0, 90, 180, and 270 clockwise. The
default value is 0. You can define the parameter as an array. The example is for head-to-toe printing on a 4-up
page signature:

/Rotate [ 00180180 ]

[FillOrder
Choose the order for filling the logical pages:

Right Down Left to right, then top to bottom, default
Left Down Right to left, then top to bottom
Right Up Left to right, then bottom to top
Left Up Right to left, then bottom to top
Up Right Bottom to top, then left to right
Down Right Top to bottom, then left to right
Down Left Top to bottom, then right to left
Up Left Bottom to top, then right to left
SET LAYOUT

The Set Layout option accesses the Insert SETLAYOUT Command dialog. Use this dialog to insert the SETLAYOUT
command at the current cursor position.

The SETLAYOUT Command Dialog allows entry of a previously defined layout, or the addition of new parameters.

These fields appear on the Insert SETLAYOUT Command dialog:

Layout Type
Choose:
Use Layout Name To enter an existing Layout Name as defined on the Insert DEFINELAYOUT
Command dialog.
Use Layout Parameters To enter values for some or all of the parameters.

Refer to Define Layout for parameter definitions.

SET FONT

The Set Font option accesses the Insert SETFONT Command dialog. Use this dialog to specify the information to
use for the font and then insert the font command at the current cursor position.

146 Xerox® FreeFlow® VI Design Pro Software User Guide



Smart Editor

These fields appear on the Insert SetFont Command dialog:
Font Sample

Refer to Font and Effects Preview/Select/Sample in the "VI Design Pro GUI" chapter of this document for
information on changing the sample font viewed here.

Font Name

Use this box to select the name of the font to use. This list includes all of the fonts that are currently available for
use.

These options are also included to facilitate changing the font face to a different member of the same font family
without having to respecify the Fontname:

/~REG Regular font of current family

/~BLD Bold font of current family

/~ITL Italic font of current family

/~BDI Bold Italic font of current family

/~CUR Current font of current family
Font Type

Select one of these font types:

e Normal

e Microprint

e GlossMark

Specify Height and Width

The Specify Height and Width box is enabled only when you have selected "Normal" as the font type. Check
Specify Height and Width to specify a different font size for the font height and width. When you check this box,
the Font Height field is enabled.

Font Width

Enter a value specifying the font width. Enter a value that includes integers or real numbers. The font size is based
on units of 1/72 points. When you enter 0, the font is automatically scaled based on the margins and grid that are
specified in the SETMARGIN and SETGRID commands.

Initially, this field is labeled FontSize. When you check the Use X and Y size box, this field name displays as X
FontSize and the font size value you enter applies only to the X (horizontal) axis.

Font Height

Enter a value specifying the font height. The size of the font to use for the Y (vertical) axis. Use a value that includes
integers or real numbers. The font size is based on units of 1/72 points. When 0 is entered, the font is automatically
scaled based on the margins and grid specified in the SETMARGIN and SETGRID commands. This field is only
enabled when the Specify Height and Width box is checked.
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SET FONT KERNING

The Set Font Kerning option accesses the Insert SETKERN Command dialog. Use this dialog to set the kerning
options for all subsequent text imaged using one of the SHx commands, and insert a SETKERN command at the

current cursor position.

More information about font kerning can be found in the VIPP® Language Reference Manual, and in Adding

PostScript fonts.

These fields appear on the Insert SETKERN Command dialog:

Pair-wise Kerning

Use this box to select the pair-wise kerning option.

Selections include:

0 Disable

null Keep current
5 Looser

1 Regular

1.5 Tight

2 Track Kerning

Generic Track Kerning

Use this box to select generic track kerning values:

0 Disable

null Keep current
-3 Tightest

-2 Tighter

-1 Tight

1 Loose

2 Looser

3 Loosest

Track Kerning Degree

Use this box to define the track kerning degree. Choose one of these values:

0 Disable
null Keep current
3 Tightest
-2 Tighter
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1 Tight

1 Loose

2 Looser
3 Loosest

SET TEXT COLOR

The Set Text Color option accesses the Insert SETTXC Command dialog. Use this dialog to specify the information
to use to insert a text color and then insert the text color command at the current cursor position.

Transparency level: enter O to 1

Tint: enter O to 1

These fields appear on the Insert SETTXC Command dialog:
Colorkey

Use the menu to select the name of the text Colorkey to use. The box on the right side of the dialog displays
the color that you selected. This list includes all of the font Colorkeys that are currently available for use.

Pattern

Use the menu to select the name of the pattern to use. This list includes all of the patterns that are currently
available for use.

SET TEXT BKGRD ATTRIBUTE

The Set Text Bkgrd Attribute option accesses the Insert a SETTXB Commmand dialog. Use this dialog to specify the
information to use to insert a text background attribute and then insert the text background attribute command at
the current cursor position.

This field appears on the Insert SETTXB Command dialog:
BAT Key

Use the menu to select the name of the text background attribute key to use. This list includes all of the text
background attribute keys that are currently available for use.

A sample of the selected BATKey appears at the top of the dialog.

SET SUB/SUPERSCRIPT

The Set Sub/SuperScript option accesses the Insert SETTXS Command dialog. Use this dialog to specify the
parameters to use when printing subscript or superscript characters.

This field appears on the Insert SETTXS Command dialog:

Sub/Super Parameter

Choose the parameter to use or enter a numerical value.
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SET VARIABLE

The Set Variable option accesses the Insert SETVAR Command dialog. Use this dialog to specify the information to
use to set the value for a variable and then set the variable command at the current cursor position. After you have
set a variable, store the variable and use it in any command in place of a string, number, or array parameter.

zl
Wariable Name INAF{.sample
Walue 1 ;I
NI
Caution: When entering value, make sure strings are enclosed in parentheses
and amays are enclosed in square brackets.
ok | Hp | Cancel |

These fields appear on the Insert SETVAR Command dialog:

Variable Name

Enter the name of the variable to set. Enter any alphanumeric string of up to 20 characters.

Value

Enter the value to associate with the variable. Enter a string, a number, or an array.
e Ifastring is entered, enclose it in parentheses ().
e Ifan array is entered, enclose it in square brackets [ 1.

INI

Check the INI box to specify that you only want the variable to be set if it is not already set. This is particularly
useful when you are initializing a variable in a DBM.

STORE VARIABLE

The Store Variable option accesses the Insert STOREVAR Command dialog. Use this dialog to specify the
information necessary to store a variable in a file for later use by the same or another application, then insert the
stored variable command at the current cursor position.

These fields appear on the Insert STOREVAR Command dialog:
Variable Name

Enter the name of the variable to store. Enter any alphanumeric string of up to 20 characters.

Storefile Name

Enter the file name to use for the stored variable.
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Multi-Instance VIeC Allowed

Enable this option to allow multi-instance when running VIeC (FreeFlow VI eCompose) jobs.

Project Allows File in first SETPPATH Directory
Enable this option when there is a file in the first SETPPATH directory for the job.

Append Data to File

Enable as appropriate for the job.

Text Mode

Enable as appropriate for the job.

SAVE CURRENT CONTEXT

The Save Current Context option accesses the Insert RSAVE Command dialog. Use this dialog to insert an RSAVE
command at the current cursor position.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

RESET CURRENT CONTEXT

The Reset Current Context option accesses the Insert RESET Command dialog. Use this dialog to insert a RESET
command at the current cursor position.

The RESET command restores the VIPP® context to the initial default value or to the value stored by the last RSAVE
command. This command also cancels all forms, fonts, etc.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

SET DATE

The Set Date option accesses the Insert SETDATE Command dialog. Use this dialog to specify the information
necessary to temporarily set the date variables.

These fields appear on the Insert SETDATE Command dialog:
Specify a Date

Select this option to enter a specific date and time by entering their value (integer only) in these fields:

Year is the year (>1970).

Month is the month (1-12).

Day is the day (1-31).

Hour is the hours (0-23).

Minute is the minutes (0-59).

Second is the seconds (0-59).
Specify Number of Days
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Select this option to set the date using the number of days since January 1, 1970 as the basis. The entered value
must be an integer.
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Page Layout

The Smart Editor produces these options when Page Layout is selected from the Smart Editor menu:

Set Units Set Page Orientation Set Tab Positions

Set Coordinate Origin Set Page Margins Set Zebra Lines

Set Max Forms/BackForms Set Page Frame Set Column Width

Set Form/BackForm Set Page Grid Set Widow/Orphan Control
Shift Page Origin Set Page Numbering Set Linked Frames Mode

Shift Form Origin Set LineFeed Increment Go to Next Frame
OneUp/TwoUpPrinting Set LineSpacing Value Go to Specified Frame

Set Page Definitions Set Tab Spacing Initialize OMR Code for Mailer
Set Page Size

SET UNITS

The Set Units option accesses the Insert SETUNIT Command dialog. Use this dialog to indicate the units of
measure and then insert the unit of measure command at the current cursor position.

This field appears on the Insert SETUNIT Command dialog:

Units of Measure

Use this box to select the unit of measure to use. This is the unit of measure that is used for all commands
except the SETGEP commands; use SETUNIT to specify this information for the SETGEP command.

This box provides the following options:

DOT3 To use 300 dots per inch as the graphical unit of measure.

PELS To use picture elements (pels), or pixels, as the graphical unit of measure.
POINT To use points as the graphical unit of measure.

CM To use centimeters as the graphical unit of measure.

MM To use millimeters as the graphical unit of measure.

INCH To use inches as the graphical unit of measure.

SET COORDINATE ORIGIN

The Set Coordinate Origin option accesses the Insert Coordinate Origin dialog. Use this dialog to specify coordinate
origin information and then insert the coordinate origin command at the current cursor position.

This field appears on the Insert Coordinate Origin dialog:
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Coordinate Origin

Use this box to select the coordinate origin to use:

ORIBL

To set the origin at the bottom left corner for all coordinates, except for the Record Processing Entry (RPE).

ORITL

To set the origin at the top left corner for all coordinates.

SET MAX FORMS/BACKFORMS

The Set Max Forms/BackForms option accesses the Insert a SETMAXFORM Command dialog. Use this dialog to
specify the information to use to specify the number of form planes and backform planes for a page and then
insert the form plane and backform plane command at the current cursor position.

These fields appear on the Insert SetMaxForm Command dialog:
Max Forms (Planes)

Enter the maximum number of form planes allowed on the page. This indicates the number of forms that can be
imaged on top of each other on a single page. Enter a value between 0 and maxplanenumber-1, associated forms
are imaged in that order. PostScript elements are opaque.

Apply to Back Forms

Check the Apply to Back Forms box to specify that the maximum plane value you entered in the Max Forms
(Planes) field will apply to back form planes.

SET FORM/BACKFORM

The Set Form/BackForm option accesses the Insert a SETFORM Command dialog. Use this dialog to specify the
information to use to insert a form or backform and then insert the form command at the current cursor position.
After you perform this task, a new form tab is created in the Resource Notebook section of VI Design Pro’s window
and the information for the form displays on the tab.

These fields appear on the Insert SETFORM Command dialog:
Formname

Enter the name of the form to insert, or use Browse to access the Please choose the file to load window and select
the form to insert. Use Preview to see a graphical representation of the selected form.

Specify Planenumber

Check the Specify Planenumber box to enter plane number information for this form. When you check this box,
the Plane Number field is enabled.

Plane Number

This field is enabled when you check the Specify Planenumber box. Use this field to enter the plane number for this
form. The value you enter specifies the order in which this form is imaged on the page in relation to the other forms
imaged on the page.

When you enter a value in this field, the value must be less than or equal to the maximum number of planes that
can be imaged on a page (the value entered in the Max Forms (Planes) field on the Insert SETMAXFORM
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Command dialog). For example, when you use the Insert SETMAXFORM Command dialog to specify that a page
can have seven planes, use this field to specify that this particular form is plane five.

Specify Copy Selection

Check the Specify Copy Selection box to enter copy selection information for the form. When you check this box,
the Copies Selection field is enabled.

Copies Selection

This field is enabled when you check the Specify Copy Selection box. Use this field to enter the values that
correspond to the pages on which this form is imaged. For example, [ 1 5 ] indicates that the form is imaged only
on copies one and five.

When you enter a value in this field, the value must be less than or equal to the maximum number of copies that
will be printed (the value entered in the Number of Copies field on the Insert SETCYCLECOPY dialog). When you do
not enter a value in this field, the form is imaged on all copies.

Set Back Side Form

Check the Set Back Side Form box to apply the values entered on this screen to a back side form. This option
changes the command from SETFORM to SETBFORM. For duplex mode jobs this causes the static form to print on
the back side of each page and the variable data on the front side.

SHIFT PAGE ORIGIN

The Shift Page Origin option accesses the Insert SHIFT Command dialog. Use this dialog to specify page shift
information and then insert the page shift command at the current cursor position.

This command defines the horizontal (X) and vertical (Y) shift values for the front and back pages of a job. When
using this command, all of the page content is shifted from the bottom left origin on the horizontal and vertical
axis, based on the values specified for the command (either positive or negative). The specified values always refer
to the bottom left origin of the portrait sheet, regardless of the page orientation. This command is useful to set the
left or top margins when you are binding a job in duplex mode.

These fields appear on the Insert Shift Command dialog:
X FrontSide Shift

Enter the number of units by which the information will shift on the X axis (horizontal) on the front page.

Y FrontSide Shift

Enter the number of units by which the information will shift on the Y axis (vertical) on the front page.

X BackSide Shift

Enter the number of units by which the information will shift on the X axis (horizontal) on the back page.

Y BackSide Shift

Enter the number of units by which the information will shift on the Y axis (vertical) on the back page.

SHIFT FORM ORIGIN

The Shift Form Origin option accesses the Insert FORMSHIFT Command dialog. Use this dialog to specify form shift
information and then insert the form shift command at the current cursor position.
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This command allows you to adjust the origin in a VIPP® form and is only in effect inside a form definition
(between curly braces) and after the orientation command.

These fields appear on the Insert FormShift Command dialog:
X Shift
Enter the number of units by which to shift the X axis (horizontally).

Y Shift
Enter the number of units by which to shift the Y axis (vertically).

ONEUP/TWOUPPRINTING

The OneUp/TwoUp Printing option accesses the Insert 1Up/2Up Option dialog. Use this dialog to print using
OneUp or TwoUp mode and then insert either a OneUp or TwoUp printing command at the current cursor position.

This field appears on the Insert TUp/2Up Option dialog:
1Up/2Up Option

Use this box to select the printing option to use. This list provides the following options:

ONEUP To use OneUp mode, which permits a single logical page to be imaged on each
physical page. Use this option to cancel TWOUP or Multi-Up modes.

TWOUP To use TwoUp mode, which permits two reduced logical pages to be printed on top
of each other (LAND/ILAND) or side by side (PORT/IPORT) on the same physical
page. Use this option with SETCYCLECOPY and COLLATE_off to produce two
reduced copies of a document on a normal size sheet of paper.

SET PAGE DEFINITIONS

The Set Page Definitions option accesses the Insert SETPAGEDEF Command dialog. Use this dialog to define
different sets of frames, forms, media and other layout settings for consecutive pages. The layouts are applied in
the order they are defined in a cyclical manner unless the last layout is followed by the /R key. When you use the /R
key, the last layout is applied indefinitely.

Use the right hand dialog to manually enter the definitions for the page layout highlighted on the left hand screen.
Refer to the VIPP® Language Overview in the VIPP® Language Reference Manual for SETPAGEDEF syntax and
examples.

SET PAGE SIZE

The Set Page Size option accesses the Insert SETPAGESIZE Command dialog. Use this dialog to specify page size
information and then insert the page size command at the current cursor position.

All page layout settings such as orientation, grid, and margins are based on these values. When you do not specify
the page size values, the default values are the default page size for the imaging device. An error occurs when this
command is placed incorrectly (for example, in the middle of a page). On Level 2 printers, this command causes
subsequent pages to print on the correct media.

These fields appear on the Insert SETPAGESIZE Command dialog:
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Page Width

Enter the value for the page width to use. In general, this refers to the short edge of the page which is the
horizontal, X, axis in portrait orientation.

Page Height

Enter the value for the page height to use. In general, refers to the long edge of the page which is the vertical, Y,
axis in portrait orientation.

SET PAGE ORIENTATION

The Set Page Orientation option accesses the Insert Page Orientation dialog. Use this dialog to specify page
orientation information and then insert the page orientation command at the current cursor position.

This field appears on the Insert Page Orientation dialog:
Page Orientation

Use this box to select the page orientation to use:

PORT Use portrait orientation.

IPORT Use reverse portrait orientation.
LAND Use landscape orientation.

ILAND Use reverse landscape orientation.

SET PAGE MARGINS

The Set Page Margins option accesses the Insert SETMARGIN Command dialog. Use this dialog to specify page
margin information and then insert the page margins command at the current cursor position.

j’ Note: When using this command, measure the bottom and right margins from the bottom and right edges
of the page. Otherwise, the font can be scaled incorrectly when using auto-scale mode.

These fields appear on the Insert SetMargin Command dialog:
Top Margin
Enter the margin for the top of the page.

Bottom Margin
Enter the margin for the bottom of the page.

Left Margin
Enter the margin for the left side of the page.

Right Margin
Enter the margin for the right margin of the page.
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SET PAGE FRAME

The Set Page Frame option accesses the Insert SETFRAME Command dialog. Use this dialog to specify frame
information and then insert the frame command at the current cursor position. This command draws an overall
frame around the current page and all following pages.

These fields appear on the Insert SETFRAME Command dialog:

Line Width
Enter the line width to use for the frame. This is the width of the line used to draw the frame. A value of O

indicates no frame.

Offset from Margins

Specify the amount of space between the page margins and the frame.

Line Color

Use the menu to select the color to use for the frame border. The box on the right side of this field displays the
color that you selected. This list includes all of the colors currently available for use.

Line Pattern

Use the menut to select the pattern to use. This list includes all of the patterns currently available for use.

Corner Radius

Specify the radius to use for the corners of the frame. A value of 0 specifies a square.

SET PAGE GRID

The Set Page Grid option accesses the Insert SETGRID Command dialog. Use this dialog to specify characters per
line and lines per page information and then insert the characters per line and lines per page command at the
current cursor position.

These fields appear on the Insert SETGRID Command dialog:

Characters per Line

Enter the number of characters per line to use on the page.

Lines per Page

Enter the number of lines per page to use on the page.

SET PAGE NUMBERING

The Set Page Numbering option accesses the Insert SETPAGENUMBER Command dialog. Use this dialog to specify
page numbering information and then insert the page numbering command at the current cursor position.

These fields appear on the Insert SETPAGENUMBER Command dialog:

Page Number Format

Enter the page numbering format to use (for example, (Page #)). Enter any string in this field, using the number
sign character (#) to represent the page number in the string. The maximum page number is limited to six
characters. Use multiple # characters to print leading zeros in the page numbers (for example (Page ###) prints
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as Page 001).

First Page Number

Enter the value for the first page number to use. Enter zero or a negative value in this field. However, when using
zero or a negative value, any page numbers that are less than one do not print.

Use Position Parameter

Check the Use Position Parameter box to use the Position field to specify the relative position at which the
page number will print. When you check this box, the Position field is enabled. You must check either this box or
the Use X and Y Coords box to specify the page number positioning.

Position

Use this box to select the relative position at which the page number is placed on the printed page. This field is
only enabled when you check the Use Positioning Parameter box.

This list provides the following options:

0 Don't print page number Do not print page numbers on the page.

1 Bottom Center Print the page number centered at the bottom of the printed
page.

2 Bottom Right Print the page number on the right side at the bottom of the
printed page.

3 Top Center Print the page number to print centered at the top of the
printed page.

4 Top Right Print the page number to print on the right side at the top of
the printed page.

Use X and Y Coords

Check the Use X and Y Coords box to specify an absolute position for the page numbers. When you check this
box, the X Coordinate, Y Coordinate, and Alignment fields are enabled. You must check either this box or the
Use Position Parameter box to specify the page number positioning.

X Coordinate

Enter the X (horizontal) coordinate at which the page number will print. This field is only enabled when you
check the Use X and Y Coords box.

Y Coordinate

Enter the Y (vertical) coordinate at which the page number will print. This field is only enabled when you check
the Use X and Y Coords box.

Alignment

Use the menu to select the alignment to use for the page number at the absolute coordinates specified in the X
Coordinate and Y Coordinate fields. This field is only enabled when you select the Use X and Y Coords check
box.

This list provides the following options:
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5 Left Align the page numbers on the left at the specified X and Y coordinates.
6 Right Align the page numbers on the right at the specified X and Y coordinates.
7 Center Align the page numbers in the center at the specified X and Y coordinates.

Use Rotate Parameter

Select the Use Rotate Parameter check box to specify a rotation percentage. When you select this check box,
the Rotation Degrees (+ is CCW) field is enabled.

Rotation Degrees (+ is CCW)

Enter the degree to turn the page number. When you enter a positive number, the page number is rotated
counterclockwise. When you enter a negative number, the page number is rotated clockwise. This field is only
enabled when you select the Use Rotate Parameter check box.

SET LINEFEED INCREMENT

The Set LineFeed Increment option accesses the Insert SETLFI Command dialog. Use this dialog to specify line feed
information and then insert the line feed command at the current cursor position. The line feed increment is the
number of lines that are skipped before or after each record.

This field appears on the Insert SETLFI Command dialog:
Lines to Skip

Enter the number of lines to skip in each line feed (equivalent to the number of carriage returns). When you enter a
positive value, the lines are skipped after each record; when you enter a negative value, the lines are skipped before
each record. The value you enter must be an integer.

SET LINESPACING VALUE

The Set LineSpacing Value option accesses the Insert SETLSP Command dialog. Use this dialog to specify line
spacing information and then insert the line spacing command at the current cursor position.

This field appears on the Insert SetLSp Command dialog:
Line Spacing Value

Enter the amount of space between each line of type (also known as the leading).

SET TAB SPACING

The Set Tab Spacing option accesses the Insert SETTAB Command dialog. Use this dialog to specify the
information about tab spacing.

j’ Note: This command is intended for use only with fixed pitch fonts.

These fields appear on the Insert SETTAB Command dialog:
Tab Spacing

Enter the number of characters between each tab, for example, a value of 8 specifies a tab stop every eight
characters.
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Tab Using Current Units

Select the Tab Using Current Units check box to specify the tab spacing will be based on the current units.

SET TAB POSITIONS

The Set Tab Position option accesses the Insert SETTABS Command dialog. Use this dialog to specify information
about tab alignment and position.

These fields appear on the Insert SETTABS Command dialog:
Tab Alignment

Select from these alignment options:

o Left

e Right

e Center
Tab Position

Enter a value in points for the position of the tab relative to the current main print position.

Leader Character

Enter the character to use as the leader character for this tab position.

Alignment Character

Enter the alignment character used for this tab position.

Default Tab Spacing

Enter the number of spaces to be used as the default distance between tabs. This is the space used each time a
tab character is found and processed after all preceding tab stops in the set have been used.

Delete

Click the Delete button to delete the highlighted entry in the screen to the left of the buttons. Click OK to insert
the SETTABS command into the application at the current cursor position.

Insert

Click the Insert button to insert the values entered in the Tab Alignment and Tab Position boxes, into the screen
to the left of the buttons. Click OK to insert the SETTABS command into the application at the current cursor
position.

Replace

Click the Replace button to replace the highlighted values in the screen to the left of the buttons, with the
values entered in the Tab Alignment and Tab Position boxes. Click OK to insert the SETTABS command into the
application at the current cursor position.

Append

Click the Append button to append additional tabs to the list of tabs in screen to the left of the buttons. The
added tabs are defined with the values entered in the Tab Alignment and Tab Position boxes. Click OK to insert
the SETTABS command into the application at the current cursor position.
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SET ZEBRA LINES

The Set Zebra Lines option accesses the Insert SETZEBRA Command dialog. Use this dialog to specify information
for a shaded background box or greenbar printing.

These fields appear on the Insert SETZEBRA Command dialog:
Colorkey

Use the menu to select the name of the Colorkey to use for the background printing. The box on the right side
of this field displays the color that you selected. This list includes all of the Colorkeys that are currently available
for use.

Pattern Key

Use the drop-down list to select the name of the pattern to use for the background printing. This list includes all
of the patterns that are currently available for use.

Lines with Zebra

Enter the number of lines used in background printing. This field and the Lines without Zebra field define the
sequence of the zebra printing, which is the sequence of lines with and without zebra printing.

Lines without Zebra

Enter the number of lines for which background printing will not be used. This field and the Lines with Zebra
field define the sequence of the zebra printing (the sequence of lines with and without zebra printing).

Zebra Only for Lines Printed

Select the Zebra Only for Lines Printed check box to vary the number of zebra lines depending on the number
of lines that are printed on the page. When you do not select this check box, the number of zebra lines is
constant and is controlled by the number of lines per page that is set using the SETGRID command.

SET COLUMN WIDTH

The Set Column Width option accesses the Insert SETCOLWIDTH Command dialog. Use this dialog to specify
column width information and then insert the column width command at the current cursor position.

This field appears on the Insert SetColWidth Command dialog:
Column Width

Enter the width to use for each column. The value is entered in "current units".

SET WIDOW/ORPHAN CONTROL

The Set Widow/Orphan Control option accesses the Insert SETSKIP Command dialog, allowing you to specify a
Widow/Orphan command at the current cursor position.

These fields appear on the Insert SETSKIP Command dialog:
Printer Control Code (PCC)

Enter a string of any length. If the beginning of a line matches this string then the associated skip action will
occur. The string remains as part of the printable data.
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Pre-Skip
Enter either the number of lines to skip or a key to be assigned later by SETVFU.

Print-Action

Select true to print the record, false if you do not want to print the record.

Post-Skip
Enter either the number of lines to skip or a key to be assigned later by SETVFU.

Bottom of Form (BOF)

When a value is entered in this dialog a skip to next page (before print) will occur when the number of
remaining lines on the page after pre-skip is less than this number. The number of lines per page is defined by
the SETGRID command.

Top of Form (TOF)
Enter a line number other than O to force that line to be the target line for the top of the form, regardless of the
pre-skip.

Buttons

This box displays all of the linked frame information you have created. Use the buttons available to the right of
the box to change, add, and delete linked frame information as follows:

Delete Use this button to remove selected information from the box.

Insert Use this button to insert the values defined in the Insert SETSKIP
Command fields.

Replace Use this button to replace the currently selected value with information
changed in Insert SETSKIP Command fields.

Append Use this button to insert the current information in the Insert SETSKIP
Command fields.

SET LINKED FRAMES MODE

The Set Linked Frames Mode option accesses the Insert SETLKF Command dialog, allowing you to define a
collection of rectangular frames on a page into which text or graphics can be placed.

These fields appear on the Insert SETLKF Command dialog:
Horizontal

Enter the horizontal coordinates of the top left corner of the new linked frame relative to the current origin (top left
or bottom left) of the page. Units of measure are the currently set values.

Vertical

Enter the vertical coordinates of the top left corner of the new linked frame relative to the current origin (top left or
bottom left) of the page. Units of measure are the currently set values.

Width

Enter the value for the width of the new linked frame.
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Height

Enter the value for the height of the new linked frame.
Rotate

Enter the degree of rotation for the new linked frame.
Comment

Use this field for comments.

Buttons

This box displays all of the linked frame information you have created. Use the buttons available to the right of the
box to change, add, and delete linked frame information as follows:

Delete Remove selected information from the box.
Insert Insert the values defined in the position, size, and rotation fields.
Replace Replace the currently selected value with information changed in the position, size,

and rotation fields.

Append Insert the current information in the position, size, and rotation fields at the end of
the listed values.

GO TO NEXT FRAME

The Go to Next Frame option accesses the Insert NEWFRAME Command dialog, allowing you to start placing
elements in the next available frame.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

GO TO SPECIFIED FRAME

The Go to Specified Frame option accesses the Insert GOTOFRAME Command dialog, allowing you to start placing
elements in a specific frame.

This field appears on the Insert GOTOFRAME Command dialog:

Frame number

Enter the number of the frame to access.

INITIALIZE OMR CODE FOR MAILER

The initialize OMR Code for Mailer option accesses the Insert OMRINIT Command dialog, which initializes OMR
code processing. An OMR code is a sequence of small vertical bars used to drive an automated mailing system.

These fields appear on the Insert OMRINIT Command dialog:

Plex

Enter one of:
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/F OMR code is intended on front pages
/B OMR code is intended on back pages
Feed Count

Enter one of these values:

1-255 feed envelope after that number of pages
0 no feed for the next pages
Fold Count
Enter one of these values:
1-255 intermediate fold after that number of pages
0 no intermediate fold for the next pages
Annexes

Enter a value. Each power of 2 component of the inserted integer represents a bar intended to trigger an
insertion or a side action.
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Page Marking

The Smart Editor produces these options when Page Marking is selected from the Smart Editor menu

Insert Image Draw Path (rounded corners) Move X and Y Position
Insert Segment Draw PDF417 Barcode Set Indentation (for SHP)
Insert Text Draw MaxiCode Barcode Cancel Clipping Area
Insert Text on Path Draw DataMatrix Barcode Save Secondary Print Position
Insert Distorted Text Draw Aztec Barcode Insert RUN (VIPP® or PostScript)
Insert Table Draw QRCode Barcode Insert RUNDD (Decomposed Docs)
Insert Table Row Draw USPS 4-State Barcode Insert RUNTIF (Multi-page TIFF)
Draw Box/Circle/Ellipse Draw Linear Numeric Barcode Set Ignore BadTiffs Option
Draw Polygon Fill OMR Grid Set Reverse Mode Option
Draw DDG Charts (bar/curve/pie/ Draw Cut Marks Set TIFF Orientation Option
Pareto/radar)
Draw Path Set Params (DDG, FILLOMR,

Format... )

INSERT IMAGE

The Insert Image option accesses the Insert ICALL Command dialog. Use this dialog to specify image information
and then insert the image command at the current cursor position.

After you perform this task in Line mode, the image displays on the image tab in the Resource Notebook section of
VI Design Pro's window.

These fields appear on the Insert ICALL Command dialog:
File Name

Enter the name of the image to insert, or use Browse to access the Please choose the file to load window and select
the image to insert. Use Preview to see a graphical representation of the selected image.

Scale Factor (%)

Enter the percentage to resize the image on the page (for example, 100 indicatesl 00 percent). This allows you to
make the image larger or smaller proportionally.

Rotation Degrees (+ is CCW)

Enter the degree to turn the image. When you enter a positive number, the image is turned counterclockwise; when
you enter a negative number, the image is turned clockwise.

Use Alignment

Check the Use Alignment box to select alignment criteria for the image. When you check this box, the Alignment
field is enabled.
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Alignment

Use this box to select the position at which to align the image. This field is only enabled when you check the Use
Alignment box. These options are currently available:

0 Top Left

1 Top Right

2 Top Center

10 Bottom Left
11 Bottom Right
12 Bottom Center
20 Center Left

21 Center Right
22 Center Center

Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis position for the image. When you check this box,
the X Position field is enabled.

Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position. This position is
relative to the last primary horizontal position (defined in the last MOVETO or the current frame). This generates a
MOVEHR command.

X Position

Enter the position on the X axis (horizontal) at which to place the image. This field is enabled when you check the
Specify X Position, Specify Relative X Position, or Specify X+Y Position box.

Dot Leading GEPKey
Enter the GEPKey description.

The GEP keys used for the dot leading function are a subset of the full GEP key list (as used in other dialogs like
DRAWB). The dot-leading subset of GEP keys excludes the full-color GEP keys and only includes those that are line-
style (solid, dashed, or bold).

Specify X + Y Position

Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
image. When you check this box, the X Position and the Y Position fields are enabled.

Position

Enter the position on the Y axis (vertical) at which to place the image. This field is enabled when you check Specify
X+Y Position.
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INSERT SEGMENT

The Insert Segment option accesses the Insert SCALL dialog. Use this dialog to specify information to use for the
segment and then insert the segment command at the current cursor position.

After you perform this task, a .seg tab is created for the segment in the Resource Notebook section of VI Design
Pro's window.

When the Insert SCALL Command dialog is accessed the accessible fields vary according to the Encapsulation
method selected. When Use FCALL is selected only the X, Y, and X+Y positions may be specified for the selected File
Name.

These fields appear on the Insert SCALL Command dialog:
File Name

Enter the name of the segment file to insert, or use Browse to access the Please choose the file to load window and
select the segment to insert. Use Preview to see a graphical representation of the selected segment. Refer to the
VIPP® Language Reference Manual for information about options available for use when inserting PDF files.

Specify Scale Factor

Check the Specify Scale Factor box to resize the segment on the page. When you check this box, the Horizontal
and Vertical Scale (%) fields are enabled.

Horizontal Scale( %)

Enter the percentage to resize the horizontal dimension of the segment (for example, 100 indicates 100 percent).
This allows you to make the segment larger or smaller. To ensure that the segment is scaled proportionally enter the
same value for both the Horizontal and Vertical scales.

Vertical Scale( %)

Enter the percentage to resize the vertical dimension of the segment (for example, 100 indicates 100 percent). This
allows you to make the segment larger or smaller. To ensure that the segment is scaled proportionally enter the
same value for both the Horizontal and Vertical scales.

Specify Rotation
Check the Specify Rotation box to specify rotation degrees.
Rotation Degrees (+ is CCW)

Enter the degree to turn the segment. When you enter a positive number, the image is turned counterclockwise;
when you enter a negative number, the image is turned clockwise.

Use Alignment
Check the Use Alignment box to choose the position at which the segment will be aligned.
Alignment

Use the drop-down list to select the position at which to align the segment. These options are currently available:

0 Top Left
1 Top Right
2 Top Center
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10 Bottom Left
11 Bottom Right
12 Bottom Center
20 Center Left

21 Center Right
22 Center Center

Use Resource Caching

Check the Use Resource Caching box to enable Resource Caching. Enabling this option also activates the Use Fit-
in Box option.

Use Fit in box Option

Select the Use Fit in box Option box to enable the Fit-in Box option. Enabling this box activates the Alignment,
Extra Alignment, Box Width, Box Height, and Rotation Degrees (within box) fields.

Extra Alignment

Select the Extra Alignment option to use the following options. These options are only available when the Use Fit
in box option is selected:

None

Fill in box Use this option to scale the image isomorphically so that it fills
the entire box. When the width/height ratios of the box and the
image differ, the part of the image that falls outside of the box is
cropped. In this case the alignment options are used to choose
which part of the image (corners, left, right, top, bottom, or
center) is kept visible in the box.

Stretch in box Use this option to scale the image anamorphically so that it fills
the entire box. When the width/height ratios of the box and the
image differ, the image is stretched either vertically or
horizontally. In this case the alignment options are useless.

Box Width

Enter the box width using currently defined units of measurement.
Box Height

Enter the box height using currently defined units of measurement.
Rotation Degrees (within box)

Select the degrees of rotation to use for the segment within the box.
Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis position for the segment. This is the same as
placing an x MOVEH command before the SCALL or FCALL command. When you check this box, the X Position field
is enabled.
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Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position for the segment. This
is the same as placing an x MOVEHR command before the SCALL or FCALL command. When you check this box, the
X Position field is enabled.

X Position

Enter the position on the X axis (horizontal) at which to place the segment. This field is enabled when you check the
Specify X Position, Specify Relative X Position, or the Specify X+Y Position box.

Dot Leading GEPKey
Enter the GEPKey description.

The GEP keys used for the dot leading function are a subset of the full GEP key list (as used in other dialogs like
DRAWB). The dot-leading subset of GEP keys excludes the full-color GEP keys and only includes those that are line-
style (solid, dashed, or bold).

Specify X + Y Position

Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
image. This is the same as placing an x y MOVEH command before the SCALL or FCALL command. When you check
this box, the X Position and the Y Position fields are enabled.

Y Position

Enter the position on the Y axis (vertical) at which to place the segment. This field is enabled when you check the
Specify X+Y Position box.

Encapsulation

Use the buttons to select the method used to place this segment, either SCALL (encapsulated) or FCALL (not
encapsulated).

Use SCALL (segment will not produce side effects)

Select this button to use SCALL to place the segment. SCALL images the segment on the current page, placing the
origin (0,0) of the segment at the secondary print position. SCALL is encapsulated, meaning that it has no side
effect and that the current print positions remain unchanged. To print paragraphs down the page, use FCALL.

Use FCALL (segment can produce side effects)

Select this button to use FCALL to place the segment. FCALL executes a segment using the current context such as
font, print or position. FCALL is not encapsulated and may cause side effects.

INSERT TEXT

The Insert Text option accesses the Insert a Show String Command dialog. Use this dialog to specify text string
information and then insert the text string command at the current cursor position.

The title and options available on the Insert a Show String Command window vary depending upon the selected
command. The dialog shown here is a composite of all command types, boxes will be greyed out when they are not
applicable to the command type selected.

These fields appear on the Insert a Show String Command dialog:

Command Type
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Select the button that corresponds to the type of text string command to enter. This table describes the options
enabled for each choice:

WHEN THIS COMMAND TYPE IS CHOSEN: THESE FIELDS ARE ENABLED:

Regular Command (SHL) — Allows you to use a basic String to Show

text stri d.
ext string comman Print Position (Main or Secondary)

Text Alignment (Left or Top, Right or Bottom, Center, or
Justified)

Specify X Position, Specify Relative X Position, or
Specify X+Y Position

Use GEPkey/Rotation (SHX) — Allows you to specify String to Show
Graphic Element Property (GEP) key and rotation

information for the text string command. Print Position (Main)

Rotation (degrees)
Color Type

GEP key

Color

Pattern

Text Alignment (Left or Top, Right or Bottom, Center,
XYcenter (ucase), or XY Center (lcase))

Specify X Position, Specify Relative X Position, or
Specify X+Y Position

Use Font/Color Switching (SHMF) — Allows you to String to Show
specify font and color switching information for the

text string command. Print Position (Main or Secondary)

Specify Column Width
Column Width
Vertically Set Latin Text

Text Alignment (Left or Top, Right or Bottom, Center,
Justified, or Decimal Point)

SHMF/SHP Alignment Options (None, Fit in width,
Stretch in width)

Specify X Position, Specify Relative X Position, or
Specify X+Y Position
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WHEN THIS COMMAND TYPE IS CHOSEN: THESE FIELDS ARE ENABLED:

Use Word Wrap/Multi Strings (SHP) — Allows you to String to Show
specify word wrap and m ulti string information for the

text string command. Print Position (Main or Secondary)

Specify Column Width

Column Width

Use Text-In-Box Option

Box Width

Box Height

Line Spacing

Word Wrapping and Alignment
Vertically Set Latin Text

SHP Vertical Alignment

Text Alignment (Left or Top, Right or Bottom, Center,
Justified, Right-align Last Line, Center Last Line, or
Justify All Lines)

SHMF/SHP Alignment Options (None, Fit in width,
Stretch in width, Wrap and Fit in width, Wrap and
Stretch in width)

SHP Alignment Options (Strip Blanks, Treat Newline
Characters as Spaces, Allow Wrapping on Hyphen
characters)

Specify X Position, Specify Relative X Position, or
Specify X+Y Position

Truncate Strings to Column Width (SHT) — Allows you | String to Show
to automatically truncate text strings to the width of

the columns. Print Position (Main or Secondary)

Specify Column Width

Column Width

Word Wrapping and Alignment
Vertically Set Latin Text

Text Alignment (Left or Top, Right or Bottom, Center, or
Justified)

Specify X Position, Specify Relative X Position, or
Specify X+Y Position

String to Show

Enter the text to insert. In general, there are not restrictions on the values you enter in this field. However,
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parentheses must be used in sets (for example, each opening parenthesis must have a matching closing
parenthesis). Multiple strings must be entered in the format [(string1) (string2)].

Alternatively, place the cursor in the "String to Show" box and right-click to display options that will list DataBase
field names, Variables defined with SETVAR in your application, System-Defined variables or Date and Time built-in
variables. Select the variable to enter as the text string.

Print Position

Select the button that represents the print position at which to align the text string:

Main align the text string at the main (SHL) print position.

Secondary align the text string at the secondary (SH) print position.

Rotation (degrees)

Enter the degree by which to turn the image. When you enter a positive number, the image is turned
counterclockwise; when you enter a negative number, the image is turned clockwise.

Color Type
Select either GEPKey or Color/Pattern from the drop-down list.
GEP key

This box is enabled when Color Type = GEPKey. Use this box to select the Graphic Element Property (GEP) key to
use. The box on the right side of this field displays the GEPkey or Color and Pattern that you selected. The list
includes all of the GEP keys currently available for use.

Color

This box is enabled when Color Type = Color/Pattern. Use this box to select the Colorkey to use. The box on the right
side of this field displays the Color that you selected. The list includes all of the Colorkeys currently available for use.

Pattern

This box is enabled when Color Type = Color/Pattern. Use this box to select the PATkey to use. The box on the right
side of this field displays the Color and Pattern that you selected. The list includes all of the PATkeys currently
available for use.

Specify Column Width

Check the Specify Column Width box to enter the column width information for the text string. When you check
this box, the Column Width field is enabled.

Column Width
Enter the width to use for each column. This field is only enabled when you check the Specify Column Width box.
Use Text-In-Box Option

This selection is only available when the command type "Use Word Wrap/Multi Strings” is selected. When this
option is selected, the box width, box height and line spacing fields are enabled.

Box Width
Enter the width of the box into which text will be placed.

Box Height
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Enter the height of the box into which text will be placed.
Line Spacing

Enter the line spacing value to use for the Text-In-Box option.
Word Wrapping and Alignment

Select one of the following options:

e Original Rules (default)

e Wrap down (Asian rules)

e  Wrap Up (Asian rules)

e Wrap Up and Hanging Punctuation (Asian rules)

e Hanging Punctuation (Asian rules)

e Apply transform on each line (Arabic rules)

e Apply transform on each line and use different font for non-Arabic characters (Arabic rules)
e Apply transform on each line and replace European digits with Hindi digits (Arabic rules)
Vertically Set Latin Text

Select one of the following options:

e Disable Latin Text Processing (default)

e Set Horizontal-in-Vertical

e Set Rotated 90 Degrees Clockwise

¢ Set Conversion

e Set Conversion and Horizontal-in-Vertical

e Set Conversion and 90 Degrees Clockwise

SHP Vertical Alignment

Use this box to define the SHP vertical alignment, options are:
e Top (default)

e Bottom

e Vertical Center

Text Alignment

Text alignment options vary with the selected command type. Select the button that represents the text alignment

for the text string:

Left or Top Align the text on the left or top margin.

Right or Bottom Align the text on the right or bottom margin.
Center Center the text.

Justified Align the text on the left and the right margin.
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Decimal point Align the text on the decimal point (only available for use with an
SHMF command).

Right-align Last Line Right align the last line of the text string.

XYcenter (ucase) Center the text on the X (horizontal) and Y (vertical) axis in uppercase
text.

Center Last Line Center the last line of the text string.

XYcenter (lcase) Center the text on the X (horizontal) and Y (vertical) axis in lowercase
text.

Justify All lines Justify all of the lines of text.

SHMF/SHP Alignment Options

Select the button that represents the extra alignment option to use. These options are only available when the Use
Font/Color Switching, or Use Word Wrap/Multi Strings option is selected:

NONE

Fit in width

When this option is enabled the current font will be
scaled on the horizontal axis so that the printed string
fits into the current column width.

Stretch in width

When this option is enabled the current font will be
scaled on the horizontal axis so that the printed string
entirely fills the current column width.

Wrap and Fit in width

When this option is enabled the current font will wrap
in the text box as well as being scaled on the horizontal
axis so that the printed string fits into the current
column width.

Wrap and Stretch in width

When this option is enabled the current font will wrap
in the text box as well as being scaled on the horizontal
axis so that the printed string entirely fills the current
column width.

SHP Alignment Options

Select the button that represents the extra alignment option to use. These options are only available when the Use
Font/Color Switching, or Use Word Wrap/Multi Strings option is selected:

Specify X Position

Strip Blanks

When this option is enabled the leading and trailing
blanks are stripped from delimited fields.

Treat Newline Characters as Spaces

When this option is enabled newline characters will be
treated as spaces.

Allow wrapping on Hyphen character

When this option is enabled line wrapping can occur at
a Hyphen character.
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Check the Specify X Position box to enter the X (horizontal) axis position for the text only. When you check this
box, the X Position field is enabled. This generates a MOVEH command before the SHx commands.

Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position. This position is
relative to the last primary horizontal position (defined in the last MOVETO or the current frame). This generates a
MOVEHR command.

Dot Leading GEPKey
Enter the GEPKey description.

The GEP keys used for the dot leading function are a subset of the full GEP key list (as used in other dialogs like
DRAWB). The dot-leading subset of GEP keys excludes the full-color GEP keys and only includes those that are line-
style (solid, dashed, or bold).

X Position

Enter the position on the X axis (horizontal) at which to place the text. This field is enabled when you check the
Specify X Position or the Specify X + Y Position box.

Specify X + Y Position

Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
image. When you check this box, the X Position and the Y Position fields are enabled. This generates a MOVE
command.

Y Position

Enter the position on the Y axis (vertical) at which to place the text. This field is enabled when you check the Specify
X +Y Position box.

INSERT TEXT ON PATH

The Insert Text on Path option accesses the Insert SHPATH Command dialog. Use this option to define the offset
and alignment for text that will print along a path. Refer to Draw Path for information about defining the path on
which the text is placed.

These fields appear on the Insert SHPATH Command dialog:
Display Text

Enter the text that will be paced on the path.

Baseline Offset

Enter the value, in current units, of the distance between the baseline of the text and the path. The value can be
positive or negative.

Path Offset

Enter the value, in current units, of the distance between the beginning of the path and the start of the text.
Text Start

Enter the beginning text string.

Text End

176 Xerox® FreeFlow® VI Design Pro Software User Guide



Smart Editor

Enter the ending text string.
Alignment

Choose one of the following alignment options:

0 Align at Start of Path

1 Align at End of Path

2 Align on Center of Path
3 Justify Along Entire Path

INSERT DISTORTED TEXT

The Insert Distorted Text option accesses the Insert SHPIT Command dialog. Use this option to print distorted
text into a quadrilateral shape. The distorted text will fill / take the shape of the quadrilateral frame. The text may
or may not have a drop shadow effect applied. The quadrilateral itself may also be drawn by coding an additional
DRAWPOL.

These fields appear on the Insert SHPIT Command dialog:
Display Text

Enter the text that will be distorted.

Upper Left X

Enter the position on the X axis (horizontal) at which to place the upper left point of the quadrilateral.

Upper Left Y

Enter the position on the Y axis (vertical) at which to place the upper left point of the quadrilateral.

Lower Left X

Enter the position on the X axis (horizontal) at which to place the lower left point of the quadrilateral.

Lower Left Y

Enter the position on the Y axis (vertical) at which to place the lower left point of the quadrilateral. Enter the
position on the Y axis (vertical) at which to place the lower left point of the quadrilateral.

Upper Right X

Enter the position on the X axis (horizontal) at which to place the upper right point of the quadrilateral.

Upper Right Y

Enter the position on the Y axis (vertical) at which to place the upper right point of the quadrilateral.

Lower Right X

Enter the position on the X axis (horizontal) at which to place the lower right point of the quadrilateral.

Lower Right Y

Enter the position on the Y axis (vertical) at which to place the lower right point of the quadrilateral.
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Text Color Type
Choose Color/Pattern, or GEPKey.

GEPKey
This field is enabled when the Text Color Type is GEPKey. Choose the required GEPKey from the drop-down list.

Color

This field is enabled when the Text Color Type is Color/Pattern. Choose the required color from the drop-down
list.

Pattern

This field is enabled when the Text Color Type is Color/Pattern. Choose the required pattern from the menu.

Use Shadow Color

Click on Use Shadow Color when a drop shadow is to be added to the text.

X offset

Enter the horizontal offset value (in current units) for the drop shadow.

Y offset

Enter the vertical offset value (in current units) for the drop shadow.

Shadow Color Type
Choose Color/Pattern or GEPKey.

GEPKey
This field is enabled when the Shadow Color Type is GEPKey. Choose the required GEPKey from the menu.

Color

This field is enabled when the Shadow Color Type is Color/Pattern. Choose the required color from the menu.

Pattern

This field is enabled when the Shadow Color Type is Color/Pattern. Choose the required pattern from the menu.

Use mirroring

To use the mirroring option, select the check box for Use mirroring.

Rotation

Choose from the following:
e None
e 90 degrees
e 180 degrees
e 270 degrees
Fitting

Choose from the following:
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e None
e Fitin width
e Stretch in Width

Alignment
o left
e right
e center

INSERT TABLE

The Insert Table option accesses the Insert BEGINTABLE Command dialog. Use this dialog to specify the
information to use to define and insert a table at the current cursor position.

These fields appear on the Insert BEGINTABLE Command dialog:
/Width
Enable this check box in order to enter the width, in current units, of the table.
Height Parameters
Specify Height
Enable this check box in order to enter values, in current units, for the height and maximum height of the table.
/Height
Enter the height of the table in current units.
/MaxHeight
Enter the maximum height allowed for the table in current units.
Margin Parameters
/Margins

Enable this check box to enter the following values:

Top

Enter the distance from the center of the page to the top of the table in current units.

Bottom

Enter the distance from the center of the page to the bottom of the table in current units.

Left

Enter the distance from the center of the page to the left side of the table in current units.

Right

Enter the distance from the center of the page to the right side of the table in current units.

CellStroke Parameters
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CellStroke Parameters are applied to all of the cells in the table.

/CellStroke

Enable this check box to enter cell stroke parameters.

All

Enable this check box to select cell stroke parameters for all sides of the table's cells. The parameter is selected
from a drop-down list.

Top

Enable this check box to select cell stroke parameters for the top of the table's cells. The parameter is selected
from a drop-down list.

Bottom

Enable this check box to select cell stroke parameters for the bottom of the table's cells. The parameter is
selected from a drop-down list.

Left

Enable this check box to select cell stroke parameters for the left side of the table's cells. The parameter is
selected from a drop-down list.

Right

Enable this check box to select cell stroke parameters for right side of the table's cells. The parameter is selected
from a drop-down list.

/CellFill

Enable this check box to assign a fill to the cells in the table. The default is "no color”.
[TextAtt

Enable this check box to assign text attributes to the cells in the table.

/Align

Enable this check box to align text in the cells in the table.

/TableStroke

Enable this check box to enter table stroke values for the table, a sample of the GEPKey is shown on the right side
of the window.

INSERT TABLE ROW

The Insert Table Row option accesses the Insert SHROW Command Dialog. Use this dialog to specify the
information to use to define and insert a table row at the current cursor position.

These fields appear on the Insert SHROW Command dialog:

A Cell Commands display window is at the top of the dialog. It displays each of the command definitions that
make up the table row. Changes are made using the buttons to the right of the window:

Insert

When the Cell Commands window is empty the Insert button is used to create a new cell command. When all
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cell parameter settings have been defined, clicking this button inserts the new cell command into the Cell
Commands window.

When a cell command definition appears in the Cell Commands window and is selected or highlighted, clicking
the Insert button creates and inserts a new cell command after or below the selected cell.

Append

This button creates and inserts a new cell command at the bottom of the current list of cell commands shown in
the Cell Commands window, regardless of which cell has been selected or highlighted.

Remove

Any cell command that has been created and inserted into the Cell Commands window can be deleted by
highlighting the command and pressing the Remove button

Update
The Update button is used to modify the currently selected (highlighted) cell command based on the parameter

settings in effect, as shown below the Cell Commands window.

/Width

Enable this check box in order to enter the width, in current units, of the current cell being defined or selected, or
highlighted in the Cell Commands window.

Height Parameters
Specify Height

Enable this check box in order to enter values, in current units, for the height and maximum height of the cell.

/Height

Enter the height of the cell in current units.

/MaxHeight

Enter the maximum height allowed for the cell in current units.

FixHeight

Enter a fixed height allowed for the cell in current units. If /Height and / MaxHeight are also specified, they will
take precedence if the value for / FixHeight does not fall between those values.

If placed in the default cell parameters array it defines a fixed height for the row (all cells) unless surrounded in
a subsequent cell by /Height or /MaxHeight.

[/FixHeight prevents the evaluation of the size of the text for each cell, thus providing better performance.
[FixHeight is recommended when the size of the text is predictable and not expected to overflow the box.

/Margin Parameters

The values entered are the distance rom the center of the current cell being defined or selected (highlighted) in the
Cell Commands window.

/Margins

Enable this check box to enter the following values:

Top
Enter the distance from the center of the current cell being defined or selected (highlighted) in the Cell
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Commands window to the top of the table in current units.

Bottom
Enter the distance from the center of the current cell being defined or selected (highlighted) in the Cell
Commands window to the bottom of the table in current units.

Left
Enter the distance from the center of the current cell being defined or selected (highlighted) in the Cell
Commands window to the left side of the table in current units.

Right

Enter the distance from the center of the current cell being defined or selected (highlighted) in the Cell
Commands window to the right side of the table in current units.

CellStroke Parameters

CellStroke Parameters are applied to the current cell being defined or selected (highlighted) in the Cell Commands
window.

[CellStroke

Enable this check box to enter cell stroke parameters.

All
Enable this check box to select cell stroke parameters for all sides of the current cell being defined or selected
(highlighted) in the Cell Commands window. The parameter is selected from a drop-down list.

Top
Enable this check box to select cell stroke parameters for the top of the current cell being defined or selected
(highlighted) in the Cell Commands window. The parameter is selected from a drop-down list.

Bottom
Enable this check box to select cell stroke parameters for the bottom of the current cell being defined or selected
(highlighted) in the Cell Commands window. The parameter is selected from a drop-down list.

Left
Enable this check box to select cell stroke parameters for the left side of the current cell being defined or
selected (highlighted) in the Cell Commands window. The parameter is selected from a drop-down list.

Right

Enable this check box to select cell stroke parameters for right side of the current cell being defined or selected
(highlighted) in the Cell Commands window. The parameter is selected from a drop-down list.

/CellFill

Enable this check box to assign a fill to the cells in the current cell being defined or selected (highlighted) in the Cell
Commands window. The default is "no color”.

[TextAtt

Enable this check box to assign text attributes to the cells in the current cell being defined or selected (highlighted)
in the Cell Commands window.
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/Align

Enable this check box to align text in the cells in the current cell being defined or selected (highlighted) in the Cell
Commands window.

/CellText

Enable this check box to define a text string to be shown in side the current cell being defined or selected
(highlighted) in the Cell Commands window.

/Celllmage

Enable this check box to insert an image into the current cell being defined or selected (highlighted) in the Cell
Commands window. The Browse button to the right of this selection allows you to browse for the image file.

INSERT VOID PANTOGRAPH

The Insert Void Pantograph option accesses the SETPAT command dialog. Use this dialog to specify the
information to use to define void pantograph special effect.

In the SETPAT command dialog, use the fields to create the void pantograph pattern.
PatternName

This field displays the name the pattern, for example /VPO1.

TextPixelFrequency

This field defines the frequency and size of the pixel for the text that needs to be hidden.

BackgroundPixelFrequency

This field defines the frequency and size of the pixel for the background patch that hides the text.

Color1

It is highly recommended that you use this option to select the pixel background.

Color2

This option allows you to select the pixel color and text background color.

Htrans

This value is for the horizontal transformation of background pixels.

Vtrans

This value is for the vertical transformation of background pixels.

Rotate

This value specifies the rotation of background pixels through a given angle.

DRAW BOX/CIRCLE/ELLIPSE

The Draw Box/Circle/Ellipse option accesses the Insert a Draw Box/Circle/Ellipse Command dialog. Use this dialog to
specify the information to use to insert one or more boxes, circles, or ellipses, then insert the command at the
current cursor position.

Xerox® FreeFlow® VI Design Pro Software User Guide 183



Smart Editor

These fields appear on the Insert a Draw Box/Circle/Ellipse Command dialog:

Draw Box

To enter a draw box command, click Draw Box.

Draw Circle/Ellipse

To draw a circle or an ellipse, click Draw Circle/Ellipse.
When you select the Draw Circle/Ellipse option, the Rounded Corners, Multiple Boxes, Repeat Count, Y
displacement, and X displacement features are disabled.

You can edit one type of command, and switch to any other command using the dialog, for example change
DRAWB to DRAWC. Save the results.

X Position

Enter the position on the X horizontal axis where you want to place the box.

Y Position

Enter the position on the Y vertical axis where you want to place the box.

Width

Enter the value to use for the box width.

Height

Enter the value to use for the box height.

Color Type
To select GEPKey or Color/Pattern, use the list.

GEPkey

This option is enabled when the Color Type is set to GEPKey. To select the Graphic Element Property (GEP) key to
use, select the check box for GEPkey. The box on the right side of this field displays the color that you selected.
The list includes all of the GEP keys available for use.

Color

This option is enabled when the Color Type is set to Color/Pattern. To select a color to use when drawing a box,
select the check box for Color. The box on the right side of this field displays the color and pattern that you
selected. The list includes all of the Colorkeys available for use.

Pattern

This option is enabled when the Color Type is set to Color/Pattern. To select a pattern to use when drawing a
box, select the check box for Pattern. The box on the right side of this field displays the pattern and color that
you selected. The list includes all of the PATkeys available for use.

Rounded Corners

When the corners of the box are rounded, select the check box for Rounded Corners. When you select this
option, the Radius field is enabled.

Text Flow

When text is not added to the defined shape, select None. When you want to place text in, on, or around the
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defined shape, select one of the other options. The default option is None. Select one of the following options:
e None
e Text on Path
e Text Inside Shape
e Text Outside Shape
Radius
Specify the radius to use for the corners of the box. This field is enabled only when you select the Rounded
Corners option.

Multiple Boxes

To draw more than one box, select the check box for Multiple Boxes. When you select the Multiple Boxes
option, the Repeat Count, X displacement, and Y displacement fields are enabled.

Repeat Count

Enter the value for the number of boxes to draw. This field is enabled only when you select the Multiple Boxes
option.

X Displacement

Enter the value to add to the X horizontal position of the previous box to provide the position of the next box to
be drawn.

Y Displacement

Enter the value to add to the Y vertical position of the previous box to provide the position of the next box to be
drawn.

DRAW POLYGON

The Draw Polygon option accesses the Insert a DRAWPOL Command dialog. Use this dialog to specify the
information to use to create a polygon and then insert the command at the current cursor position. This command
supports strings as parameters, allowing you to use DBM variables as parameters.

These fields appear on the Insert a DRAWPOL Command dialog:

X Coordinate

Enter the subsequent horizontal positions (Xpos) of the polygon, in conjunction with its corresponding vertical
position (Ypos).

Y Coordinate

Enter the subsequent vertical positions (Ypos) of the polygon, in conjunction with its corresponding horizontal
position (Xpos).

Round All to Integers

Click the Round All to Integers button to round values to integers.

Color Type

Use the menu to select either GEPKey or Color/Pattern.
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GEPkey

This box is enabled when the Color Type is set to GEPKey. Use this box to select the Graphic Element Property
(GEP) key to use. The box on the right side of this field displays the color that you selected. The list includes all
of the GEP keys currently available for use.

Color

This box is enabled when the Color Type is set to Color/Pattern. Use this box to select a color to use when
drawing a box. The box on the right side of this field displays the color (and pattern) that you selected. The list
includes all of the Colorkeys currently available for use.

Pattern

This box is enabled when the Color Type is set to Color/Pattern. Use this box to select a pattern to use when
drawing a box. The box on the right side of this field displays the pattern (and color) that you selected. The list
includes all of the PATkeys currently available for use.

Text Flow

Use these options to define text flow in or around an object:

None no text flow is defined

Text on Path to place text on a path

Text Inside Shape to insert text into an object

Text Outside Shape to wrap text around an object
Buttons

Use the buttons available at the top right of the dialog to delete, insert, replace or append X and Y Coordinates

as follows:

Delete Removes the selected coordinate.

Insert Inserts a new coordinate using the X and Y coordinate fields.

Replace Replaces the currently selected X and Y coordinates with the information entered in the
XCoordinate and YCoordinate fields. In general, use this button to modify existing
coordinates.

Append Inserts new coordinates, using the information entered in the XCoordinate and
YCoordinate fields.

DRAW DDG CHARTS (BAR/CURVE/PIE/PARETO/RADAR)

The Draw DDG Charts (bar/curve/pie/Pareto/radar) option accesses the Insert a Draw Chart Command dialog. Use
this dialog to specify the information to use to create data-driven bar, curve, pie, Pareto, or radar charts and then
insert the chart command at the current cursor position.

These fields appear on the Insert a Draw Chart Command dialog:

Chart Type
Select the button that represents the type of chart to insert:
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Bar insert a bar chart (DRAWBAR)
Curve insert a curve chart (DRAWC RV)
Pie insert a pie chart (DRAWPIE)
Pareto insert a Pareto chart (DRAWPAR)
Radar insert a radar chart (DRAWRDR)

Chart Dimensions:

Width Specify the width to use for the chart. This field is only available for bar,
curve, and Pareto charts.

Height Specify the height to use for the chart. This field is only available for bar,
curve, and Pareto charts.

Radius Specify the radius to use for the chart. This field is only available for pie and
radar charts.

Stack this Chart

Select the Stack this Chart box to produce a stacked bar chart. A [ /Stack true ] statement is placed in the DDG
Parameters box.

Unstack this Chart

Select the Unstack this Chart box to unstack the bar chart. A [ /Stack false ] statement is placed in the DDG
Parameters box.

Use DDG Index

Select the Use DDG Index check box to use the numeric DDG Index for the chart. When you select this check
box, the field to the right of the box is enabled.

This field contains the DDG index value for the chart. Currently, the only supported value is 0. This value is
computed by adding all of the values that are related to the required parameters. Refer to the xgf/demo/
samddg. ps file for a sample of the available DDG codes.

When you select this check box, the Use Label/Value Variable check box and field and the Label and Value boxes
are disabled. This check box is disabled when you select the Use Label/Value Variable check box.

Use Label/Value Variable

Select the Use Label/Value Variable check box to use a variable for the label/value pairs. When you select this
check box, the entry field to the right of this box is enabled.

Use the enabled entry field to enter the variable to associate with the label/value pairs. This variable is used to
change the default value of a given parameter. Specify a number of label/variable pairs for use with a single
variable and then use the variable with the Draw DDG Chart command. Refer to the xgf/demo/samddg.ps
file for a sample of the available DDG codes.

When you select this check box, the Use DDG Index box and field, and the Label and Value boxes are disabled.
This check box is disabled when you select the DDG Index check box.
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Label

Displays the labels that are currently available for use in the chart.

e Use the Insert, Replace, and Append buttons with the information you enter in the Selected Label and
Selected Value fields to create and modify the Label/Value Pairs.

e Use Delete to delete Label/Value Pairs from this box and the Value box.
This box is disabled when you select the DDG Index check box or the Use Label/Value Variable check box.

Value

Displays the values that are available for use in the chart.

e Use the Insert, Replace, and Append buttons with the information you enter in the Selected Label and
Selected Value fields to create and modify the Label/Value Pairs.

e Use Delete to delete Label/Value Pairs from this box and the Label box.
This box is disabled when you check DDG Index or Use Label/Value Variable.

Label/Value Buttons

The Label and Value boxes display all of the Label/Value pairs you have created. Use the buttons available to
the right of these boxes to change, add, and delete Label/Value pairs as follows:

Delete Use this button to remove the selected Label/Value pair from the Label and
Value boxes.
Insert Use this button to insert a Label/Value Pair at the current cursor position in

the Label and Value boxes, using the information entered in the Selected
Label and Selected Value fields.

Replace Use this button to replace the currently selected Label/Value pair in the
Label and Value boxes with the information entered in the Selected Label
and Selected Value fields. In general, use this button to modify an existing
Label/Value pair in the Label and Value boxes.

Append Use this button to insert a Label/Value pair at the end of the list of Label/
Value Pairs in theLabel and Value boxes, using the information entered in
the Selected Label and Selected Value fields.

Selected Label

Enter the label information to use in the chart. Use the Insert, Replace, and Append buttons with the
information you enter in this field and the Selected Value field to create and modify the Label/Value pairs.

Selected Value

Enter the value information to use in the chart. Use the Insert, Replace, and Append buttons with the
information you enter in this field and the Selected Value field to create and modify the Label/Value pairs.

DDG Parameters

Displays the parameter changes that you make on the Edit DDG Parameters dialog. The changes you make
affect the Draw DDG command for the current chart only. You access the Edit DDG Parameters dialog when you
click Edit. Refer to DDG parameters for further information on the fields that display on the Edit DDG
Parameters dialog.
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Edit
Click the Edit button to access the Edit DDG Parameters dialog and make changes to the parameters for this

chart. The changes you make display in the DDG Parameters box and affect the Draw DDG command for the
current chart only.

DDG Line Parameters

For Pareto charts only, displays the parameter changes that you make on the Edit DDG Parameters dialog. The
changes you make affect the Draw DDG command for the current chart only. You access the Edit DDG
Parameters dialog when you click Edit. Refer to DDG parameters for further information on the fields that
display on the Edit DDG Parametersdialog.

j’ Note: When you want the DDG parameters to affect all of the Draw DDG commands, you must specify the
parameter information using the Insert SETPARAMS command dialog, which you access by selecting Set
Params (DDG and Format) from the Page Marking menu.

Specify X Position

Select the Specify X Position check box to enter the X (horizontal) axis position for the chart. When you select
this check box, the X Position field is enabled.

Specify Relative X Position

Select the Specify Relative X Position check box to specify a secondary X (horizontal) axis position. This
position is relative to the last primary horizontal position (defined in the last MOVETO command or the current
frame). This generates a MOVEHR command.

X Position

Enter the position on the X axis (horizontal) at which to place the chart. This field is enabled when you select the
Specify X Position or the Specify X + Y Position check box.

Specify X + Y Position

Select the Specify X + Y Position check box to enter the X (horizontal) axis and the Y (vertical) axis positions for
the chart. When you select this check box, the X Position and the Y Position fields are enabled.

Y Position

Enter the position on the Y axis (vertical) at which to place the chart. This field is enabled when you select the
Specify X + Y Position check box.

DRAW PATH

The Draw Path option accesses the Edit DRAWPATH Command dialog. Use this dialog to specify a path on which
text will be placed.

These fields appear on the Edit DRAWPATH Command dialog:
Origin/Path Points

The Origin Point/Path Point window contains the coordinate information, in current units, that will be included
in the DRAWPATH command options. The values displayed are defined in the X1/Y1, X2/Y2, and X3/Y3 boxes
below.
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Delete
Click the Delete button to delete a highlighted entry from the display window.

Insert

After defining the coordinates in the X1 - Y3 fields described below, click the Insert button to insert the
coordinates.

Replace

Click the Replace button to replace the highlighted entry with the coordinates defined below.

Append
Click the Append button to append the highlighted value in the window to the DRAWPATH command options.

Round All to Integers

Click the Round All to Integers button to round every number, including numbers in the list box and editable
fields, in the dialog to an integer.

Point Type
Select one of these options to enable their respective data entry fields:
Arc To draw a curve.
Line Segment To draw a straight line.
New Path Origin To enter the coordinates for a new path origin.

Radius Value (for DRAWPATHR)

Enter a value in current units when using the DRAWPATHR command. Not used with the DRAWPATH
command.

X1 and Y1

Enter the coordinates for the consecutive point on the line after the origin. When Line Segment has been
selected, this will be the end point of the line.

X2/Y2 and X3/Y3
Enter the coordinates of the consecutive points joining the previous point with a Bezier curve. To close the path
the X3 and Y3 coordinates must be the same as the origin.

Color Type
Choose Color/Pattern to select a color and pattern for the path, or GEPKey to use a predefined GEPkey.

GEPkey

When the Color Type is GEPkey, a list of existing GEPkeys will be available. Use the list to choose the key for the
application.

Color

Use the menu to choose the color of the path being defined. Choose No Color when the path should not be
visible, as when it will be used for text placement.
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Pattern

Use the menu to choose the pattern of the path being defined. Choose No Pattern when the path should not be
visible, as when it will be used for text placement.

Text Flow

Choose where the text will be placed in relation to the path being defined:

None

Text On Path places the text along a line.

Text Inside Shape places the text inside the defined shape.

Text Outside Shape places the text around the outside of the defined shape.

DRAW PATH (ROUNDED CORNERS)

The Draw Path option accesses the Insert DRAWPATHR Command dialog. Use this dialog to specify a path on which
text will be placed.

These fields appear on the Insert DRAWPATHR Command dialog:
Origin/Path Points

The Origin Point/Path Point window contains the coordinate information, in current units, to include in the
DRAWPATH command options. The values displayed are defined in the X1/Y1, X2/Y2, and X3/Y3 fields.

Delete
Click the Delete button to delete a highlighted entry from the display window.

Insert

After defining the coordinates in the X1 - Y3 boxes described below, click the Insert button to insert the
coordinates.

Replace

Click the Replace button to replace the highlighted entry with the coordinates defined below.

Append
Click the Append button to append the highlighted value in the window to the DRAWPATH command options.

Round All to Integers

Clicking the Round All to Integers button rounds every number, including numbers in the list box and editable
fields, in the dialog, to an integer.

Point Type

Select one of these options to enable their respective data entry fields:
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Arc to draw a curve.
Line Segment to draw a straight line.
New Path Origin to enter the coordinates for a new path origin.

Radius Value (for DRAWPATHR)

Enter a value in current units when using the DRAWPATHR command.

X1 and Y1

Enter the coordinates for the consecutive point on the line after the origin. When Line Segment has been
selected, this will be the end point of the line.

X2/Y2 and X3/Y3

Enter the coordinates of the consecutive points joining the previous point with a Bezier curve. To close the path
the X3 and Y3 coordinates must be the same as the origin.

Color Type
Choose Color and Pattern to select a color and pattern for the path, or GEPKey to use a predefined GEPkey.

GEPkey

When the Color Type is GEPkey, a list of existing GEPkeys is available. Use the list to choose the key for the
application.

Color

Use the menu to choose the color of the path being defined. Choose No Color when no path is to be visible, as
when it is used for text placement.

Pattern

Use the menu to choose the pattern of the path being defined. Choose No Pattern when no path is to be
visible, as when it is used for text placement.

Text Flow

Choose where text will be placed in relation to the path being defined:

None

Text On Path Places the text along a line.

Text Inside Shape Places the text inside the defined shape.

Text Outside Shape Places the text around the outside of the defined shape.

DRAW PDF417 BARCODE

The Draw PDF417 Barcode option accesses the Insert a PDF417 Command dialog. Use this dialog to specify the
information to use to create PDF417 barcodes and then insert the barcode command at the current cursor position.

These fields appear on the Insert PDF417 Command dialog:
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Data Display Window

This window contains the information that will be encoded in the PDF417 Barcode.

Data Types
Text

Use this option to enter data in text compaction mode. Allowable characters are:

PRINTABLE CHARACTERS

(\n) new line or line feed
(\r) carriage return
(\t) horizontal tab
(\\) backslash
Byte

Use this option to enter data in byte compaction mode. Encode any 8-bit value from O to 255.
Numeric

Use this option to enter data in numeric compaction mode. Numeric compaction mode should be used to
encode long strings of consecutive numeric digits. Although numeric compaction mode can be invoked at any
digit length, Xerox recommends that it be used when there are 13 or more consecutive digits.

Specify number of Rows

Use this box to optionally specify the number of rows for the barcode.

Rows (3-90)

Enter the number of rows in the barcode. The number must be within the range of 3 to 90.

Specify number of columns

Use this box to optionally specify the number of columns for the barcode.

Columns (1-30)

Enter the number of data columns in the barcode. The value must be within the range of 1 to 30.

Specify Aspect Ratio

Use this box to optionally specify the aspect ratio of the barcode.

Aspect Ratio H

Enter the horizontal aspect ratio of the barcode.

Aspect Ratio W

Enter the vertical aspect ratio of the barcode.

Specify Error Handling level

Use this box to optionally specify the error handling level for the barcode.
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Error Handling level

Enter the error correction/detection level, which must be within the range of 0 to 8, where 0 is the minimum and
8 is the maximum amount of correction. The error level will default to a minimum of two and a maximum of
five depending on the amount of data encoded.

One PDF417 barcode can encode approximately 1850 text characters, 1110 bytes, or 2710 digits at an error
level of 0. For an error level of 8, the limits are approximately 830 text characters, 498 bytes, or 1215 digits.

Truncation

Select True from the menu if you want to allow the barcode to be truncated, False if you do not.

Specify scale or width, rotation, and alignment

Select the Specify scale or width, rotation, and alignment check box to enter these values for the barcode:

Scale (% )/Width

Use the menu to choose to adjust the size of the barcode by entering a scaling percentage or actual width in
current units. Enter either:

e The percentage to resize the image on the page (for example, 100 indicates 100 percent). This allows you
to make the image larger or smaller proportionally.

e A numeric value for a barcode with a fixed width.

Rotation

Enter the degree of rotation for the barcode.

Alignment

Use this field to select the position at which to align the barcode. This field is only enabled when you select the
Specify scale, rotation, and alignment check box. These options are currently available:

0 Top Left

1 Top Right

2 Top Center

10 Bottom Left
1N Bottom Right
12 Bottom Center
20 Center Left

21 Center Right
22 Center Center

Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis position for the chart. When you select this
check box, the X Position field is enabled.
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Specify Relative X Position

Select the Specify Relative X Position check box to specify a secondary X (horizontal) axis position. This
position is relative to the last primary horizontal position defined in the last MOVETO or the current frame. This
generates a MOVEHR command.

X position
Enter the position on the X axis (horizontal) at which to place the chart. This field is enabled when you select
the Specify X Position or the Specify X + Y Position check box.

Specify X + Y Position
Select the Specify X + Y Position check box to enter the X (horizontal) axis and the Y (vertical) axis positions for
the chart. When you check this box, the X Position and the Y Position fields are enabled.

Y position

Enter the position on the Y axis (vertical) at which to place the chart. This field is enabled when you select the
Specify X + Y Position check box.

DRAW MAXICODE BARCODE

The Draw MaxiCode Barcode option accesses the Insert MAXICODE Command dialog. Use this dialog to specify
the information to use to create Maxicode barcodes and then insert the barcode command at the current cursor
position.

These fields appear on the Insert MAXICODE Command dialog:

Message Data

Enter a string that contains the data to be encoded.

Mode

Choose the structure of the barcode data and error correction within the symbol.

2 Creates a US structured carrier message that is used as a destination sortation symbol by
carriers in the shipping industry.

3 Creates an international structured carrier message that is used as a destination sortation
symbol by carriers in the shipping industry.

4 Creates a symbol that encodes information for purposes other than the shipping industry.
Mode 4 encodes a maximum of 93 characters or 138 digits, but it contains less error
correction/detection than mode 5.

5 Creates a symbol that encodes information for purposes other than the shipping industry.
Mode 5 encodes a maximum of 77 characters or 113 digits, but it provides more error
correction/detection than mode 4.

6 Creates a symbol that encodes a message used to program barcode readers (scanners).
Mode 6 encodes a maximum of 93 characters or 138 digits.

Modes 2, 3, 4, and 6 use Enhanced Error Correction (EEC) for the primary message and Standard Error
Correction (SEC) for the secondary message. Mode 5 uses EEC for both the primary and secondary messages.
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Specify scale or width, rotation, and alignment

Check the Specify scale or width, rotation, and alignment box to enter these values for the barcode:

Scale (% )/Width

Use the drop-down list to choose to adjust the size of the barcode by entering a scaling percentage or actual
width in current units. Enter either:

e The percentage to resize the image on the page (for example, 100 indicates 100 percent). This allows you
to make the image larger or smaller proportionally.

e A numeric value for a barcode with a fixed width.

Rotation

Enter the degree of rotation for the barcode.

Alignment

Use this field to select the position at which to align the barcode. This field is only enabled when you check the
Specify scale, rotation, and alignment field. These options are currently available:

0 Top Left

1 Top Right

2 Top Center

10 Bottom Left
11 Bottom Right
12 Bottom Center
20 Center Left

21 Center Right
22 Center Center

Specify optional parameters

Click on the Specify optional parameters field to enable the Position and Total value dialogs. The optional
structured append array is specified if more than one and up to eight Maxicode barcodes are appended in a
structured format.

Position Value (1-8)

Enter the position of the barcode.

Total Value (1-8)

Enter the total number of appended barcodes.

Specify X Position

Select the Specify X Position check box to enter the X (horizontal) axis position for the chart. When you check
this box, the X Position field is enabled.
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Specify Relative X Position

Select the Specify Relative X Position check box to specify a secondary X (horizontal) axis position. This
position is relative to the last primary horizontal position, defined in the last MOVETO or the current frame).
This generates a MOVEHR command.

X Position
Enter the position on the X axis (horizontal) at which to place the chart. This field is enabled when you select
the Specify X Position or the Specify X + Y Position check box.

Specify X + Y Position
Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
chart. When you check this box, the X Position and the Y Position check boxes are enabled.

Y Position

Enter the position on the Y axis (verti cal) at which to place the chart. This field is enabled when you check the
Specify X + Y Position box.

DRAW DATAMATRIX BARCODE

The Draw DataMatrix Barcode option accesses the Insert DATAMATRIX Command dialog. Use this dialog to specify
the information to use to create a DataMatrix barcode and then insert the barcode command at the current cursor
position.

j’ Note: DataMatrix is ECC 200 compliant.

These fields appear on the Insert DATAMATRIX Command dialog:
Text Data

Enter a string that contains the data to be encoded.

Specify scale or width, rotation, and alignment

Check the Specify scale or width, rotation, and alignment box to enter these values for the barcode:

Scale( % )/Width

Use the drop-down list to choose to adjust the size of the barcode by entering a scaling percentage or actual
width in current units. Enter either:

e The percentage to resize the image on the page (for example, 100 indicates100 percent). This allows you to
make the image larger or smaller proportionally.

e A numeric value for a barcode with a fixed width.

Rotation

Enter the degree of rotation for the barcode.

Alignment

Use this box to select the position at which to align the barcode. This field is only enabled when you check the
Specify scale, rotation, and alignment box. These options are currently available:
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0 Top Left

1 Top Right

2 Top Center

10 Bottom Left

1N Bottom Right

12 Bottom Center

20 Center Left

21 Center Right

22 Center Center
Specify Rectangle

Check the Specify rectangle box to specify a rectangle.

Rectangle

Choose one of the following:

0 Always produces a square symbol

1 Produces a rectangular symbol if data fits

Specify encoding
Check the Specify encoding box to specify encoding method, which is presently limited to ASCII.

Encoding

Choose encoding method.

Specify Minimum Dimension (number of rows)

Check the Specify Minimum Dimension box to specify the minimum barcode dimension.
MinDim

Enter the minimum value of the barcode dimensions. The default is 1.
Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis position for the chart. When you check this
box, the X Position field is enabled.

Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position. This position is
relative to the last primary horizontal position (defined in the last MOVETO or the current frame). This generates
a MOVEHR command.
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X Position
Enter the position on the X axis (horizontal) at which to place the chart. This field is enabled when you check the
Specify X Position or the Specify X + Y Position box.

Specify X + Y Position
Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
chart. When you check this box, the X Position and the Y Position fields are enabled.

Y Position

Enter the position on the Y axis (vertical) at which to place the chart. This field is enabled when you check the
Specify X + Y Position box.

DRAW AZTEC BARCODE

The Draw AZTEC Barcode option accesses the Insert AZTEC Command dialog. Use this dialog to specify the
information to use to create an Aztec barcode, then insert the barcode command at the current cursor position.

These fields appear on the Insert AZTEC Command dialog:

Text Data

Enter a string that contains the data to be encoded.

Specify scale or width, rotation, and alignment
To enter values for the barcode, select the check box for Specify scale or width, rotation, and alignment,
then select the following options, as needed:

Scale (% )/Width

To adjust the size of the barcode, enter a scaling percentage or enter the width in current units. Use the drop-
down list to choose one of the options:

e The percentage to resize the image on the page, for example, 100 indicates 100 % . This option allows you
to make the image larger or smaller proportionally.

e A numeric value for a barcode with a fixed width.
Alignment

To select the position at which to align the barcode, use this option. This field is enabled only when you select
the check box for Specify scale, rotation, and alignment. The following options are available:

0 Top Left

1 Top Right

2 Top Center

10 Bottom Left
11 Bottom Right
12 Bottom Center
20 Center Left
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21 Center Right

22 Center Center

Specify error level

To specify an error level, select the check box for Specify error level.

ElLevel

To indicate the error level used in this application, enter a value between 0 and 99. The default value is 23.

Specify Minimum Dimension (number of layers)

to specify the number of layers to use in this application, select the check box for Specify Minimum
Dimension (number of layers).

MinDim
To indicate the dimension of the symbol or the number of layers used, enter an integer from 1-3 . The default is
1.

Specify X Position

To enter the X horizontal axis position for the chart, select the check box for Specify X Position. When you
select this option, the X Position field is enabled.

Specify Relative X Position

To specify a secondary X horizontal axis position, select the check box for Specify Relative X Position. This
position is relative to the last primary horizontal position as defined in the last MOVETO or the current frame.
This action generates a MOVEHR command.

X Position

Enter the position on the X horizontal axis where you want to place the chart. This field is enabled when you
select the Specify X Position or the Specify X + Y Position options.

Specify X + Y Position
To enter the X horizontal axis and the Y vertical axis positions for the chart, select the check box for Specify X +

Y Position. When you select the option, the X Position and the Y Position fields are enabled.

Y Position

Enter the position on the Y vertical axis where you want to place the chart. This field is enabled when you select
the Specify X + Y Position option.

DRAW QRCODE BARCODE

The Draw QRCode Barcode option accesses the Insert QRCODE Command dialog. Use this dialog to specify the
information to use to create a QRCode barcode and then insert the barcode command at the current cursor
position.

*

These fields appear on the Insert QRCODE Barcode Command dialog:
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Data Display Window

This window contains the information that will be encoded in the QRCODE Barcode.

Data Types:

Text

Enter a string that contains the text data to be encoded.
The data is encoded at a density of 2 characters per 11 bits. There are 45 allowable characters:

e 10 numeric digits (0-9)

e 26 alphabetic characters (A-2)

e 9symbols (SP,$, %, " + - . /1.2
Byte

Enter a string that contains any data to be encoded.
This mode encodes the 8-bit Latin/Kana character set in accordance with JIS X 0201 (character values 00 to FF
hex) at a density of 8 bits per character.

Kanji Data

Enter a string that contains any Kanji data to be encoded.
The Kanji mode encodes Kanji characters in accordance with the Shift JIS system based on JIS X 0208 at a
density of one two-byte character per 13 bits. The Shift JIS values are shifted from the JIS X 0208 values.

Mixed Data

Enter a string that contains any mixed data to be encoded.
This mode encodes sequences of data in a combination of any of the compaction modes.

Numeric Data

Enter a string that contains any numeric data to be encoded.
This mode encodes data from the decimal digit set (0-9) at a density of 3 data characters per 10 bits.

Data String

Use to enter a Data String.

Specify error handling level

Check the Specify error handling level box to specify an error handling level.

Error Handling Level

Enter a value between 1 and 4 to indicate the error correction/detection level to be used. 1 is the minimum and
4 is the maximum amount of correction. This range corresponds to levels L, M, Q, and H respectively. Level 2, or
M, is the default when an error handling level is not specified.

Specify Structured Append Array
Check the Specify Structured Append Array box to specify the structured append array.

The optional structured append array is used when more than one, and up to 16, QR barcodes are to be
appended in a structured format. The array contains two elements that may be used as defined in the Position
and Count boxes.
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Position Value (1-16)

Enter the position of the barcode within the set of appended barcodes.

Total Value (1-16)

Enter the total number of appended barcodes.

Specify QR Version
Check the Specify QR Version box to specify the QR Version to use.

QR Version (1-40)
The QR version is a number from 1 to 40. If a version number is not specified, the most suitable version will
automatically be determined from the number of encoded data characters and the error handling level.
Use Mask Pattern or Mask Pattern Array

Check the Use Mask Pattern or Mask Pattern Array box to specify the use of a mask pattern or mask array.

Mask Pattern (1-8)

Enter a value between 1 and 8, or an array of numbers, to define the mask pattern or array. 1 is the default.

Use QR Optimum
Check the Use QR Optimum box to enter a QR Optimum value.

QR Optimum

QR Optimum is a performance enhancement parameter. It enables/disables shortcuts in the analysis of mask
patterns. -1 enables the shortcuts, other numbers disable the shortcuts.

Specify scale or width, rotation, and alignment

Check the Specify scale or width, rotation, and alignment box to enter these values for the barcode:

Scale( % )/Width

Use the drop-down list to choose to adjust the size of the barcode by entering a scaling percentage or actual
width in current units. Enter either:

e The percentage to resize the image on the page (for example, 100 indicates100 percent). This allows you to
make the image larger or smaller proportionally.

e A numeric value for a barcode with a fixed width.

Rotation

Enter the degree of rotation for the barcode.

Alignment

Use this box to select the position at which to align the barcode. This field is only enabled when you check the
Specify scale, rotation, and alignment box. These options are currently available:

0 Top Left
1 Top Right
2 Top Center
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10 Bottom Left

11 Bottom Right

12 Bottom Center

20 Center Left

21 Center Right

22 Center Center
Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis position for the chart. When you check this box,
the X Position field is enabled.

Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position. This position is
relative to the last primary horizontal position (defined in the last MOVETO or the current frame). This generates a
MOVEHR command.

X position

Enter the position on the X axis (horizontal) at which to place the chart. This field is enabled when you check the
Specify X Position or the Specify X + Y Position box.

Specify X + Y Position

Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
barcode. When you check this box, the X Position and the Y Position fields are enabled.

Y position

Enter the position on the Y axis (vertical) at which to place the barcode. This field is enabled when you check the
Specify X + Y Position box.

DRAW USPS 4-STATE BARCODE

The Draw USPS 4-State Barcode option accesses the Insert USPS4CB Command dialog. Use this dialog to specify
the information to use to create a USPS 4-State barcode and then insert the barcode command at the current
cursor position.

These fields appear on the Draw USPS4CB Command dialog:
Tracking Data

Enter the tracking data for this application. Tracking data is a 20 digit tracking data string comprised of the
following sub-fields:

e 2-digit Barcode Identifier. The second digit must be O through 4.
e 3-digit Special Services field.
e 6-digit Customer Identifier field.

e 9-digit Sequence Number field.
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Routing Code

Enter the Routing code for this application. Routing Code is the delivery point ZIP code. It can be in any of the 4
forms accepted by the USPS:

() An empty or null string for no ZIP code
(12345) A 5-digit ZIP code

(12345-6789) A 9-digit ZIP+4 code-

(12345-6789 01) An eleven digit ZIP+4 + 2-digit DPC

Specify alignment
Check the Specify alignment box to enter the alignment values.
Alignment

Choose the alignment value from the menu of available options.

0 Top Left

1 Top Right

2 Top Center

10 Bottom Left

11 Bottom Right

12 Bottom Center

20 Center Left

21 Center Right

22 Center Center
Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis for the barcode. When you check this box, the X
Position field is enabled.

Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position. This position is
relative to the last primary horizontal position defined in the last MOVETO or the current frame). This generates a
MOVEHR command.

X position

Enter the position on the X axis (horizontal) at which to place the barcode. This field is enabled when you check the
Specify X Position or the Specify X + Y Position box.

Specify X + Y Position

Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
barcode. When you check this box, the X Position and the Y Position fields are enabled.
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Enter the position on the Y axis (vertical) at which to place the barcode. This field is enabled when you check the

Specify X + Y Position box.

DRAW LINEAR NUMERIC BARCODE

The Draw Linear Numeric Barcode option accesses the Insert DRAWBC Command dialog. Use this dialog to specify
the information to use to create a Linear Numeric barcode and then insert the barcode command at the current
cursor position.

These fields appear on the Insert DRAWBC Command dialog:

Numeric Data

Enter the numeric data to include in the barcode.

Barcode Type

Choose:

JUPCA (11 digits)
JUPCE (7 digits)
JEANS (5 digits)
JEANS (7 digits)
JEAN13 (12 digits)
/DATABAR

Use Scale

Enable the Use Scale Option to enter the percentage by which you want to increase (positive value) or decrease
(negative value) the Horizontal and/or Vertical dimension of the barcode.

Print Option
Select the print option from the drop-down list. Choose:
0 Do not print human-readable digits
10 Print human-readable digits
Databar Type

Select the Databar Type from the drop-down list.

0 GS1 Databar Omnidirectional

1 GS1 Databar Truncated

2 GS1 Databar Stacked

3 GS1 Databar Stacked Omnidirectional
4 GS1 Databar Limited
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GS1 Databar Expanded

GS1 Databar Expanded Stacked

f Note: Databar options 0—-4 can include 13 or 14 digits. When 14 digits are entered, the 14th digit is

considered a placeholder and is replaced with the calculated check digit. Data entered for Databar options 5
and 6 require the exact number of digits expected for the preceding Application Identifier. The last digit can
be any number because it is considered a placeholder and is replaced with the calculated check digit.

Segments per Row

This option is available only when Databar Type 6 (GS1 Databar Expanded Stacked) is selected. Supported
values are 2, 4, 6,8, 10,12, 14,16, 18, and 20.

FILL OMR GRID

The Fill OMR Grid option accesses the Insert FILLOMR Command dialog. Use this dialog to specify the information
to fill an Optical Mark Reading (OMR) grid, and insert the FILLOMR command at the current cursor position.

Response String

FILLOMR Parameters

FILLOMR parameters are listed here, refer to FILLOMR parameters in the SETPARAMS description for more
information:

/OMRMap
/OMRDir
/OMRHskip
/OMRVskip
/OMRHdisp
/OMRVdisp
/OMRMode
/OMRSlugFont
/OMRSlugSize
/OMRSlugChar
/OMRWriteResp

All the parameters have built-in defaults that can be altered using SETPARAMS. The FILLOMR array can be
provided with only those parameters that differ from the defaults.

Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis position for the grid. When you check this box,
the X Position field is enabled.

Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position. This position is
relative to the last primary horizontal position, defined in the last MOVETO or the current frame. This generates
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a MOVEHR command.

X position
Enter the position on the X axis (horizontal) at which to place the grid. This field is enabled when you check the
Specify X Position or the Specify X + Y Position box.

Specify X + Y Position
Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
grid. When you select this check box, the X Position and the Y Position fields are enabled.

Y position

Enter the position on the Y axis (vertical) at which to place the grid. This field is enabled when you select the
Specify X + Y Position check box.

DRAW CUT MARKS

The Draw Cut Marks option accesses the Insert CUTMARK Command dialog. Use this dialog to specify print marks
intended to guide trimming of Multi-Up layouts or areas falling off the finished page.

These fields appear on the Insert CUTMARK Command dialog:

X Position

Enter the position on the X axis (horizontal) at which to place the cut mark.

Y Position

Enter the position on the Y axis (vertical) at which to place the cut mark.

Length

Enter the length of the mark in current units.

Width

Enter the width of the lines in current units.

Type
Choose the type of cut mark from a drop-down list:
0 Top left corner
1 Bottom left corner
2 Bottom right corner
3 Top right corner
4 Vertical down
5 Vertical up
6 Vertical center
7 Horizontal right

Xerox® FreeFlow® VI Design Pro Software User Guide 207



Smart Editor

8 Horizontal left

9 Horizontal center

SET PARAMS (DDG, FILLOMR, FORMAT...)

The Set Params (DDG, FILLOMR, Format...) option accesses the Insert SETPARAMS Command dialog. Use tabs at
the top of the dialog to select one of these parameter types:

e DDG Parameters

e FILLOMR parameters

e Miscellaneous Parameters

e Format Parameters

e Layout Parameters

The dialogs for each parameter type provide a means to set unique parameter values.

Each of the Insert SETPARAMS Command dialogs include a Defaults button at the bottom of the dialog. Clicking
this button resets all of the parameters on the dialog to their default value.

DDG Parameters

Use the DDG parameters dialog to specify information to use to set the parameters for all subsequent data-driven
graphic charts and insert the SETPARAMS command at the current cursor position.

The following fields appear on the DDG Parameters tab, in the Insert SETPARAMS Command dialog.
e To view all DDG parameters, use the slider control.

e To enable a field, select the check box.

e Todisable a field, clear the check box.

3D

To enter values for the /3D parameter at the cursor position, use the 3D field. To specify 3D capabilities for the
DDG, select an option:

true The DDG is three-dimensional.
false The DDG is not three-dimensional.
3DAngle

to enter values for the /3DAngle parameter at the cursor position, select the check box for 3DAngle. In the
3DANgle field, enter the number value for the angle to use for the 3D DDG. The default value is 0.3.

0-1 Show the right side of the bars.

1-2 Show the left side of the bars.

3DThickness

To enter values for the /3DThickness parameter at the cursor position, use this field. In the 3DThickness field,
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enter the number value for the thickness to use for the 3D DDG. The numeric value indicates the percentage of
the radius, the percentage of the bar width, or the percentage of the width. The default value is 0.35.

BarSpace

To enter values for the /BarSpace parameter at the cursor position, use this field. The number is the value for the
amount of space between the bars. The numeric value indicates the percentage of the bar width. The default
value is 0.4.

BarSpace?

To enter values for the /BarSpace2 parameter at the cursor position, use the BarSpace? field. The values set the
spacing between a cluster of bars. The possible values are the same as the values for BarSpace.

BGColor

To enter values for the /BGColor parameter at the cursor position, use the BGColor field. To select the color and
pattern to use for the background of a bar or curve chart, from the list, select a color.

e The first box contains a list of all available Colorkeys.
e The second box contains a list of all available pattern keys.
e The box to the right of this field displays the color and pattern selected.
e The default value is White.
e For a transparent setting, use null instead of a Colorkey.
BGLineColor

To enter values for the /BGLineColor parameter at the cursor position, use the BGLineColor fields. To select the
color and pattern to use for the horizontal background scale lines of a bar or curve chart, from the list, select a
color and pattern.

e The first box contains a list of all available Colorkeys.
e The second box contains a list of all available pattern keys.
e The box to the right of the field displays the color and pattern selected.

e Specify the color for horizontal background scale lines. The default is white.
BurstList

To enter values for the /BurstList parameter at the cursor position, use the BurstList field. Enter the list of labels
to be burst when /SliceBurst is not 0.

ChartDir
To enter values for the /ChartDir parameter at the cursor position, use the CharDir field.

To define the chart direction for DRAWBAR and DRAWCRYV charts, select one of the following values:

0 Bottom-up

1 Left-to-right
2 Top-down

3 Right-to-left
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ChartOrder

to enter values for the /ChartOrder parameter at the cursor position, use the ChartOrder field.

Use the ChartOrder fields with the DRAWBAR and DRAWCRYV commands. Enter one of the following values:

0 Print items from left to right or top to bottom
1 Print items from right to left or bottom to top
CheckLabelOverlap

To enter values for the /CheckLabelOverlap parameter at the cursor position, use the CheckLabelOverlap field.
The ChecklLabelOverlap field enables or disables overlap control for pie charts. The default, true, prevents label
overlap.

ClusterMode

To enter values for the /ClusterMode parameter at the cursor position, use the ClusterMode field. The field sets
the presentation mode for a cluster of bars: O is for stacked bars. 1 is for side-by-side bars.

ColorCycle

To enter values for the /ColorCycle parameter at the cursor position, set the color cycle mode.

Select one of the following values for the color cycle mode:

0 Automatic (most appropriate)
1 Cycle on item (cluster)
2 Cycle on entire chart

Color Table (Edit Below)

To view the Color Table box and to enable the Color Table section located at the bottom right of the dialog,
select the check box for Color Table (Edit Below). This box contains a list of the Colorkeys that are selected for
the Color Table for the chart. This information is for display only, you do not select the Color Table items from
this box.

To add, modify, or delete Color Table items, select the Color Table (Edit Below), then use the Color Table
section to make changes to the Color Table.

e When you make changes in the Color Table section of this dialog then click Save, the box contains the
changes.

e When you make changes in the Color Table section of this dialog but do not click Save, to reset the Color
Table list, clear then select this check box. This action disables the Color Table section, resets the Color Table
list to the items that were last saved, then enables the Color Table list again.

For a transparent setting, use null instead of a Colorkey.

DrawMode

To enter values for the /DrawMode parameter at the cursor position, use the DrawMode field. DrawMode
determines how the radar area of a chart is filled. Enter one of the following values:

210 Xerox® FreeFlow® VI Design Pro Software User Guide



Smart Editor

0 Stroke the radar area (default)
1 Fill the radar area
ExtraSpace

To enter values for the /ExtraSpace parameter at the cursor position, use the ExtraSpace field. Enter the value for
the amount of top and bottom space to use with the DDG when you select O in the FitSpace field. Enter a
numeric value to indicate a percentage of the font size. The default value is 1.

FitSpace

To enter values for the /FitSpace parameter at the cursor position, use the FitSpace field. Select the option to
use to fit the DDG in the available space on the page:

0 Use the fixed size of the DDG.

1 Fit the DDG in the Record Processing Entry (RPE) space.

2 Cancel the 3D setting when the radius is less than the maximum size.

4 Use the 3D setting when the radius is greater than the maximum size.

8 Adjust the 3D thickness to allow for the DDG to fit on the page.
HalfPie

To enter values for the /HalfPie parameter at the cursor position, use the HalfPie field. To select the display
criterion for a pie chart, use the list box, then select a value:

-1 Display the bottom half of the pie chart.

0 Display the entire pie chart.

1 Display the top half of the pie chart.
KeepRatio

To enter values for the /KeepRatio parameter at the cursor position, use the KeepRatio field. To specify 3D
thickness based on the width of the bar, use the list box, then an option:

true Base the 3D thickness on the width of the bar.
false Base the 3D thickness on the page width.
LabelColw

To enter values for the /LabelColw parameter at the cursor position, use the LabelColw field. Enter the column
width as a percentage of the chart width for label wrapping on horizontal charts.

LabelDashColor

To enter values for the /LabelDashColor parameter at the cursor position, use the LabelDashColor fields. To select
the color and pattern to use for the label dashes for a pie chart, use the lists.
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e The first box contains a list of all available Colorkeys.
e The second box contains a list of all available pattern keys.

e The box to the right of the field displays the color and pattern selected.
LabelDashWidth

To enter values for the /LabelDashWidth parameter at the cursor position, use the LabelDashWidth field. Enter
the value for the width to use for the dash contained in the labels on the DDG. To indicate the width in points,
enter a numeric value. The default value is 0.5.

LabelOffset

To enter values for the /LabelOffset parameter at the cursor position, use the LabelOffset field. Enter the offset
value to use for the label on the data-driven graphic (DDG). This value indicates the offset of the labels from the
pie chart when SpotSize=0. To indicate a percentage of the radius, enter a numeric value. The default value is
0.1.

LineDash
To enter values for the /LineDash parameter at the cursor position, use the LineDash field. To define the line
dash when using DRAWCRYV, specify the size in points of consecutive solid and blank dash segments.

MaxVal
To enter values for the /MaxVal parameter at the cursor position, use the MaxVal field. Specify a maximum value
for fixed scaling.

MinVal
To enter values for the /MinVal parameter at the cursor position, use the MinVal field. Specify a minimum value
for fixed scaling.

MergeValue

To enter values for the /MergeValue parameter at the cursor position, use the MergeValue field. To combine
values that have equal labels, use the list box, then select an option:

true Combine values that have equal labels.
false Do not combine values that have equal labels.
OffsetValue

To enter values for the /OffsetValue parameter at the cursor position, use the OffsetValue field.

OriLine
to enter values for the /OriLine parameter at the cursor position, use the Oriline field.

When the parameter is set to true, a line is added from the origin of the graph at 0,0 to the first point. The
default value is false.

PlotSymbol

to enter values for the /PlotSymbol parameter at the cursor position, use the PlotSymbol field. For a single plot
symbol specification for character, size, and color specification, or an array of plot symbol specifications, enter
null.
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PrintLabel

To enter values for the /PrintLabel parameter at the cursor position, use the PrintLabel field.

To print labels on bar and curve charts, select one of the following values:

0 Do not print a label.

1 Print labels below the X axis.

2 Print labels at the ends of the bars.
PrintScale

To enter values for the /PrintScale parameter at the cursor position, use the PrintScale field.

To enable the field, select the check box. To print a scale on bar and curve charts, use the list box, then select an
option:

O/false Do not print a scale.

1/true Print a scale at the bottom left of a chart.

2 Print a scale at the top right of a chart.
PrintValue

To enter values for the /PrintValue parameter at the cursor position, use the PrintValue field. To print values on
bar and curve charts and percentages on pie charts, use the list box:

true Print values or percentages.
false Do not print values or percentages.
ScaleStep

To enable entry of values for the /ScaleStep parameter at the cursor position, use the ScaleStep box.
ShadeAdjust
When 3D is enabled, the ShadeAdjust option enables shading control.

The possible values for the /ShadeAdjust parameter are as follows:

[-1<0] Lighter shading: The smaller the number, the lighter the shading.

0 No shading.

[>0 1] Darker shading: The larger the number, the darker the shading.
SliceBurst

To enter values for the /SliceBurst parameter at the cursor position, use the SliceBurst field. Enter the value for
the burst to use for the slice lines or bar borders on the DDG. To indicate a percentage of the radius, enter a
numeric value. A value of O specifies no burst.

SliceSepColor

To enter values for the /SliceSepColor parameter at the cursor position, use the the SliceSepColor field. To select
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the color and pattern to use for the slice or bar borders, use the lists:

e The first box contains a list of all available Colorkeys.

e The second box contains a list of all available pattern keys.

e The box to the right of the field displays the color and pattern selected.

e The default value is black.
SliceSepWidth

To enter values for the /SliceSepWidth parameter at the cursor position, use the SliceSepWidth field. Enter the
value for the width to use for the slice lines or bar borders on the DDG. To indicate the width in points, enter a
numeric value. The default value is 0.5.

SpotLabels

To enter values for the /SpotLabels parameter at the cursor position, use the SpotLabels field. When DRAWBAR
is fed with multiple values for items, enter the labels associated with spot colors.

SpotOffset

To enter values for the /SpotOffset parameter at the cursor position, use the SpotOffset field.

Enter the value for the horizontal offset of the spots from the center of the graphic. The numeric value indicates
the percentage of the radius or the percentage of the width.

e A positive number offsets to the right and top.
e A negative number offsets to the left and bottom.
e The default value is 1.4.
SpotSize
To enter values for the /SpotSize parameter at the cursor position, use the SpotSize field.

Enter the value for the size of the spots. To indicate a percentage of the font size, enter a numeric value. A value
of O specifies no spots.

Stack
To enter values for the /Stack parameter at the cursor position, use the Stack field. Select one of the following:
true The bar chart is stacked.
false The bar chart is not stacked.
ValueColor

Use this field to enter a /ValueColor parameter at the cursor position.

XFloat
To enter values for the /XFloat parameter at the cursor position, use the XFloat field. Select:
true The X axis is floating.
false The X axis is always at 0.

The following are DDG Code options.
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Use DDG Code
To enable the DDG code list box and DDG codes, select the check box for Use DDG Code. To select the DDG
code shortcuts for the DDG parameters to use, use the list box. The total of the parameters that you select
accumulate in the Use DDG Code field, based on the selections that you make and save.

DDG Code Buttons

To the left of the DDG code box, select an available option:

Show/Edit To display the list box that contains the DDG code information, click
Show/Edit. Use this box to select the DDG codes to use.

Save To save the DDG code information that you have selected in the list
box, click Save. After you click Save, the parameters that you selected
appear in the Use DDG Code field, and the list box no longer appears.
To redisplay the list box, click Show/Edit.

Clear To clear all the selections from the DDG Code list box, click Clear. To
clear just one selection, click an item.

Cancel To cancel any changes that you made in the DDG Code list box, click
Cancel. When you click Cancel, the DDG Code list box no longer
appears. When you access the list box again, the changes that you
made no longer appear.

DDG Code Samples

To display a screen with sample charts, click DDG Code Samples. To view samples of the various styles
available, enable one of the following chart types:

e Bar

e Curve

e Pie

e Pareto
e Radar

Click the type of chart you want to insert. The DDGCode dialog updates the code related to the selected
sample.

Color Table

The Color Table panel at the bottom of the screen is activated when you select the check box for Color Table.
The Color Table option displays all the Colorkeys that are selected for the Color Table command. When you
select the check box for Color Table, the option is enabled. To add, modify, or delete Colorkeys from the Color
Table, select the check box for Color Table, then use the Colorkey field and the Color Table buttons.

e When you make changes in the Color Table panel and click Save, the Color Table panel is updated with the
changes.

e When changes are made in the Color Table panel and you have not clicked Save, reset the Color Table box to
the Colorkeys that were last saved. Click, then reclick the Color Table panel.
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Colorkey

To select the Colorkey to add to the Color Table, use the unlabeled box below the Color Table Window. The box
on the right side of the Colorkey field displays the color that you selected. The list includes all of the Colorkeys
that are available currently. To create and modify the Color Table selections, use the Insert, Replace, and Append
buttons with the information that you enter in the Colorkey field.

Pattern

To select the pattern key to use, use this unlabeled box below the Colorkey box . The list includes all of the
pattern keys that are available currently.

Color Table Buttons

Select the following options, as needed:

Delete To remove the selected Colorkey from the Color Table panel, select
Delete.
Insert To insert the Colorkey that is selected in the Colorkey field at the

current cursor position in the Color Table panel, select Insert.

Replace To replace the Colorkey that is selected in the Color Table panel with
the Colorkey that is selected in the Colorkey field, select Replace.

Append To insert the Colorkey that is selected in the Colorkey field at the end of
the list of Colorkeys in the Color Table panel, select Append.

Save To save the Colorkeys that are included currently in the Color Table
panel, click Save. When you click Save, the Color Table panel is updated
with the new information.

Clear To clear all of the Colorkeys from the Color Table panel, select Clear.
When you perform this task without clicking Save, you can reset the
Color Table panel to the Colorkeys that were last saved. Click, then
reclick the Color Table panel.

FILLOMR parameters

Use the FILLOMR parameters dialog to specify information to use to set the parameters for all subsequent Optical
Mark Reading grids then insert the SETPARAMS command at the current cursor position.

These fields appear on the Insert SETPARAMS Command dialog (FILLOMR Parameters tab). Use the
corresponding check boxes to enable the fields.

OMRMap

Use this field to enter values for the /OMRMap parameter at the cursor position.

Indicates which characters make up the OMR grid and in which order. The default is
(ABCDEFGHIJKLMNOPQRSTUVWXYZ).

f Note: Every character in the response string must be a character in the map string.

OMRDir

Use this field to enter values for the /OMRDir parameter at the cursor position.
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OMRHskip
The direction of the OMRMap string characters in the OMR grid.
/H OMR map string characters are shown horizontally (and form each row of) the OMR grid.
N OMR map string characters are shown vertically (and form each row of) the OMR grid.
(default).

Use this field to enter values for the /OMRHskip parameter at the cursor position.
Indicates the number of columns skipped, the default is O.

OMRVskip

Use this field to enter values for the /OMRVskip parameter at the cursor position.
Indicates the number of rows skipped, the default is O.

OMRHdisp

Use this field to enter values for the /OMRHdisp parameter at the cursor position.

The number of columns per inch (CPI) in the OMR grid, the default is 6.
OMRVdisp

Use this field to enter values for the /OMRVdisp parameter at the cursor position.

The number of lines/rows per inch (LPI) in the OMR grid, the default is 6.
OMRMode

Use /OMRMode to slug characters, digits, or numeric strings.

Possible values:

0 Character mapping (default) Slugs each character of the response string that
must be made up of characters from OMRMap.

1 Binary decimal mapping Slugs each digit of a numeric string into appropriate
binary bits 1, 2, 4 and 8. OMRMap must be set to
(1248) or (8421).

2 Binary litho mapping Slugs a numeric string (up to 1,073,741,823) into
appropriate binary bits 1, 2, 4, 8, 16, 32, etc. up to
536,870,912.
OMRSlugFont

Use this field to enter values for the /OMRSlugFont parameter at the cursor position.
The OMR font used to fill in the OMR grid bubbles, the default is /XOMR.
OMRSlugSize

Use this field to enter values for the /OMRSlugSize parameter at the cursor position.
The size in points of the OMR font used to fill in the OMR grid bubbles, the default is 12 points.
OMRSlugChar

Use this field to enter values for the /OMRSlugChar parameter at the cursor position.
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The shape of the OMR grid bubbles are:

(A) square

(B) vertical rectangle

Q) horizontal rectangle

(D) circle (default)

(B) vertical oval

(F) vertical condensed oval
(G) horizontal oval

(H) horizontal condensed oval

fo Note: The letters A through H in the OMRSlugChar window are not related to the response or map strings.
They are used to choose a shape that is defined in the /XOMR font.
OMRWriteResp

Use this field to enter values for the /OMRWriteResp parameter at the cursor position. This indicates how
response boxes are filled.

OMRConfig
true the response boxes must be filled in with the response string
false no response box (default)

Use OMRConfig to define the configuration of the OMR code for OMRINIT/OMRSHOW.

Miscellaneous Parameters

Use the Miscellaneous Parameters dialog box to set parameters that are not included on the other SETPARAMS
tabs, then insert the SETPARAMS command at the current cursor position.

These fields appear on the Insert SETPARAMS Command dialog, on the Miscellaneous Parameters tab. To enable
the fields, select the check boxes. To disable the fields, clear the check boxes.

BookletMismatch
Use this field to enter values for the /BookletMismatch parameter at the cursor position.

Sets the action when the number of booklet pages do not match the PagesPerBooklet parameter:

0 Ignore mismatch (default)

1 Add pages until the booklet pages match

2 Abort and send VI Compose error message

3 Add pages with the current form until the number of pages match
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PagesPerBooklet

Use this field to enter values for the /PagesPerBooklet parameter at the cursor position.
The number of pages in a booklet. The default is 1.

Caching

Use this field to enter values for the /Caching parameter at the cursor position.

Set this parameter using one of these values. If no value is selected, caching occurs according to Adobe
specifications.

0 No caching

1 Caching through CACHE and PRECACHE.

2 Caching through CACHE, PRECACHE, and FSHOW.

11 Caching through CACHE and PRECACHE.

12 Caching through CACHE, PRECACHE, and FSHOW (default).
ClearSubst

Use this field to enter values for the /ClearSubst parameter at the cursor position. Possible values:

0 Best fit behavior (default):
If Clear is present, apply:

On VDP/VIE/VDEP, desktop printer substitute text pattern. On production printer (FFPS, ...
) without Clear, ignore.

On FFPS/Normalizer, preserve or ignore, depending if Clear is present or not. On VIeC,

ignore
1 Same as 0. but preserve on VIeC. The PDF is intended for printing.
2 Ignore on all devices except when Clear is present.
3 Substitute text pattern on all devices except when Clear is present.
4 Preserve on all devices.
5 Ignore on all devices even when Clear is present.
6 Substitute text pattern on all devices even when Clear is present.

CJKunitcount

Use this field to enter values for the /CJKunitcount parameter at the cursor position. A single-byte character is one
unit, a multi-byte character is two units.

Set the parameter using one of these values:
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false Each multi-byte character is one unit (default).

true Applies only to SETRCD, SETPCD, GETFIELD, RPE.

MixPlexCount

Use this field to enter values for the /MixPlexCount parameter at the cursor position.
Use to indicate the number of pages to delay simplex mode. The default is O.
CachelCALL

Use this field to enter values for the /CacheICALL parameter at the cursor position.
Setting the value to true enables caching transparently when using ICALL.
TransWeight

Use this field to enter values for the /TransWeight parameter at the cursor position.

The TransWeight parameter improves black pixels on the soft edges of transparent areas. These values are
available:

1 Eliminate black pixels (default).

<1 Reduce black pixels.

0 Keep black pixel (current behavior).
ImageDefRes

Use this field enter a value for the /ImageDefRes parameter at the cursor position.

The default for this Image Rendition parameter is 300.

Interpolate

Use this field to enter values for the /Interpolate parameter at the cursor position.

Use to request image interpolation (enhanced quality) on color images. The default is false.
This parameter can impact job performance. Use with CACHE to minimize job impact.
Page Range

Use this field to enter values for the /PageRange parameter at the cursor position.

Use to define the PAGERANGE behavior after the last page in the range prints. The default is O.

0 Abort the job with an error message (warning)
1 Flush the data file and end without error
2 Process the data file to the end, but do not image pages after the last page in
the range.
LCDSmode

Use this field to enter values for the /LCDSmode parameter at the cursor position.
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Use this setting to facilitate migration from LCDS to VIPP®. The default is false. When set to true, the SETFORM and
SETBFORM commands apply all forms to the physical pages instead of the logical pages. The PROCESSDJDE
command automatically sets this value to true.

MediaSubst
Use this field to enter values for the /MediaSubst parameter at the cursor position.

Use this setting to define device-specific actions for SETMEDIA requirements. Use on devices that do not support
media selection through SETPAGEDEVICE.

MUPduplex
Use this field to enter values for the /MUPduplex parameter at the cursor position.

Use this setting to define logical page positions for printing multiple images on each side of a print.

0 (Default) logical page positions are identical on the front and on the back.

1 Logical page positions on the back side are computed so that they physically face their
counterparts on the front. Logical pages must fit entirely on the physical page, either
through explicit specification of the logical page sizes, or by scaling down.

ResolvePath

Use this field to enter values for the /ResolvePath parameter at the cursor position. Use to set the path resolution
mode for fileref in PIF links.

0 (Default) Do not resolve the file reference. Leave it as provided.

1 Try to resolve the file reference in the current VIPP® context. If it exists, replace it with the
full path. If not, leave it as provided.

PDFCropping
Use this field to enter values for the / PDFCropping parameter at the cursor position.
Possible values:

e /CropBox (Default)

e /TrimBox

e /ArtBox

e /BleedBox
e /MediaBox

DotsPerModule

Use this field to enter values for the /DotsPerModule parameter for a PDF417 barcode at the cursor position.
The number of dots per bar or space in the barcode. The default is 3.

RowHeight

Use this field to enter values for the /RowHeight parameter for a PDF417 barcode at the cursor position.

The height of one row in the barcode. If the error level is given low amounts of encoded data, the default value is 4.
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If the error level is appropriate for the amount of data encoded, the default is 3.

AlignChar

Use this field to enter values for the /AlignChar parameter at the cursor position.

Enter the alternate align character for SHMF align=4. Possible values: any ASCII code (0-255)

TextFit

Use this field to enter values for the /TextFit parameter at the cursor position.

Possible values:

0 Anamorphic scale (horizontal only)
1 Isomorphic scale (horizontal and vertical)
SHPWrap

Use this field to enter values for the wrapping characters for the SHP command, in addition to the space. The

charx value is always a single character.

LocalToUTF8

Use this field to choose a value for the /LocalToUTF8 text encoding parameter.

Possible values:

0 None (default)
1 ISO-8859-2/Windows-1252
2 IDSO-8859-2 (Latin-2)
3 Windows-1250 (Latin-2)
4 ISO-8859-9 (Turkish)
5 Windows-1251 (Cyrillic)
6 Windows-1258 (Vietnamese)
7 Windows CP-874/TIS-6
8 Windows CP-866 (Cyrillic)
9 IDSO-8859-15 (Latin-9)
10 Mac OS Roman
11 Windows-1256 (Arabic)
12 Windows-1255 (Hebrew)
13 UTF-16 (Unicode)
AmPm

Use this field to enter values for the /AmPm parameter at the cursor position.
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The AmPm value in an unchecked box is the default value set in xgf.def. The value in a checked box is the value of
the SETPARAMS command currently being edited. Use the check box to activate the default value, or to enter a new
value.

DaylightSaving
Use this field to enter values for the /DaylightSaving parameter at the cursor position.

The DaylightSaving value in an unchecked box is the default value set in xgf.def. The value in a checked box is the
value of the SETPARAMS command currently being edited. Use the check box to activate the default value, or to
enter a new value.

DaysLong
Use this field to enter values for the /DaysLong parameter at the cursor position.

The DaysLong (unabbreviated day names) value in an unchecked box is the default value set in xgf.def. The value
in a checked box is the value of the SETPARAMS command currently being edited. Use the check box to activate
the default value, or to enter a new value.

DaysShort
Use this field to enter values for the /DaysShort parameter at the cursor position.

The DaysShort (abbreviated day names) value in an unchecked box is the default value set in xgf.def. The value in
a checked box is the value of the SETPARAMS command currently being edited. Use the check box to activate the
default value, or to enter a new value.

DefaultDate
Use this field to enter values for the /DefaultDate parameter at the cursor position.

The DefaultDate value in an unchecked box is the default value set in xgf.def. The value in a checked box is the
value of the SETPARAMS command currently being edited. Use the check box to activate the default value, or to
enter a new value.

DefinedDate

Use this field to enter values for the /DefinedDate parameter at the cursor position.
Use this box to define a specific date.

MonthslLong

Use this field to enter values for the /MonthsLong parameter at the cursor position.

The MonthsLong (unabbreviated month names) value in an unchecked box is the default value set in xgf.def. The
value in a checked box is the value of the SETPARAMS command currently being edited. Use the check box to
activate the default value, or to enter a new value.

MonthsShort
Use this field to enter values for the /MonthsShort parameter at the cursor position.

The MonthsShort (abbreviated month names) value in an unchecked box is the default value set in xgf.def. The
value in a checked box is the value of the SETPARAMS command currently being edited. Use the check box to
activate the default value, or to enter a new value.

TimeZone
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Use this field to enter values for the /TimeZone parameter at the cursor position.

The TimeZone value in an unchecked box is the default value set in xgf.def. The value in a checked box is the value
of the SETPARAMS command currently being edited. Use the check box to activate the default value, or to enter a
new value.

TimeZoneName
Use this field to enter values for the /TimeZoneName parameter at the cursor position.

The TimeZoneName value in an unchecked box is the default value set in xgf.def. The value in a checked box is the
value of the SETPARAMS command currently being edited. Use the check box to activate the default value, or to
enter a new value.

Format Parameters

Use the Format Parameters tab to set all subsequent format parameters then insert the SETPARAMS command at
the current cursor position.

These fields appear on the Insert SETPARAMS Command dialog (Format Parameters tab):

Bar Chart/Curve Chart Label Format

Enable the Bar Chart/Curve Chart Label Format check box to enter or select the format string to use for Bar
Chart/Curve Chart Labels (/Format).

Pie Chart Percentage Format

Enable the Pie Chart Percentage Format check box to enter or select the format string to use for Pie Chart
Percentages (/FormatPC).

Insert Format Parameters

The window at the center of the Format Parameters dialog provides a checklist consisting of the following
parameters:

/DecimalPoint Decimal delimiter (input string)
/NSign Negative Sign (input string)
/FDecimalPoint Decimal delimiter (format string)
/FNSign Negative sign (format string)

/FPSign Positive sign (format string)
/FPunctuation Punctuation delimiter (format string)
/FDigit Digit delimiter (format string)
/FLZDigit Leading zero delimiter (format string)

To insert a parameter definition at the current cursor position, place a check mark in the box next to the desired
parameters, and then click OK.

To change a character definition, highlight the Meta Character Name, enter the desired character in the
Character window below the parameter list, then click Update Selection.
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Character

This field contains the symbol that will be used when defining an input or format string. When you enter a new
character here and press Update Selection the definition of the selected Meta Code character is updated to
include the new character and its decimal value.

The buttons used to set and update the Meta Character characters are:

Reset All Use this button to reset all the parameters shown in the box to their original settings.
Reset Selection Use this button to reset the selected parameter in the box to its original setting.
Update Selection Use this button to update the selected parameter in the box to use the

character you have entered in the Character field.

Layout Parameters

Use the Layout parameters dialog to specify information to use to set the parameters for all subsequent layout
options, then insert the SETPARAMS command at the current cursor position.

The parameters on this screen are used in Multi-Up applications. The SETPARAMS are the same parameters as
defined in DEFINELAYOUT and SETLAYOUT Command dialogs. When the parameters are set in the SETPARAMS
screen, the parameters become the default values.

These fields appear on the Insert SETPARAMS Command dialog in the Layout Parameters tab. To enable the option,
select the corresponding check box.

/PageWidth
Enter the value for the /PageWidth parameter, which is the width of the logical page in current units.
/PageHeight

Enter the value for the /PageHeight parameter, which is the height of the logical pages.

/LayoutMarks
Choose the value for the /LayoutMarks parameter. Select one of the following options:
0 No Marks (default)
1 Crop Marks
2 Bleed Marks
3 Both

Layout Mark Pages

Choose one of the following options:

00 Front Pages Only
10 Back Pages Only
20 Front and Back Pages
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Omit Marks

Choose one of the following options:

000 None

100 Inside Crop Marks

200 Inside Bleed Marks

300 Inside Crop and Bleed Marks
/MarkLength

Enter the value for the /MarkLength parameter, which is the length of the layout marks. Tthe default is 18 points.
/MarkWidth

Enter the value for the /MarkWidth parameter, which is the width of the layout marks. The default is .5 points.
/MarkOffset

Enter the value for the /MarkOffset parameter, which is offset for mark from the corner. Tthe default is 4.5 points.
[TopBleed

Enter the value for the /TopBleed parameter, which is a value for the amount of bleed allowed at the top margin of
the logical page. The default is O.

/BottomBleed

Enter the value for the /BottomBleed parameter, which is a value for the amount of bleed allowed at the bottom
margin of the logical page. The default is O.

/LeftBleed

Enter the value for the /LeftBleed parameter, which is a value for the amount of bleed allowed at the left margin of
the logical page. The default is O.

/RightBleed

Enter the value for the /RightBleed parameter, which is a value for the amount of bleed allowed at the right margin
of the logical page. The default is O.

/HGutter

Enter the value for the /HGutter parameter, which is a value for the horizontal gutter width. The default is O.
/VGutter

Enter the value for the /VGutter parameter, which is a value for the vertical gutter width. The default is O.
/Across

Enter the value for the /Across parameter, which is the number of logical pages across the sheet. The default is 1.
/Down

Enter the value for the /Down parameter, which is the number of logical pages down the sheet. The default is 1.

/Rotate
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Choose the value for the /Rotate parameter, which is the degree of rotation for the logical pages. The possible
values are: 0, 90, 180, and 270 clockwise. The O value is the default.

/FillOrder

Choose the value for the /FillOrder parameter, which is the order for filling the logical pages. Filling orders are as
follows:

Right Down Left to right then top to bottom (default)
Left Down Right to left then top to bottom
Right Up Left to right then bottom to top
Left Up Right to left then bottom to top
Down Right Top to bottom then left to right
Up Right Bottom to top then left to right
Down Left Top to bottom then right to left
Up Left Bottom to top then right to left
/PageClip
Use this field to select:
true Enables page clipping
false Disables page clipping

MOVE X AND Y POSITION

The Move X and Y Position option accesses the Insert a Move Command dialog. Use this dialog to specify the new
X (horizontal) and Y (vertical) positions to use and then change the X and Y coordinates command at the current
cursor position.

These fields appear on the Insert a Move Command dialog:
Specify X Position

Check the Specify X Position box to enter the X (horizontal) axis position for the chart. When you check this box,
the X Position field is enabled.

Specify Relative X Position

Check the Specify Relative X Position box to specify a secondary X (horizontal) axis position. This position is
relative to the last primary horizontal position (defined in the last MOVETO or the current frame). This generates a
MOVEHR command.

X position

Enter the position on the X axis (horizontal) at which to place the chart. This field is enabled when you check the
Specify X Position or the Specify X + Y Position box.

Dot Leading GEPKey
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Enter the GEPKey description.

The GEP keys used for the dot leading function are a subset of the full GEP key list (as used in other dialogs like
DRAWB). The dot-leading subset of GEP keys excludes the full-color GEP keys and only includes those that are line-
style (solid, dashed, or bold).

Specify X + Y Position

Check the Specify X + Y Position box to enter the X (horizontal) axis and the Y (vertical) axis positions for the
chart. When you check this box, the X Position and the Y Position fields are enabled.

Y position

Enter the position on the Y axis (vertical) at which to place the chart. This field is enabled when you check the
Specify X + Y Position box.

SET INDENTATION (FOR SHP)

The Set Indentation (for SHP) option accesses the Insert SETINDENT Command dialog. Use this dialog to specify
the indent value for the SHP command and then insert the indent command at the current cursor position.

This field appears on the Insert SETINDENT Command dialog:
Indentation Value

Enter the indentation to use for the SHP command. You enter this value in current units. The default value is O.

SET ABSOLUTE POSITION MODE

The Set Absolute Position Mode option accesses the Insert ABSPOS Command dialog. Use this dialog to insert an
ABSPOS command at the current cursor position. In Multi-Up mode, the ABSPOS command allows all of following
placements to be relative to the physical page rather than to the current logical page.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

CANCEL CLIPPING AREA

The Cancel Clipping Area option accesses the Insert ENDCLIP Command dialog. Use this dialog to insert an
ENDCLIP command at the current cursor position. ENDCLIP disables clipping and restores full-page printing.

To insert the command at the current cursor position, on the Insert ENDCLIP Command screen, select the check box
for Insert This Command.

SAVE SECONDARY PRINT POSITION

The Save Secondary Print Position option accesses the Insert SAVEPP Command dialog. Use this dialog to insert a
SAVEPP command at the current cursor position. SAVEPP saves the current secondary print position for later use.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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INSERT RUN (VIPP® OR POSTSCRIPT)

The Insert RUN (VIPP® or PostScript) option on the RUN Commands submenu accesses the Insert RUN Command
dialog. Use this dialog to specify RUN command information and then insert the RUN command at the current
cursor position.

(D Caution: VIPP® or PostScript files must be in a directory path defined by the SETMPATH command.

These fields appear on the Insert RUN Command dialog:
File Name

Enter the name of the file to run, or use Browse to access the Please choose the file to load window and select the
file to run. The RUN command executes the VIPP® or PostScript code contained in the referenced file. The VIPP® or
PostScript file you specify must be available in a directory path defined by the VIPP® SETMPATH command.

Run Option

Use this box to select the run option to use:

0 No Special Action, which performs no special action

1 Save/Restore Encapsulation, which protects memory consumption. Use this option for any
applications that need to protect the RUN execution.

2 Save/Restore + Basic VIPP®/PS Interaction, which enables interaction between VIPP® and
PostScript (where page-related features such as SETFORM, SETPAGENUMBER, and SETFRAME
are active during execution of the PostScript job). This option also updates context
information (such as page numbering and front/back settings) and applies VIPP® features at
the end of the PostScript page execution (this is the reason that SETMEDIA is not allowed
with this option).

3 Save/Restore + Full VIPP®/PS Interaction, which enables interaction between VIPP® and
PostScript (where page-related features such as SETFORM, SETPAGENUMBER, and SETFRAME
are active during execution of the PostScript job). This option also updates context
information (such as page numbering and front/back settings) and applies VIPP® features at
the beginning of the PostScript page execution. When the PostScript file is generated by an
Apple LaserWriter NTX II driver (W3.1x and W95), it is only supported when TrueType fonts
are not used.

INSERT RUNDD (DECOMPOSED DOCS)

The Insert RUNDD (Decomposed Docs) option on the RUN Commands submenu accesses the Insert RUNDD
Command dialog. Use this dialog to specify RUNDD command information and then insert the RUNDD command
at the current cursor position. The RUNDD command allows you to print a document that was previously processed
by the Decomposition Service in DocuPrint NPS or DocuTech 6100/6135/6180 printers.

(D Caution: Documents must be in a directory path defined by a SETIPATH or SETFPATH (DocuPrint NPS
only) command.

These fields appear on the Insert RUNDD Command dialog:

Document Name
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Enter the name of the decomposition document to print, or use Browse to access the Please choose the file to load
window and select the decomposition document to print.

The RUNDD command accesses the libraries currently defined by SETIPATH and SETFPATH to locate the initial page
for the document you specify. Once the initial page is located, VIPP® prints all of consecutive pages that are
associated with the document and are located in the same library. The document you specify must be available in a
directory path defined by the VIPP® SETIPATH or SETFPATH command.

Use /ENDOFRUN Flag

Check the Use /ENDOFRUN Flag box to end the document.

Use /ENDOFSET Flag

Check the Use /ENDOFSET Flag box to staple the document, offset the document, or both.

INSERT RUNTIF (MULTI-PAGE TIFF)

The Insert RUNTIF (Multi-page TIFF) option on the RUN commands submenu accesses the Insert RUNTIF
Command dialog. Use this dialog to specify RUNTIF command information and then insert the RUNTIF command
at the current cursor position.

The RUNTIF command prints a document from a single TIFF file that contain one or more pages. Each page of the
TIFF file prints on a separate logical page.

(D Caution: Documents must be in a directory path defined by a SETIPATH command.

These fields appear on the Insert RUNTIF Command dialog:
Document Name

Enter the name of the TIFF file to print, or use Browse to access the Please choose the file to load window and
select the TIFF file to print. The TIFF file you specify must be available in a directory path defined by the VIPP®
SETIPATH command.

Use StartPage/StopPage

Place a check in this box to enable the Start Page and Stop Page fields.
Start Page

Enter the number of the first page in the range of pages to print.

Stop Page

Enter the number of the last page in the range of pages to print.

SET IGNORE BADTIFFS OPTION

Set Ignore BadTiffs Option on the TIFF Options submenu accesses the Insert Bad Tiffs Option dialog. Use this
dialog to indicate whether to turn the bad TIFFs option on or off and then insert the Bad TIFFs option command at
the current cursor position.

This field appears on the Insert Bad Tiffs Option dialog:
Bad Tiffs Option
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Use this box to specify the bad TIFFs option:

IGNOREBT _on Enable the bad TIFFs option and cause icall to ignore corrupted or unsupported
TIFF files.

IGNOREBT_off Disable the bad TIFFs option and cause icall to abort the job when a corrupt or
unsupported TIFF file is encountered.

SET REVERSE MODE OPTION

Set Reverse Mode Option on the TIFF Options submenu accesses the Insert Reverse Option dialog. Use this dialog
to indicate whether to turn the reverse option on or off and then insert the reverse option command at the current
cursor position.

This field appears on the Insert Reverse Option dialog:

Reverse Option

Use this box to specify the reverse option:

IREVERSE_on Enable the reverse option and print images in reverse mode.

IREVERSE_off Disable the reverse option and print images in normal mode.

SET TIFF ORIENTATION OPTION

Set TIFF Orientation Option on the TIFF Options submenu accesses the Insert Tiff Orientation dialog. Use this
dialog to indicate whether to turn the TIFF orientation on or off and then insert the orientation command at the
current cursor position.

This field appears on the Insert Tiff Orientation dialog:

Tiff Orientation
Use this box to specify the TIFF orientation.

TIFORI_on Enable TIFF orientation (enables processing of tag 274).

TIFORI_off Disable TIFF orientation (disables processing of tag 274).
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RPE Items

The Smart Editor produces these options when RPE Items is selected:

New RPE Prefix Definition New Record Criteria Definition New BEGINRPE, FROMLINE, or
(RCD) RPEKEY Group

New Page Criteria Definition (PCD) New GETFIELD Command

NEW RPE PREFIX DEFINITION

The New RPE Prefix Definition option accesses the Insert SETRPEPREFIX Command dialog. Use this dialog to specify
RPE prefix information and then insert the RPE prefix command at the current cursor position. The SETRPEPREFIX
command enables Record Processing Entry (RPE) prefix mode and sets the prefix length.

Prefix Length
Enter the length of the prefix.

Prefix Position

Enter the position of the prefix in the record, starting with O.

NEW PAGE CRITERIA DEFINITION (PCD)

The New Page Criteria Definition (PCD) option accesses the Insert setpcd Command dialog. Use this dialog to
specify page criteria definition (PCD) information and then insert the SETPCD command at the current cursor
position.

These fields appear on the Insert SETPCD Command dialog:

Key Name

Enter the name to use for the setpcd key.

Line Number

Enter the value that specifies the line number from which the condition is evaluated.
Line Count

Enter the value that specifies the number of lines on which the condition is evaluated.
Record Position

Enter the value that specifies the position of the desired field in the record. This field only displays when you check
the Use Recpos, Reclen box.

Use Recpos, Reclen

Check the Use Recpos, Reclen box to specify the position and length of the desired field by displaying and using
the Record Position and Record Length fields. Use this box to specify the information for records that do not have a
field delimited structure.

Record Length

Enter the value that specifies the length of the desired field in the record. This field only displays when you check
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the Use Recpos, Reclen box.
Use Field Number

Check the Use Field Number box to specify the number and keyword for the line by displaying and using the Field
Number and /FN Keyword fields. Use this box to specify the information for records that have a field delimited
structure.

Field Number

Enter the number of the desired field in the record. This field only displays when you check the Use Field Number
box.

/FN Keyword

This field displays and automatically contains the text /FN when you check the Use Field Number box. This field
specifies that the value entered in the Field Number field indicates a field number for the desired field.

Conditional Test

Use the drop-down list to select the test operator to use (for example, eq, ne, ge, gt, le, It and /HOLD). / HOLD
searches for the compare string anywhere in the selected record.

Compare String

Enter the reference string for the test. Enter any string of text to locate in the data file. The text you enter must be
enclosed in parentheses.

Use /PREV

Check the Use /PREV box to insert the /PREV parameter in the Compare String field. /PREV refers to the equivalent
string on the previous page.

NEW RECORD CRITERIA DEFINITION (RCD)

The New Record Criteria Definition (RCD) option accesses the Insert SETRCD Command dialog. Use this dialog to
insert a record criteria definition (RCD) at the current cursor position.

These fields appear on the Insert SETRCD Command dialog:

Key Name

Enter the name to use for the setrcd key.

Record Position

Enter the value that specifies the position of the desired field in the record. This field only displays when you
check the Use Recpos, Reclen box.

Use Recpos, Reclen

Check the Use Recpos, Reclen box to specify the position and length of the field by displaying and using the
Record Position and Record Length fields. Use this box to specify the information for records that do not have a
field delimited structure.

Record Length

Enter the value that specifies the length of the desired field in the record. This field only displays when you
check the Use Recpos, Reclen box.
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Use Field Number

Check the Use Field Number box to specify the number and keyword for the field by displaying and using the
Field Number and /FN Keyword fields. Use this box to specify the information for records that have a field
delimited structure.

Field Number
Enter the number of the field in the record. This field only displays when you check the Use Field Number box.

/FN Keyword

This field displays and automatically contains the text /FN when you check the Use Field Number box. This field
specifies that the value entered in the Field Number field is the number for the desired field.

Conditional Test

Use this box to select the test operator to use, for example, eq, ne, ge, gt, le, It and /HOLD. /HOLD searches for
the compare string anywhere in the selected record.

Compare String

Enter the reference string for the test. Enter any string of text to locate in the data file. The text you enter must
be enclosed in parentheses.

Use Condition Statement
Check the Use Condition Statement box to enable Condition Statement.When enabled only the Key Name
and Condition Statement fields will be available.

Condition Statement

Use this box to enter a sequence of VIPP® commands expected to deliver a boolean variable.

NEW GETFIELD COMMAND

The New GETFIELD Command option accesses the Insert GETFIELD Command dialog. Use this dialog to specify
GETFIELD command information and then insert the GETFIELD command at the current cursor position. The
GETFIELD command captures a record portion or a field of a specific line and assigns its value to the specified
variable.

These fields appear on the Insert GETFIELD Command dialog:
VAR Name

Enter the name of the variable to which to assign the captured data.

Line Offset From Key

Enter the value that specifies the line number from which the data is captured.

Record Position

Enter the value that specifies the position of the desired field in the record. This field only appears when you
select the Use Recpos, Reclen check box.

Use Recpos, Reclen

To specify the position and length of the desired field by displaying and using the Record Position and Record
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Length fields, select the Use Recpos, Reclen check box . Use this box to specify the information for records that
do not have a field delimited structure.

Record Length

Enter the value that specifies the length of the desired field in the record. This field only displays when you
check the Use Recpos, Reclen box.

Use Field Number

Select the Use Field Number check box to specify the number and keyword for the line by displaying and using
the Field Number and /FN Keyword fields. Use this check box to specify the information for records that have a
field delimited structure.

Field Number
Enter the number of the desired field in the record. This field only appears when you select the Use Field

Number check box.

/FN Keyword

This field displays and automatically contains the text /FN when you check the Use Field Number box. This field
specifies that the value entered in the Field Number field indicates a field number for the desired field.

PCDKey Name
Enter the name of the PCDKey to use. Use a PCDKey that has already been defined using the SETPCD

command. This field is only available when you select the Use PCDKey check box.

Use PCDKey

Check the Use PCDKey box to specify a PCDKey for use with the GETFIELD command. When you select this
check box, the PCDKey Name field is enabled.

NEW BEGINRPE, FROMLINE, OR RPEKEY GROUP
Selecting any one of the three RPE group options listed here accesses the Insert an RPE Item dialog.

Use the New beginrpe Group option to specify the information to use to begin a Record Processing Entry (RPE)
library definition in a Job Descriptor Ti cket (JDT) file and then insert the RPE library definition command at the
current cursor position.

Use the New fromline Group option to specify the information to use to set an RPE definition, which will be applied
from a specific line number, and then insert the FROMLINE command at the current cursor position.

Use the New RPEKEY Group option to specify the information to use to set an RPE definition, which will be invoked
by SETRPE or by the line prefix, and then insert the RPEKEY group command at the current cursor position. This
command sets the parameters for a single RPEKEY group (rather than for an entire BEGIN/END RPE group).

Fields on the Insert and RPE Item dialog will be available depending on the type of command and position of the
cursor. Also, when the cursor is placed in the RPE Tree Item box and the right mouse button is clicked, the RPE Tree
Item right mouse button menu displays. Refer to Using the RPE Tree Item right mouse button menu for further
information on this right mouse button menu.

RPE Data Record list box

Displays the data records for the application.
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RPE Tree Item list box

Displays the formatting hierarchy of the BEGINRPE command. Select the items from this box using the mouse or
the arrow keys. The information for the item that is currently selected in this box displays in the Edit Selected Line
field. When you right-click on an item from the hierarchy, the RPE Tree Item right mouse button menu displays.

RPE Tree Item right mouse button menu

When you right-click on an item from the RPE Tree hierarchy, the RPE Tree Item right mouse button menu displays.
The RPE Tree Item right mouse button menu options that are enabled are based on the type of RPE definition and
on the current position of the cursor in the RRE Tree Item box. Refer to Using the RPE Tree Item right mouse button
menu for further information on this right mouse button menu.

Depending on the cursor placement the following options are available on this menu:

Insert new RPEKEY

Allows you to insert a new RPE key after the current selection. When you select this item from the RPE Tree Item
right mouse button menu, the RPEKEY Insert new item after current selection dialog displays. Refer to Using the
RPE Tree Item right mouse button menu for further information on this dialog.

Insert FROMLINE

Allows you to insert a new FROMLINE entry after the current selection. When you select this item from the RPE
Tree Item right mouse button menu, the FROMLINE Insert new item after current selection dialog displays.
Refer to Using the RPE Tree Item right mouse button menu for further information on this dialog.

Insert new RPE entry

Allows you to insert a new RPE entry after the current selection. Refer to Using the RPE Tree Item right mouse
button menu for further information on this option.

Delete this line (and children)

Allows you to delete the item currently selected in the RPE Tree Item box. When an item is deleted from the
hierarchy, all children of the selected item are also deleted. BEGINRPE or an ENDRPE item cannot be deleted.

Align
Enter the value to use to specify the alignment for the data specified by the RPE entry.
Rotate

Enter the degree by which to turn the image. When you enter a positive number, the image is turned
counterclockwise; when you enter a negative number, the image is turned clockwise.

Xinit

Enter the value that specifies the initial horizontal position on the page. This position is computed from the left
margin.

Xdisp
Enter the value to add to Xinit for consecutive records that use the same RPE definition.
Yinit

Enter the value that specifies the initial vertical position on the page. This position is computed from the top
margin. In an RPE definition, the origin is always the top left corner of the page.
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Ydisp

Enter the value to add to Yinit for consecutive records that use the same RPE definition.
Recpos

Enter the value that specifies the position of the field in the record.

Reclen

Enter the value that specifies the length of the field in the record.

Font

Use this box to select the font index to use. This list includes all of the font indices currently defined (using
INDEXFONT) and available for use.

Color
Use the drop-down list to select the Colorkey to use. This list includes all of the Colorkeys currently available for use.
Pattern

Use the drop-down list to select the pattern key to use. This list includes all of the pattern keys currently available
for use.

Edit Selected Line

Indicates the item that is currently selected in the RPE Tree Item box. This information changes as you select items
in the RPE Tree Item box, or use the arrow keys to move through the box. Modify the selected item by entering the
changes in this field. The changes you make in this field display in the RPE Tree Item box after you click the Apply
Changes button.

Get Recpos/Reclen

Click the Get Recpos/Reclen button to update the information contained in the Recpos and the Reclen fields. The
information that displays is based on the data field that is currently selected in the RPE Data Record box. Click the
Apply Changes button to update these changes in the RPE Tree Item box.

Apply Changes

Click the Apply Changes button to apply the changes you make to the command information.

Using the RPE Tree Item Right Mouse Button Menu

The RPE Tree Item right mouse button menu is accessed when you right-click on an item located in the RPE Tree
Item box on the Insert an RPE Item: BEGINRPE, the Insert an RPE Item: FROMLINE, or the Insert an RPE Item:
RPEKEY dialog.

Insert new FROMLIME
Insert new RPE entry

Delete this line (and children)
The RPE Tree Item right mouse button menu options that are enabled are based on the type of RPE definition and

on the current position of the cursor in the RPE Tree Item box. These options appear on the RPE Tree Item right
mouse button menu:
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Insert new RPEKEY
Insert NEWGROUP
Insert new FROMLINE
Insert new RPE entry

Delete this line (and children)

Insert new RPEKEY

Use this menu option to insert a new RPEKEY entry after the current selection.

The Item to Insert field contains the default RPEKEY name. This is the name that is used for the new RPE key
that you add to the RPE Tree hierarchy. After you insert the new RPE key, use the Edit Selected RPE Line field to
edit the RPE key text.

Insert NEWGROUP

Use this menu option to insert a NEWGROUP entry after the current selection.

Insert new FROMLINE

Use this menu option to insert a new FROMLINE entry after the current selection.

The Item to Insert field contains the default FROMLINE name. This is name that is used for the new
FROMLINE entry that you add to the RPE Tree hierarchy. After you insert the new FROMLINE entry, use the
Edit Selected Line field to edit the FROMLINE entry text.

Insert new RPE entry

When you select this item from the RPE Tree Item right mouse button menu, a new RPE entry is added after the
current selection. After you insert the new RPE entry, use the RPE entry parameter fields available in the Edit
Selected Line section to edit the RPE entry settings.

When there are currently no Index Font settings specified, the Unable to Create RPE Entry error message
dialog appears.

Delete this line (and children)

When you select this item from the RPE Tree Item right mouse button menu, the item that is currently selected
in the RPE Tree Item box can be deleted. When you delete an item from the hierarchy, all children of the
selected item are also deleted. BEGINRPE or an ENDRPE item cannot be deleted.
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Smart Editor

The Smart Editor produces these options when Output Device Control is selected from the Smart Editor menu:

Set Media Requirements

Set Booklet Range to Print

Set Offset Option

Set Output Resolution

Set Page Range to Print

Set MSPP Option

Mark End of Run

Set Duplex Option

Set Binding Option

Mark End of Set

Set Finishing Options

Set Staple Details

Start a Booklet

Set Staple Option

Mark Start of Set

End a Booklet

Set Jog Option

SET MEDIA REQUIREMENTS

The Set Media Requirements option accesses the Insert SETMEDIA Command dialog. Use this dialog to specify
media information and then insert the media requirements command at the current cursor position.

These fields appear on the Insert SETMEDIA Command dialog:

Media

This box displays all of the Media items you have created using the paper selections you specify in the Type,
Color, and Weight fields. Use the buttons available to the right of this box to change, add, and delete media

selections as follows:

e Delete: Use this button to remove the selected media item from the Media box.

e Insert: Use this button to insert a Media item, using the selections made in the Type, Color, and Weight
fields, at the current cursor position in the Media box.

e Replace: Use this button to replace the currently selected Media item in the Media box with the selections
made in the Type, Color, and Weight fields. In general, use this button to modify an existing media item in

the Media box.

e Append: Use this button to insert a Media item, using the selections made in the Type, Color, and Weight

fields, at the end of the list of Media items in the Media box.

Type

Use this box to select the type of paper stock to use for the Media item, for example, Drilled. If the paper stock

is not on the list, enter the appropriate information in this field.

Color

Use this box to select the paper color to use for the Media item, for example, goldenrod. If the paper color is not
on the list, enter the appropriate information in this field.

Weight

Enter the weight for the paper stock to use for the Media item, for example, 60 to indicate 60 Ib. stock.

Front Coating

Use these boxes to select the media coating types from a menu.
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Back Coating

Use these boxes to select the media coating types from a menu.

Copies Selection

Enter the number of copies to use. Make sure that the value you enter in this field is less than or equal to the
value specified with the SETCYCLECOPIES command. This field is available only when you select the Specify
Copies check box.

Specify Copies Selection

Select the Specify Copies Selection check box to enter a copy selection for the Set Media command. When
you select this check box, the Specify Copies selection field is enabled.

Use media for current page only

Check the Use media for current page only box to use the criteria for this Set Media command for the
current page only. When you select this check box, the Mediabox field and related buttons, the Copies selection,
and the Specify Copies selection fields are disabled.

SET OUTPUT RESOLUTION

The Set Output Resolution option accesses the Insert SETRES Command dialog. Use this dialog to specify page
resolution information and then insert the resolution command at the current cursor position.

This field appears on the Insert SETRES Command dialog:

Resolution

300: Print at 300 dots per inch
600: Print at 600 dots per inch

MARK END OF RUN

The Mark End of Run option accesses the Insert ENDOFRUN Command dialog. Use this dialog to insert an
ENDOFRUN command at the current cursor position.

The ENDOFRUN command acts as a subset of the set delimiter. When you insert this command in the print file,
you must place it at the beginning of the last page of the subset.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

MARK END OF SET

The Mark End of Set option accesses the Insert ENDOFSET Command dialog. Use this dialog to insert an
ENDOFSET command at the current cursor position.

The ENDOFSET command acts as a set delimiter. When using this command in the print file, you must place it at
the beginning of the last page of the set.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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START A BOOKLET

The Start a Booklet option accesses the Insert STARTBOOKLET Command dialog. Use this dialog to insert a
STARTBOOKLET command at the current cursor position.

The STARTBOOKLET command must be coded before any marking command on the first page of a booklet.
j’ Note: It should not be used in VIPP® applications running on other platforms.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

END A BOOKLET

The ENDBOOKLET command must be inserted after the last PAGEBRK command on the last page of a booklet.
j’ Note: It should not be used in VIPP® applications running on other platforms.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

SET BOOKLET RANGE TO PRINT

The Set Booklet Range to Print option accesses the Insert BOOKLETRANGE Command dialog. Use this dialog to
insert a BOOKLETRANGE command at the current cursor position.

BOOKLETRANGE is similar to PAGERANGE but is booklet oriented. BOOKLETRANGE works in conjunction with
STARTBOOKLET and ENDBOOKLET to allow selection of a range of booklets to print.

These fields appear on the Set Booklet Range to Print option dialog:
Starting Booklet

Enter the number of the first booklet to print.

Ending Booklet

Enter the number of the last booklet to print.

SET PAGE RANGE TO PRINT

The Set Page Range to Print option accesses the Insert PAGERANGE Command dialog. Use this dialog to insert a
PAGERANGE command at the current cursor position.

These fields appear on the Insert PAGERANGE Command to Print option dialog:
Starting Page

Enter the starting page number.
Ending Page

Enter the ending page number.

SET DUPLEX OPTION

The Set Duplex Option option accesses the Insert Duplex Option dialog. Use this dialog to indicate whether to turn
duplexing or tumble duplexing on or off and then insert the duplex option command at the current cursor position.
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This field appears on the Insert Duplex Option dialog:
Duplex Option
Use this box to specify the duplexing option.
e DUPLEX_on: Enable the duplex option and print images in duplex mode.
e DUPLEX_off: Disable the duplex option and print images in simplex mode.
e TUMBLEDUPLEX_on: Enable the tumble duplex option and rotate the even page or back page images.
e TUMBLEDUPLEX off: Disable the tumble duplex option.

SET FINISHING OPTIONS

The Set Finishing Options option accesses the Insert a SETFINISHING Command dialog. Use this dialog select the
finishing feature name and related option appropriate to the job and print device.

The SETFINISHING command replaces these deprecated commands:
e BIND_on, BIND_off, BINDDETAILS

e STAPLE_ON, STAPLE_off, STAPLEDETAILS

e OFFSET_on, OFFSET_off

These feature names and their related options are included in the dialog:

242 Xerox® FreeFlow® VI Design Pro Software User Guide



Smart Editor

FINISHING FEATURE FEATURE OPTIONS

Staple

ON

OFF

SinglePortrait
RightPortrait
BottomLeftPortrait
BottomRightPortrait
SingleLandscape
RightLandscape
BottomLeftLandscape
BottomRightLandscape
DualLeftPortrait
DualRightPortrait
DualTopPortrait
DualBottomPortrait
DualLeftLandscape
DualRightLandscape
DuallLandscape
DualBottomLandscape
CenterLeftPortrait
CenterRightPortrait
CenterTopPortrait
CenterBottomPortrait
CenterlLeftLandscape
CenterRightLandscape
CenterToplLandscape

CenterBottomLandscape

Offset

ON
OFF

Bind

ON
OFF

LeftPortrait
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FINISHING FEATURE FEATURE OPTIONS

RightPortrait
Longedge
Shortedge

Fold ON

OFF

CFold

ZFold

CFoldOutside

CFoldInside

ZFoldOutside

ZFoldInside
ZFoldRightHalf
HalfFoldOutside
HalfFoldInside
BookletSquareFoldAndTrim
BookletSaddleSquareFoldAndTrim
BiFoldInsideAndTrim
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FINISHING FEATURE FEATURE OPTIONS

MakeBooklet

ON

OFF

BookletFold
BookletSaddleStitch

Punch

ON

OFF

TopPortrait: Two
TopPortrait: Three
TopPortrait: Four
TopPortrait: System
BottomPortrait: Two
BottomPortrait: Three
BottomPortrait: Four
BottomPortrait:

System RightPortrait: Two
RightPortrait: Three
RightPortrait: Four
RightPortrait: System
LeftPortrait: Two
LeftPortrait: Three
LeftPortrait: Four
LeftPortrait: System
TopLandscape: Two
TopLandscape: Three
TopLandscape:

Four TopLandscape: System
BottomLandscape: Two
BottomLandscape: Three
BottomLandscape: Four
BottomLandscape: System

RightLandscape: Two
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FINISHING FEATURE FEATURE OPTIONS

RightLandscape: Three
RightLandscape: Four
RightLandscape: System
LeftLandscape: Two
LeftLandscape: Three

LeftLandscape: Four

LeftLandscape: System

SET STAPLE OPTION

The Set Staple Option option accesses the Insert a STAPLE Option dialog. Use this dialog to insert an STAPLE_on
or STAPLE_off command at the current cursor position.

SET JOG OPTION

Set Jog Option accesses the Insert Jog Option dialog. Use this dialog to turn the page offset on or off. When you
have specified the criterion to use, click OK to insert the jog option command at the current cursor position.

This field appears on the Insert Jog Option dialog:
Jog Option

JOG_on: enable the page offset option
JOG_off: disable page offset

SET OFFSET OPTION

The Set Offset Option option accesses the Insert Offset Option dialog. Use this dialog to insert an OFFSET_on or
OFFSET_off command at the current cursor position.

SET MSPP OPTION

Set MSPP Option accesses the Insert MSPP_on Command dialog. Use this dialog to insert an MSPP_on command
at the current cursor position.

In Multi-Up mode, the MSPP_on command allows ENDOFSET, ENDOFRUN, and JOG_on and JOG_off to be
placed at the beginning of the last physical page rather than at the beginning of the last logical page. By default,
VIPP® forces the last logical page on a new physical page to execute the ENDOFx command. Although the set
remains consistent, this may lead to undesirable page splitting. MSPP_on avoids this.

j’ Note: When using MSPP_on, the customer application must insert these commands in the position that
identifies the first logical page of the last physical page of the set.
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SET BINDING OPTION

The Set Binding Option on the DocuSP Options submenu, accesses the Insert Binding Option dialog. Use this dialog
to insert an BIND_on or BIND_off command at the current cursor position.

SET STAPLE DETAILS

The Set Staple Details Option on the DocuSP Options submenu, accesses the Insert STAPLEDETAILS Command
dialog.

The stapling options are:
¢ Single Portrait

e Single Landscape

e Dual Landscape

e Right Portrait

e Right Landscape

e Right Dual Portrait

e Dual Portrait

MARK START OF SET

The Mark Start of Set option on the DocuSP Options submenu accesses the Insert STARTOFSET Command dialog.
Use this dialog to insert a STARTOFSET command at the current cursor position.

The STARTOFSET command acts as a set delimiter for DocuSP print jobs only. Only use this command with
FreeFlow Print Server. Place this command at the beginning of the first page of a set.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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Print File Processing

The Smart Editor produces these options when Print File Processing is selected from the Smart Editor menu:

Start LineMode Processing Set Job Descriptor Ticket (JDT) Set Field Separator

Start DataBaseMode Processing Insert ZSORT Command Set Blank Stripping Off

Start XML Mode Processing Skip LineMode Data Set First+Last Character Stripping
On

Set Data File Set Line Buffer Size Set OverPrint On

Set Distribution List Set BackSpacing Option

START LINEMODE PROCESSING

The Start LineMode Processing option accesses the Insert STARTLM Command dialog. Use this dialog to specify the
point at which LineMode will begin. This command must precede the line mode data.

These fields appear on the Insert STARTLM Command dialog:
JDT Name

Enter, or browse for the name of the JDT to be started. Select View File to see the contents of the named JDT.

1st JDT Name

When two JDTs are selected, enter or browse for the name of the first JDT to be started. Select View File to see
the contents of the named JDT.

1st JDT Page Count
When two JDTs are selected, enter the page count of the first JDT to be started.

Use 2 IDTs

Check this box when two JDTs are used.

START DATABASEMODE PROCESSING

The Start DataBaseMode Processing option accesses the Insert STARTDBM Command dialog. Use this dialog to
specify the point at which DataBaseMode will begin.

These fields appear on the Insert STARTDBM Command dialog:
DBM Name

Enter or browse for the JDT name to insert. Select View File to see the contents of the selected file.

Record Grouping

Enter the number of records to read for processing the DBM. The default value is 1.
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START XML MODE PROCESSING

The Start XML Mode Processing option accesses the Insert STARTXML Command dialog. Use this dialog to specify
the point at which XML Mode begins.

These items appear on the Insert STARTXML Command dialog:
XJT Name

Enter or browse for the name of the XJT file to insert. Select View File to see the contents of the selected file.

Edit an XPD Item

When any XML job appears in the Resource Notebook section of VI Design Pro window, right-click on BEGINXPD,
then select Edit this Cmd or Keyword from the Smart Editor Menu, which will produce the Edit an XPD Item
dialog.

When the Edit an XPD Item dialog is open and you select any XML tag from the top window, the corresponding
BTA or BTS actions are highlighted in the lower left window. Each BTA or BTS item has one or more of these actions
assigned:

e Start Tag Actions
e End Tag Actions
e Partial Tag Actions

When you choose one of the three tag action tabs in the lower right window, VI Design Pro displays the associated
tag action in that window.

When the cursor is placed in the lower left window, and an entry is right-clicked, a pop-up menu displaying these
options is produced:

e Insert new BTA definition

o Insert new BTS Definition

o Insert Blank or Comment line
e Delete this item

Insert new BTA definition

Use this selection to enter the new XML variable name for this definition. The BTA command starts a tag action
definition.

Insert new BTS definition

Use this selection to enter the new XML variable name for this definition. The BTS commands starts a tag
substitution definition.

Insert Blank or Comment line

Use this selection to add a blank line, or a comment line to the job.
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Delete this item

Use this selection to delete the highlighted item from the job.

SET DATA FILE

The Set Data File option accesses the Insert SETLMFILE Command dialog. Use this dialog to specify a specific file
from which data is to be read.

These fields appear on the Insert SETLMFILE Command dialog:

Data File Name

Enter or browse for the name of the data file to insert. Select View File to see the contents of the selected file.

Skip Lines Count

Specify the number of skiplines to ignore when processing this file.

SET DISTRIBUTION LIST

The Set Distribution List option accesses Insert SETDLFILE Command dialog. Use this dialog to activate multiple
copies of the Distribution List for the current job as an alternate to using the SETCYCLECOPY command.

These fields appear on the Insert SETDLFILE Command dialog:
Distribution List

Enter or browse for the distribution list that is to be used with a JDT in order to produce cover pages at the
beginning of each document. Select View File to see the contents of the selected file.

JDT Name

Enter or browse for the JDT that is to be used with a distribution list in order to produce cover pages at the
beginning of each document. Select View File to see the contents of the selected file.

SET JOB DESCRIPTOR TICKET (JDT)

The Set Job Descriptor Ticket (JDT) option accesses the Insert SETJIDT Command dialog. Use this dialog to specify
a new JDT for subsequent pages in the job.

These fields appear on the Insert SETJDT Command dialog:
JDT Name

Enter or browse for the JDT to use. Select View File to see the contents of the selected file.

Skip Page Count
Enter the number of pages to skip prior to applying the JDT.

INSERT ZSORT COMMAND

The Z-Sort Imposition option accesses the Insert ZSORT Command dialog. Use this dialog to specify how the
simplex or duplex Multi-Up documents will be stacked, and to define slipsheet options.

ZSORT can be used to process single or multiple page documents. If using Database mode and each record
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generates the same number of pages, use Last stack options 0—3. In any other situation use Last stack options
4-5.
Slipsheet Procedure

Enter the VIPP® code to execute at the end of a stack to produce a slipsheet. This procedure is processed by the
SLIPSHEET command a nd must be a valid procedure for that command. This procedure may be empty if no
slipsheet is desired.

Stack Size

Enter the maximum number of sheets in a stack. The size of the stack is generally based on the maximum
number of sheets that can be cut by the post-processing cutter. This size may be adjusted depending upon the
amount of printer storage capacity and average amount of data per stack. A reasonable stack size is between
500 and 1000 sheets.

Page Count -1

Enter the number of pages per document minus 1. This is only relevant for Database mode.

Last Stack Options

Choose:

0 Database mode only shorten the last stack to fit the number of records with continuous
duplex

1 Database mode only add blank logical pages to the last stack to match the stack size
with continuous duplex

2 Database mode only shorten the last stack to fit number of records with non-continuous
duplex

3 Database mode only add blank logical pages to the last stack to match stack size with
non- continuous duplex

4 all modes shorten the last stack to fit the number of records

5 all modes add blank logical pages to the last stack to match the stack size

Grouping

(Optional) To enter an integer that must be a divider of the multi-up number, enable the Use grouping check
box . It enables multiple consecutive logical pages on the sheet to be treated in sequence instead of through
the stack. The selection and order of these pages is determined by the multi-up filling order (/FillOrder for
SETLAYOUT or sequence order for SETMULTIUP).

SKIP LINEMODE DATA

The Skip LineMode Data option accesses Insert LMSKIP Command dialog. Use this dialog to specify a number of
lines or characters, or an array of bytes to skip at the beginning of line mode data.

These fields appear on the Insert LMSKIP Command dialog:

Skip Lines
Activate the Skip Lines button to skip lines.
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Lines to Skip

Enter the number of lines to skip.

Skip Characters
Activate the Skip Characters button to skip characters.

Characters to Skip

Enter the number of characters to skip.

Skip Byte Values
Activate the Skip Byte Values button to skip line values.

Byte Values to Skip
Enter the ASCII value of the bytes to skip.

SET LINE BUFFER SIZE

The Set Line Buffer Size option accesses the Insert SETBUFSIZE Command dialog. Use this dialog to specify line
buffer size info.

f Note: When the buffer size is too small, the job aborts with a rangecheck error on the readline or readstring
offending command.

These fields appear on the Insert SETBUFSIZE Command dialog:
Line Buffer Size

Enter the maximum line length files to be processed.

Fixed Length Records in Data File

Check the Fixed Length Records in Data File box to specify that the files to be processed include fixed length
records (for example, files with no LF, CR, or CRLF record delimiters).

SET BACKSPACING OPTION

Set BackSpacing Option accesses the Insert Backspacing Option dialog. Use this dialog to indicate whether to turn
the backspace options on and off and then insert the backspace option command at the current cursor position.

This field appears on the Insert Backspacing Option dialog:
Backspacing Option

Use this box to specify the backspacing option to use:

BACKSP_off Disable backspace processing.
BACKSPP_on Enable backspace processing for fixed and proportional fonts.
BACKSPF_on Enable backspace processing for fixed fonts only.
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SET FIELD SEPARATOR

The Set Field Separator option accesses the Insert a SETDBSEP Commmand dialog. Use this dialog to specify the
field separator for use in database mode, or for use with RPE entries that use the /FN option, and then insert the
separator command at the current cursor position.

Any subsequent STARTDBM commands will use this field separator to scan fields in a database file.
f Note: Do not place the SETDBSEP command in a Data Base Master file.

This field appears on the Insert a SETDBSEP Command dialog:
Field Separator

Enter the character that is used to separate fields in the files to be processed. You must enclose the character in
parentheses; for example, (:).

SET BLANK STRIPPING OFF

The Set Blank Stripping Off option accesses the Insert a BSTRIP_off Command dialog. Use this dialog to insert a
BSTRIP_off command at the current cursor position.

The BSTRIP_off command disables the stripping of leading and trailing blanks in delimited fields in database
mode.

f Note:

e Do not insert a BSTRIP_off command in the Data Base Master at the beginning of the database file
before the STARTDBM command.

e Do not insert a BSTRIP_off command in an external Job Descriptor Ticket that is referenced by a
SETJDT command placed before the STARTDBM command in the database file.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

SET FIRST - LAST CHARACTER STRIPPING ON

The Set First+Last Character Stripping On option accesses the Insert QSTRIP_on Command dialog. Use this dialog
to insert a QSTRIP_on command at the current cursor position.

The QSTRIP_on command strips the first and last characters, generally quotes, from every delimited field in
database mode.

f Note:

e Do not insert a QSTRIP_on command in the Data Base Master at the beginning of the database file
before the STARTDBM command.

e Do not insert a QSTRIP_on command in an external Job Descriptor Ticket that is referenced by a
SETJDT command placed before the STARTDBM command in the database file.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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SET OVERPRINT ON

The Set OverPrint On option accesses the Insert OVERPRINT_on Command dialog. Use this dialog to insert an
OVERPRINT_on command at the current cursor position.

The OVERPRINT_on command enables overprint processing in line mode, thus enabling the printing of lines of
data over each other when each line ends with a single Carriage Return (CR) instead of a LF or CR/LF.

f Note: You must place the OVERPRINT_on command before the SETCYCLECOPY command when these
commands are used together. In addition, when using the OVERPRINT_on command on a Xerox 4220/
4230 printer, the printer must be set to BINARY POSTSCRIPT. Otherwise, you must encapsulate the print
file with the required escape sequences.

(D Caution: Use this command only when necessary as it may impact performance.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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Cyclecopy Control

The Smart Editor produces these options when Cyclecopy Control is selected from the Smart Editor menu:

Set Collation Option Set CheckPoint Insert Repeat

Set Number of CycleCopies

SET COLLATION OPTION

Set Collation Option accesses the Insert Collation Option dialog. Use this dialog to indicate whether to turn
Database or cyclecopy mode collation on or off and then insert the collation option command at the current cursor
position.

This field appears on the Insert Collation Option dialog:
Collation Option

Use this field to specify the collation option:

COLLATE_on Enable collating for cycle copy mode. When you select this item, multiple copies
are created on a job or set basis.

COLLATE_dbm Enable a new collation mode in database mode. With this collation mode
enabled, the Data Base Master is called for each record the number or times
specified in the SETCYLECCOPY command.

COLLATE_off Disable collating. When you select this item, the copies are immediately
produced after each logical page.

SET NUMBER OF CYCLECOPIES

The Set Number of CycleCopies option accesses the Insert SETCYCLECOPY Command dialog. Use this dialog to
indicate the number of cycle copies and then insert the cyclecopy command information at the current cursor
position.

This field appears on the Insert SETCYCLECOPY Command dialog:

Number of Copies

Enter the number of copies of each page.

SET CHECKPOINT

The Set CheckPoint option accesses the Insert CHKPOINT Command dialog. Use this dialog to insert a CHKPOINT
command at the current cursor position.

The CHKPOINT command defines an end of set point for cycle copy in collate mode. By default, the end of set
point is the end of the file in line mode. There is no default end of set point in native mode. In general, this
command is intended to indicate a set delimiting point to produce multiple copy sets using SETCYCLECOPY.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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INSERT REPEAT

The Insert Repeat option accesses the Insert REPEAT Command dialog. Use this dialog to indicate the number of
times a cycle copy command is repeated. The information is inserted at the current cursor position.

These fields appear on the Insert REPEAT Command dialog:
e Command to Execute: Enter a command to repeat.

e Repeat Value: Enter the number of times the command is repeated.
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Smart Editor

The Smart Editor produces these options when Page Control is selected from the Smart Editor menu:

Set Page Break Print Current Page, New Sheet Print Current Page, Front of New
Sheet
Skip Printing Current Page Print Current Page, Back of New Start a New Stack
Sheet
Print Current Page

SET PAGE BREAK

The Set Page Break option accesses the Insert SETPBRK Command dialog. Use this dialog to insert a SETPBRK
command at the current cursor position.

The SETPBRK command specifies any string as a page delimiter. When this string is detected, the line on which it
appears can be one of these:

e Last line of the current page

e First line of a new page

e Non-printable page delimiter

e Splitinto a left part and a right part

These fields appear on the Insert SETPBRK Command dialog:

Delimiter String

Enter a delimiter string.

Matching Line Position

Use this field to select from these options:

0

1

: Matching line is last line

: Matching line is first line

Matching Line Content

Use this field to select from these options:

0

[

N

3
4

Looping

: Print left part when not empty
: Print left part

: Print right part

: Print the complete line

: Print none

Use this field to select from these options:
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e 0:Loop on right part

e 1:Do not loop on right part

SKIP PRINTING CURRENT PAGE

The Skip Printing Current Page option accesses the Insert SKIPPAGE Command dialog. Use this dialog to insert a
SKIPPAGE command at the current cursor position.

The SKIPPAGE command causes the current page to be skipped and not printed. This command is intended to be
used in a BEGINPAGE procedure under the control of an IF/ELSE/ENDIF statement.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

PRINT CURRENT PAGE

The Print Current Page option accesses the Insert PAGEBRK Command dialog. Use this dialog to insert a PAGEBRK
command at the current cursor position.

The PAGEBRK command prints the current page and resets the main and secondary print positions (PP) to 0,0. This
command is the only end of page marker in native mode. In line mode, end of page also occurs when Form Feed or
channel skip are encountered. In Multi-Up mode, PAGEBRK skips to the next logical page. When nothing is imaged
on the page, PAGEBRK does not produce a blank page. To produce a blank page, you must use, at a minimum, NL
PAGEBRK.

Use the Insert This Command box on this screen to insert the command at the current cursor position.

PRINT CURRENT PAGE, NEW SHEET

The Print Current Page, New Sheet option accesses the Insert NEWSIDE Command dialog. Use this dialog to insert
a NEWSIDE command at the current cursor position.

In Multi-Up mode, the NEWSIDE command forces the current logical page to print on the next physical page. You
must insert the NEWSIDE command after a page delimiter, for example, after a PAGEBRK, Form Feed, or Skip to
channel one.

Use the Insert This Command field on this screen to insert the command at the current cursor position.

PRINT CURRENT PAGE, BACK OF NEW SHEET

The Print Current Page, Back of New Sheet option accesses the Insert NEWBAK Command dialog. Use this dialog
to insert a NEWBACK command at the current cursor position.

In duplex mode, the NEWBACK command forces the current page to print on the next available back of a sheet.
You must insert the NEWBACK command after a page delimiter, for example, after a PAGEBRK, Form Feed, or Skip
to channel one.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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PRINT CURRENT PAGE, FRONT OF NEW SHEET

The Print Current Page, Front of New Sheet option accesses the Insert NEWFRONT Command dialog. Use this
dialog to insert a NEWFRONT command at the current cursor position.

The NEWFRONT command forces the current page to print on the front of a new sheet. You must insert the
NEWFRONT command after a page delimiter, for example, after a PAGEBRK, Form Feed, or Skip to channel one.

Use the Insert This Command field on this screen to insert the command at the current cursor position.

START A NEW STACK

The Start a New Stack option accesses the Insert NEWSTACK Command dialog. Use this dialog to insert a
NEWSTACK command at the current cursor position and is only available when using the generic mode of ZSORT.

The NEWSTACK command ends the current ZSORT stack with all records processed so far, and begins a new stack.
It is intended to be used inside a conditional statement to start a new stack when the condition is true.

NEWSTACK must be placed before page initialization, before any MOVETO or mark on the page.

Use the Insert This Command box on this screen to insert the command at the current cursor position.
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PDF Interactive Features

The Smart Editor produces these options when PDF Interactive Features is selected from the Smart Editor menu:

Set PIF Set PDF Destination Set PDF Info
Index PIF Set PDF Open Mode Set PDF Bound
Create Bookmark Draw PDF Fillable Form

SET PIF

The Set PIF option accesses the Insert SETPIF Command dialog. Use this dialog to insert a SETPIF command at
the current cursor position.

The SETPIF command defines a PIF destination or note that will be associated with the next and only element
imaged on the page using either SHP, SHMF, SHX, ICALL, SCALL, DRAWB, or BOOKMARK.

The appearance of the Insert SETPIF Command dialog changes according to the PIF type selected.
PIF Type
This field appears on all Insert SETPIF Command dialogs. Use it to select one of the following PIF types:

e null: Use this to cancel any active PIF definition. Because active PIFs are automatically cancelled when
associated with an element, there is rarely any reason to use this option.

e /PAGE
e /DEST
e /XPAGE
e /XDEST
e /FILE

e /URI

e /NOTE

PIF Type: /PAGE
These fields appear when you select a PIF type of /PAGE on the Insert SETPIF Command dialog.

Page Number
Enter the page number.
View

Choose from these options to set the /PAGE view:

null Use the current view

[Fit Fit the page to the window

[FitB Fit the bounding box of the page contents to the window
[FitR Fit the rectangle specified by the parameters to the window
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[FitH Fit the width of the page to the window, this box enables the Top field

[FitV Fit the height of the page to the window, this box enables the Left field

IXYZ Place the origin of the window at left top current units of the page origin. This box
enables the Left, Top, and Zoom fields

Left

Enter in current units the left origin of the view. This field is enabled when the /FitV or /XYZ options are selected.

Top

Enter in current units the top origin of the view. This field is enabled when the /FitH or /XYZ option is selected.

Zoom

Enter the zoom value. This field is enabled when the /XYZ option is selected.
PIF Type: /DEST
This field appears when you select a PIF type of /DEST on the Insert SETPIF Command dialog.

Destination Name

Enter the destination for this PIF.
PIF Type: /IXPAGE
These fields appear when you select a PIF type of /XPAGE on the Insert SETPIF Command dialog.
File Reference

Enter the reference for the PIF file.

Page Number
Enter the page number for this PIF.
View

Choose from these options to set the /XPAGE view:

null Use the current view

[Fit Fit the page to the window

[FitB Fit the bounding box of the page contents to the window

/FitR Fit the rectangle specified by the parameters to the window

[FitH Fit the width of the page to the window, this box enables the Top field

[FitV Fit the height of the page to the window, this box enables the Left field

IXYZ Place the origin of the window at left top current units of the page origin. This box
enables the Left, Top, and Zoom fields
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Left

Enter in current units the left origin of the view. This field is enabled when the /FitV or /XYZ options are selected.

Top

Enter in current units the top origin of the view. This field is enabled when the /FitH or /XYZ option is selected.

Zoom

Enter the zoom value. This field is enabled when the /XYZ option is selected.
PIF Type: /IXDEST
These fields appear when you select a PIF type of /XDEST on the Insert SETPIF Command dialog.

File Reference

Enter the file reference for this PIF.

Destination Name

Enter the destination for this PIF.
PIF Type: /FILE
This field appears when you select a PIF type of /FILE on the Insert SETPIF Command dialog.

File Reference
Enter the file reference for this PIF.

PIF Type: /URI
This field appears when you select a PIF type of /URI on the Insert SETPIF Command dialog.

URI String
Enter the URI string.

PIF Type: INOTE
These fields appear when you select a PIF type of /NOTE on the Insert SETPIF Command dialog.

Title
Enter the title.

Contents
Enter the text.

Specify optional parameters

To enable the optional parameter selection, select the check box for the Specify optional parameters.

Note Type

Choose from among these note types:
e /Note
e /Comment

e /Help
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Choose a background color for the note.

/Insert

/Key

/New Paragraph
/Paragraph
/Draft

/Approved
/Experimental
/NotApproved
/Ass

/Expired
/NotForPublicRelease
/Confidential
[Final

/Sold
/Departmental
/ForComment
/TopSecret
[ForPublicRelease
/FT

/MK

Option

Choose any combination.

The note is presented open

Center note icon on anchor element

INDEX PIF

Smart Editor

The Index PIF option accesses the Insert INDEXPIF Command dialog. Use this dialog to insert an INDEXPIF

command at the current cursor position.

The INDEXPIF command associates an PIF destination or note with a PIF index. Once defined by INDEXPIF, a PIF

index follows the same rules and behaviors as a color index defined by INDEXCOLOR.

The appearance of the Insert INDEXPIF Command dialog changes according to the PIF type selected.

PIFIndex

Enter the name to use for the PIF index.
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PIF Type
Use this box to select one of the following PIF types:

null: Use this to define a PIF index to cancel the current one. This is only useful when on a fragment of text
inside a string printed by SHP or SHMF, when used in any i manner the PIF index is automatically cancelled
when it is associated with an element.

/PAGE
/DEST
/XPAGE
/XDEST
/FILE
/URI
/NOTE

PIF Type: /PAGE

These fields appear when you select a PIF type of /PAGE on the Insert INDEXPIF Command dialog.

PIF Type: /PAGE

Page Number

Enter the page number

Page View

Choose from these options to set the /PAGE view:

null use the current view

[Fit fit the page to the window

[FitB fit the bounding box of the page contents to the window

[FitR fit the rectangle specified by the parameters to the window

/FitH fit the width of the page to the window, this box enables the Top field

[FitV fit the height of the page to the window, this box enables the Left field

IXYZ place the origin of the window at left top current units of the page origin. This box
enables the Left, Top, and Zoom fields
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Left: Enter in current units the left origin of the view. This field is enabled when the /FitV or /XYZ options are
selected.

Top: Enter in current units the top origin of the view. This field is enabled when the /FitH or /XYZ option is
selected.

Zoom: Enter the zoom value. This field is enabled when the /XYX option is selected.
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2

PIF Type: /DEST
This field appears when you select a PIF type of /DEST on the Insert INDEXPIF Command dialog.

Destination Name

Enter the destination for this PIF.

PIF Type: /IXPAGE

These fields appear when you select a PIF type of /XPAGE on the Insert INDEXPIF Command dialog.

File Reference

Enter the reference for the PIF file.

Page Number

Enter the page number for this PIF

Page View

Choose from these options to set the /XPAGE view:

null Use the current view

[Fit Fit the page to the window

[FitB Fit the bounding box of the page contents to the window

[FitR Fit the rectangle specified by the parameters to the window

[FitH Fit the width of the page to the window, this box enables the Top field

[FitV Fit the height of the page to the window, this box enables the Left field

IXYZ Place the origin of the window at left top current units of the page origin. This box
enables the Left, Top, and Zoom fields

e Left: Enter in current units the left origin of the view. This field is enabled when the /FitV or /XYZ options are
selected.

e Top: Enter in current units the top origin of the view. This field is enabled when the /FitH or /XYZ option is
selected.

e Zoom: Enter the zoom value. This field is enabled when the /XYX option is selected.

PIF Type: /XDEST

These fields appear when you select a PIF type of /XDEST on the Insert INDEXPIF Command dialog.

File Reference
Enter the file reference for this PIF.

Destination Name

Enter the destination for this PIF.
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PIF Type: FILE

This field appears when you select a PIF type of /FILE on the Insert INDEXPIF Command dialog.

File Reference

Enter the file reference for this PIF.

PIF Type: /URI

This field appears when you select a PIF type of /URI on the Insert INDEXPIF Command dialog

URI String

Enter the URI string

PIF Type: INOTE

These fields appear when you select a PIF type of /NOTE on the Insert INDEXPIF Command dialog.

Title

Enter the title.

Contents

Enter the text.

Specify optional parameters

Select this check box to enable optional parameters.

Note Type

Choose from among these note types:
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/Note
/Comment
/Help

/Insert

/Key

/New Paragraph
/Paragraph
/Draft
/Approved
/Experimental
/NotApproved
/Asls

/Expired

/NotForPublicRelease

/Confidential
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e /Final

e /Sold

e /Departmental
e /ForComment
e /TopSecret

e /ForPublicRelease

o [FT
e /MK
Color

Choose a background color for this note.
Option

Choose any combination

e The note is presented open

e Center note icon on anchor element

CREATE BOOKMARK

The Create Bookmark option accesses the Insert BOOKMARK Command dialog. BOOKMARK creates an interactive
bookmark within a PDF file.

These fields appear on the Insert BOOKMARK Command dialog:
Input String

To create the bookmark, enter the string used.

Specify optional parameters

To enable the optional parameter fields, select the check box for Specify optional parameters.

Specify extended bookmark

To enable the extended bookmark fields, select the check box for Specify extended bookmark.

Sub-bookmark Count

Enter the number of sub-bookmarks that follow the bookmark. To indicate that the bookmark is open when the
file is accessed initially, enter a positive number. To indicate that the bookmark is closed at initial access, enter a
negative number.

Color

To select the color of the bookmark text, use the list.

Style

To select the style of the bookmark text, select an option:
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e 0:Plain, default

e 1:Italic

e 2:Bold

e 3:Bold and italic
Option 1

This option is available when you use the extended bookmark feature with the VI eCompose software. The
Option 1 feature tells the VIeC splitter how to handle the child PDF file. Choose one of the following options:

e 0: Do not produce a child PDF file.
e 1:Produce a child PDF file, but do not include the bookmark in the PDF.
e 2:Produce a child PDF file, and include the bookmark in the PDF. This setting is the default.
If there is no extended bookmark, the splitter behavior defaults to 2.
All extended bookmarks for a given sub-document require the same Option 1 value.
Option 2

This option is available when you use the extended bookmark feature with the VI eCompose software. Option 2
tells the VIeC splitter how to handle the extended bookmark. Choose one of the following options:

e 0:Do nothing with the extended bookmark.

e 1:Merge the extended bookmark with the associated regular bookmark for index file processing, but do not
include the bookmark in a child PDF file.

e 2:Merge the extended bookmark with the associated regular bookmark for index file processing, and include
the bookmark in the child PDF file.

To insert comments or instructions in the main PDF file, use the option 0.
Entering a combination of Option 1=0 and Option 2=2 is the same as entering Option 2=1.

SET PDF DESTINATION

The Set PDF Destination option accesses the Insert PDFDEST Command dialog. PDFDEST defines a named
destination, which can be referenced in a PIF definition.

These fields appear on the Insert PDFDEST Command dialog:

Destination name

Use this field to enter the destination name as an alphanumeric string.

Specify optional parameters

Select the Specify optional parameters fields to enable the optional parameter fields.

Page number

Enter the page number of the destination.

View

Use this box to define how to adjust the view for the destination.The possible values are:
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null Use the current view

[Fit Fit the page to the window

[FitB Fit the bounding box of the page contents to the window

/FitR Fit the rectangle specified by the parameters to the window

[FitH Fit the width of the page to the window, this box enables the Top field

[FitV Fit the height of the page to the window, this box enables the Left field

IXYZ Place the origin of the window at "left top” current units of the page origin. This
box enables the Left, Top, and Zoom fields

Top

Place the top origin of the window at top current units of the page origin.

Left

Place the left origin of the window at left current units of the page origin.

Zoom

Place the origin of the window at left top current units of the page origin.

SET PDF OPEN MODE

The Set PDF Open Mode option accesses the Insert PDFOPEN Command dialog. PDFOPEN defines how a PDF
document will be opened. When associated with a PIF destination it also defines a destination to be used when the
document is opened.

This field appears on the Insert PDFOPEN Command dialog:

Open mode

Use this box to select the mode used when the document is opened. It may be one of these options:

/UseNone Open the PDF but do not display bookmarks or thumbnail images
/UseOutlines Open and display bookmarks

/UseThumbs Open and display thumbnail images

[FullScreen Open in full screen mode

SET PDF INFO

The Set PDF Info option accesses the Insert PDFINFO Command dialog. PDFINFO populates the Document
Summary section of the PDF file with information.

These fields appear on the Insert PDFINFO Command dialog:
Author
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Use this field to enter the author of the document.

Creator

Use this field to enter the creator of the document.

Title

Use this field to enter the title of the document.

Subject

Use this field to enter the subject of the document.

Keywords

Use this field to enter a list of Keywords used in the document.

SET PDF BOUND

The Set PDF Info option accesses the Insert PDFBOUND Command dialog. PDFBOUND enables the creation of
optional page boundary boxes in a PDF output created by a VIPP® job. This command does not alter the PDF
contents other than by adding the additional bounding boxes in the page.

These fields appear on the Insert PDFBOUND Command dialog:
PDF BoundBox

To insert a parameter, select one of the following options:

/CropBox
/BleedBox
/TrimBox

/ArtBox

Offsets from page borders

The values in current units entered in the following boxes define the location of the BoundBox. Placement of the
BoundBox is from the edges of the page. The page is from MediaBox, as defined by SETPAGESIZE.

To define the distance from the edge of the page to the PDF BoundBox, enter a value in the following boxes:

Top: This option is the number of current units from the top of the page to the top of the BoundBox.

Bottom: This option is the number of current units from the bottom of the page to the bottom of the
BoundBox.

Left: This option is the number of current units from the left side of the page to the left side of the
BoundBox.

Right: This option is the number of current units from the right side of the page to the right side of the
BoundBox.

DRAW PDF FILLABLE FORM

The Draw PDF Fillable Form option accesses the Edit DRAWPFF Command dialog box.

The DRAWPFF feature draws and inserts a PDF form field in a PDF document at the current, secondary print
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position. PDF form fields are intended to be filledin by a user (recipient) and the PDF sent back (submitted) to a
process designed to extract the field contents and store them in a database. The command is effective when the
VIPP® job is rendered into a PDF document. When the job is simply imaged, either onscreen or on paper, only the
initial image of the field, as displayed when the PDF document is opened, is drawn.

DRAWPFF can create 11 different types of form fields as detailed in the syntax. Form fields are included in the PDF
using the AcroForm specifications. For more information, refer to Adobe Interactive Forms documentation.

Type ITL - Text field (single-line)

/TB - Text box (multi-lines)

/CB - Check box /RB - Radio button /PL - Pull down list
/CL - Combo box (free typing allowed)

/LB - List box

IRS - Reset form button

/SF - Submit form button

/SI - Digital Signature

/PR - Print Form Button

Width Is the width of the field rectangle in current units.

Height Is the height of the field rectangle in current units.
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Align

Indicates which point of the field must be aligned on the secondary print position
0: top left (default)

1: top right

2: top center

10: bottom left

11: bottom right

12: bottom center

20: center left

21: center right

22: center center

Options

Present a collection of optional key/value pairs:
/FName: Field name

Type string

Default value none

Description: A name to identify the field at extraction time. Must be different for
each field, except for a set of radio buttons, which must share the same name.

/FDesc: Field alternate description
Type string
Default value none

Description: An alternate field name to be used in place of the actual field name
wherever the field must be identified in the user interface, such as in error or
status messages referring to the field. This text is useful when extracting the
document contents in support of accessibility to users with disabilities or for other
purposes.

/FMap Field mapping name

Type string

Default value none

Description The mapping name to be used when exporting PDF form field data
/ReadOnly Read only flag

Type integer

Default value 0

Description O - field can be changed

1: field cannot be changed

/Required Required flag
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Type integer

Default value 0

Description O - field can be left empty

1: field cannot be left empty

INoExport Export flag

Type integer

Default value 0

Description: O - field is exported

1: field is not exported

INoPrint: Print flag

Type integer

Default value 0

Description: O - field prints

1: field does not print

/MulSel: Multiple selection flags (LB only)
Type integer

Default value 0

Description: O - only one selection allowed
1: multiple selections allowed

/FValue: Field value (TL, TB, PL, CL, LB only)
Type string

Default value none

Description: Preset value displayed when the PDF is opened.
/DValue: Default field value

Type string

Default value none

Description: Value displayed when pressing the reset button.

/IState: Preset state for check boxes and radio buttons. Must be coded only with
the first radio button in a set.

Type integer

Default value O

Description: O - off state
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1: on state for check box or first radio button

>1: on state for other radio buttons (button order number)
/FChoices Array of value choices (PL, CL, LB only)

Type Array of strings OR array of [export display] strings
Default value none

Description List of choices presented to the user. When [export display] format is
used the export strings are used for export and the display strings are used for
presentation onscreen.

/TAlign Field text alignment in the field

Type integer

Default value 0

Description O: left

1:right

2: center

/BColor Field border color

Type Color key (Gray, RGB and CMYK color only)
Default value none (transparent)

Description Color of the field border

/FColor Field background color

Type Color key (Gray, RGB, CMYK, Gradient and pattern color only)
Default value none (transparent)

Description Color of the field border

/VColor Field value color

Type Color key (Gray, RGB and CMYK color only)
Default value none (transparent)

Description Color of the field value

/BStyle Field border style

Type [width/style]

Default value [1 /s]

Description Border style:

- border width in points

- border style is one of:

/S solid
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/D dashed

/B embossed

/T engraved

/U underline

/FCaption Field caption (CB, RB, RS and SF only)
Type string

Default value check sign (CB) or bullet (RB)
Description For check box and radio button:

<hex code> (refer to the caption table below) for reset and submit buttons: (text
string)

/TSplit Split text field (TL, TB only)
Type integer

Default value 0

Description 0: no split

>0: number of splits and max length
/To Submission destination (SF only)
Type URL string

Default value none

Description Email or Web server URL where the form extraction (in FDF or PDF
format) is sent.

/SubmitPDF Submission format (SF only)
Type integer

Default value 0

Description

0: submit as FDF format

1: submit as PDF format

2: submit as HTML format

3: submit as XFDF format

ITFName A font name for field value. Limited to the following list: /Helv /HeBo
/HeOb /HeBO (Helvetica) /TiRo /TiBo / Tilt /TiBI (Times-Roman) /Cour /CoBo
/CoOb /CoBO (Courier).

Type /name

Default value /Helv
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/TFSize A font size for field value

Type integer (points)

Default value 0

Description O - auto-scalable

>0: fixed font size

/FImage A field background image

Type String (image name of a TIFF, JPEG or EPS)
Default value none

Description Image to be used as field background (alternative to FColor)
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Job Data Capture
The Job Data Capture option accesses the Insert ACCLOG Command dialog window.

The ACCLOG command is effective only when the Demographics feature is activated. It is used to capture data
when a VIPP® job processes, then log the data into the demographics output file (.vpr or .vpd).

Label

Use this box to enter a string or variable that will identify the information entered in the Contents window.

Contents

Use this box to enter a string or variable containing the information to be captured.
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Custom Color Lists

The Custom Color Lists option accesses the Custom Color Lists dialog. The dialog displays the custom colors
defined in \xgf\src\scoat.cckand \xgf\src\sucoat.cck. Use color lists to group and name the large
number of approximately 1000 custom colors defined in the CCK files.

Any custom color lists that have a check mark are used by the SmartEditor and VI Design Pro in dialogs, such as
Insert INDEXCOLOR or Insert SETTXC, when displaying lists of colors.

The following fields appear on the Custom Color Lists dialog:

Custom Color Palette

This window contains a list and a sample of each color included in the CCK files. To access the colors included in
the CCK files, edit the \xgf\src\xgfdos. run file.

If you print on coated paper, use scoat . cck. If you print on uncoated paper, use sucoat . cck.

After colors are added to the Custom Color Palette window, you can select or deselect the colors using the left
mouse button and the Shift or Ctrl keys on the keyboard.

Custom Color Lists
The Custom Color Lists window contains the names of the custom color lists that you define. When a check
mark appears next to the list name, the colors in the list are added to all dialogs that provide color choices,
along with pre-defined VIPP® colors.

Save to List

To add the selected colors to the custom color list highlighted in the lower dialog window, click Save to List.

Deselect All

To clear all the color choices, click Deselect All.

Select All

To select all colors shown in the upper dialog window, click Select All.
Selected colors are highlighted. To add or remove individual colors from the selections, press the Ctrl key and
click the color.

Add List

To create a new color list, click Add List. The Custom Color Lists Dialog appears. Enter the name of the new
color list, then click OK. The new color list name appears in the lower dialog window.

Delete List
To delete a highlighted custom color list, click Delete List.

Rename List

To rename a highlighted custom color list, click Rename List.
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Dialog Cross Reference

The following is an alphabetized list of commands and their location in this document.

Smart Editor

PAGE COMMAND VDP MENU OPTIONS
Set Absolute Position Mode ABSPOS Page Marking

Job Data Capture ACCLOG Job Data Capture
Draw AZTEC Barcode AZTEC Page Marking

Set BackSpacing Option

BACKSP_off, BACKSPP_on, BACKSPF_on

Print File Processing

New BEGINRPE, FROMLINE, or RPEKEY BEGINRPE, FROMLINE, RPEKEY RPE Items
Group
Insert Table BEGINTABLE Page Marking
Set Data File BEGINXPD, BTA, BTS Print File Processing
Set Booklet Range to Print BOOKLETRANGE Output Device Control
Create Bookmark BOOKMARK PDF Interactive Features
Set Blank Stripping Off BSTRIP_off Print File Processing
Set CheckPoint CHKPOINT Cyclecopy Control
Set Collation Option COLLATE_on, COLLATE_dbm, COLLATE_ Cyclecopy Control
off
Draw Cut Marks CUTMARK Page Marking
Draw DataMatrix Barcode DATAMATRIX Page Marking
Define Layout DEFINELAYOUT Fonts, colors, and
variables
Draw Box/Circle/Ellipse DRAWB and DRAWC Page Marking
Draw Linear Numeric Barcode DRAWBC Page Marking
Draw DDG Charts (bar/curve/pie/Pareto/ | DRAWBAR, DRAWCRV, DRAWPIE, Page Marking
radar) DRAWPAR, DRAWRDR
Draw Path DRAWPATH Page Marking
Draw Path DRAWPATHR Page Marking
Draw PDF Fillable Form DRAWPFF PDF Interactive Features
Draw Polygon DRAWPOL Page Marking

Set Duplex Option

DUPLEX_on, DUPLEX_off,
TUMBLEDUPLEX_on, TUMBLEDUPLEX_
off,

Output Device Control
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PAGE COMMAND VDP MENU OPTIONS
End a Booklet ENDBOOKLET Output Device Control
Cancel Clipping Area ENDCLIP Page Marking

Mark End of Run ENDOFRUN Output Device Control
Mark End of Set ENDOFSET Output Device Control
Fill OMR Grid FILLOMR Page Marking

Shift Form Origin FORMSHIFT Page Layout

New GETFIELD Command GETFIELD RPE Items

Go to Specified Frame GOTOFRAME Page Layout

Insert Image ICALL Page Marking

Set Ignore BadTiffs Option IGNOREBT_on, IGNOREBT_off Page Marking

Index Align INDEXALIGN Fonts, colors, and
variables

Index BAT Key INDEXBAT Fonts, colors, and
variables

Index Color INDEXCOLOR Fonts, colors, and
variables

Index Font INDEXFONT Fonts, colors, and
variables

Index Font Kerning INDEXKERN Fonts, colors, and
variables

Index Line Spacing INDEXLSP Fonts, colors, and
variables

Index PIF INDEXPIF PDF Interactive Features

Index Sub/Superscript INDEXSST Fonts, colors, and
variables

Set Reverse Mode Option IREVERSE_on, IREVERSE_off Page Marking

Set Jog Option

JOG_on, JOG_off

Output Device Control

Skip LineMode Data LMSKIP Print File Processing
Draw MaxiCode Barcode MAXICODE Page Marking
Move X and Y Position MOVETO, MOVEHR Page Marking

Set MSPP Option

MSPP_on

Output Device Control

Print Current Page, Back of New Sheet

NEWBACK

Page Control
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Smart Editor

PAGE COMMAND VDP MENU OPTIONS
Go to Next Frame NEWFRAME Page Layout
Print Current Page, Front of New Sheet NEWFRONT Page Control
Print Current Page, New Sheet NEWSIDE Page Control
Set Page Break NEWSTACK Page Control
Initialize OMR Code for Mailer OMRINIT Page Layout

OneUp/TwoUpPrinting

ONEUP, TWOUP

Page Layout

Set Coordinate Origin

ORIBL, ORITL

Page Layout

Set OverPrint On OVERPRINT _on Print File Processing
Print Current Page PAGEBRK Page Control

Set Page Range to Print PAGERANGE Output Device Control
Draw PDF417 Barcode PDF417 Page Marking

Set PDF Boundaries PDFBOUND PDF Interactive Features
Set PDF Destination PDFDEST PDF Interactive Features
Set PDF Info PDFINFO PDF Interactive Features
Set PDF Open Mode PDFOPEN PDF Interactive Features

Set Page Orientation

PORT, IPORT, LAND, ILAND

Page Layout

Draw QRCode Barcode QRCODE Page Marking

Set First+Last Character Stripping On QSTRIP_on Print File Processing

Insert Repeat REPEAT Cyclecopy Control

Reset Current Context RESET Fonts, colors, and
variables

Save Current Context RSAVE Fonts, colors, and
variables

Insert RUN (VIPP® or PostScript) RUN Page Marking

Insert RUNDD (Decomposed Docs) RUNDD Page Marking

Insert RUNTIF (Multi-page TIF) RUNTIF Page Marking

Save Secondary Print Position SAVEPP Page Marking

Insert Segment SCALL Page Marking

Set Line Buffer Size SETBUFSIZE Print File Processing

Set Color Definition SETCOL Fonts, colors, and
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Smart Editor

PAGE COMMAND VDP MENU OPTIONS
variables

Set Column Width SETCOLWIDTH Page Layout

Set Number of CycleCopies SETCYCLECOPY Cyclecopy Control

Set Date SETDATE Fonts, colors, and
variables

Set Field Separator SETDBSEP Print File Processing

Set Distribution List SETDLFILE Print File Processing

Set Finishing Options SETFINISHING Output Device Control

Set Font SETFONT Fonts, colors, and
variables

Set Form/BackForm SETFORM Page Layout

Set Page Frame SETFRAME Page Layout

Set GEP Definition SETGEP Fonts, colors, and
variables

Set Page Grid SETGRID Page Layout

Set Indentation (for SHP) SETINDENT Page Marking

Set Job Descriptor Ticket (JDT) SETJDT Print File Processing

Set Font Kerning SETKERN Fonts, colors, and
variables

Set Layout SETLAYOUT Fonts, colors, and
variables

Set LineFeed Increment SETLFI Page Layout

Set Linked Frames Mode SETLKF Page Layout

Set LineSpacing Value SETLSP Page Layout

Set Page Margins SETMARGIN Page Layout

Set Max Forms/BackForms SETMAXFORM Page Layout

Set Media Requirements SETMEDIA Output Device Control

Set Page Definitions SETPAGEDEF Page Layout

Set Page Numbering SETPAGENUMBER Page Layout

Set Page Size SETPAGESIZE Page Layout

Set Params (DDG, FILLOMR, Format...) SETPARAMS Page Marking
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Smart Editor

PAGE COMMAND VDP MENU OPTIONS

Set Page Break SETPBRK Page Control

New Page Criteria Definition (PCD) SETPCD RPE Items

Set PIF SETPIF PDF Interactive Features

New Record Criteria Definition (RCD) SETRCD RPE Items

Set Output Resolution SETRES Output Device Control

New RPE Prefix Definition SETRPEPREFIX RPE Items

Set Widow/Orphan Control SETSKIP Page Layout

Set Tab Spacing SETTAB Page Layout

Set Tab Spacing SETTABS Page Layout

Set Text Bkgrd Attribute SETTXB Fonts, colors, and
variables

Set Text Color SETTXC Fonts, colors, and
variables

Set Sub/SuperScript SETTXS Fonts, colors, and
variables

Set Units SETUNIT Page Layout

Set Variable SETVAR Fonts, colors, and
variables

Set Zebra Lines SETZEBRA Page Layout

Shift Page Origin SHIFT Page Layout

Insert Text SHL, SHX,SHMF, SHP, SHT Page Marking

Insert Text on Path SHPATH Page Marking

Insert Distorted Text SHPIT Page Marking

Insert Table Row SHROW Page Marking

Skip Printing Current Page SKIPPAGE Page Control

Start a Booklet STARTBOOKLET Output Device Control

Start DataBaseMode Processing STARTDBM Print File Processing

Start LineMode Processing STARTLM Print File Processing

Mark Start of Set STARTOFSET Output Device Control

Start XML Mode Processing STARTXML Print File Processing

Store Variable STOREVAR Fonts, colors, and
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Smart Editor

PAGE COMMAND VDP MENU OPTIONS
variables

Set TIFF Orientation Option TIFORI_on, TIFORI_off Page Marking

Draw USPS 4-State Barcode USPS4 Page Marking

Set Text Color uv2L Fonts, colors, and
variables

Insert ZSORT Command ZSORT Print File Processing
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